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このマニュアルについて

ここでは、マニュアルの目的、対象読者、マニュアルの構成、関連資料、使用されている表記法、

および Web 上でシスコの資料にアクセスする方法について説明します。

（注） シスコ製品についてこのマニュアルに記載されている情報は、最新のものでない場合があります。

最新の資料は、シスコ製品のマニュアルのページから入手できます。次の URL を参照してください。

http://www.cisco.com/univercd/home/home.htm

この章は、次の項で構成されています。

• 目的（P.x）

• 対象読者（P.x）

• マニュアルの構成（P.xi）

• 関連マニュアル（P.xii）

• 表記法（P.xii）

• 技術情報の入手方法（P.xiv）

• シスコ製品のセキュリティの概要（P.xvi）

• テクニカル サポート（P.xviii）

• その他の資料および情報の入手方法（P.xx）

http://www.cisco.com/univercd/home/home.htm
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このマニュアルについて

目的

目的

『Cisco Unified CallManager Serviceability アドミニストレーション ガイド』は、Real-Time Monitoring
Tool（RTMT）などの Cisco Unified CallManager Serviceability プログラムに関する情報を提供します。

本書は、『Cisco Unified CallManager システム ガイド』、『Cisco Unified CallManager アドミニストレー

ション ガイド』、『 Cisco Unified CallManager Serviceability システム ガイド』、および『CDR Analysis
and Reporting アドミニストレーション ガイド』と併せて使用してください。すべての資料には、

Cisco Unified CallManager プログラムの管理方法、および Cisco Unified CallManager の管理機能 を使

用して行う作業手順の説明があります。

対象読者

『Cisco Unified CallManager Serviceability アドミニストレーション ガイド』は、Cisco Unified 
CallManager システムの管理とサポートを担当するネットワーク管理者を対象にしています。ネッ

トワーク エンジニア、システム管理者、または通信エンジニアは、このマニュアルを使用して、リ

モート保守機能を管理するための知識を得ることができます。テレフォニーおよび IP ネットワー

キング テクノロジーに関する知識が必要です。
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このマニュアルについて

マニュアルの構成

マニュアルの構成

このマニュアルの構成は、次のとおりです。

章 説明

第 1 章「概要」 Cisco Unified CallManager Serviceability アプリケーションとリモー

ト保守アプリケーション、レポート作成ツールの概要を説明しま

す。

第 2 章「サービスの管理」 Cisco Unified CallManager サービスのアクティブ化、非アクティブ

化、開始、および停止の手順を説明します。 

第 3 章「アラームの設定」 Cisco Unified CallManager アラームの設定手順を説明します。

第 4 章「アラーム定義」 Cisco Unified CallManager アラーム定義の検索および編集手順を説

明します。

第 5 章「トレースの設定」 Cisco Unified CallManager サービスのトレース パラメータの設定手

順を説明します。

第 6 章「Troubleshooting Trace
Setting の設定」

TroubleShooting Trace Setting の設定手順を説明します。

第 7 章「Real-Time Monitoring
の設定」

Real-Time Monitoring Tool の設定手順を説明します。

第 8 章「RTMT でのアラート

設定」

アラートのプロパティの設定、アラートのオプションの設定、ア

ラートの電子メール通知の設定など、Real-Time Monitoring Tool で
のアラートの操作手順を説明します。

第 9 章「パフォーマンス モ
ニタリングの設定と使用」

パフォーマンス カウンタやカウンタの説明の表示など、パフォーマ

ンス モニタの操作手順を説明します。

第 10 章「RTMT のトレース

収集とログ集中管理」

Cisco Unified CallManager サービスおよびクラッシュ ダンプ ファイ

ルのオンデマンド トレース収集の設定方法、さらに適切なビューア

でのトレース ファイルの表示方法を説明します。

第 11 章「RTMT SysLog 
Viewer の使用」

SysLog Viewer の使用方法を説明します。

第 12 章「プラグインの使用」 Real-Time Monitoring Tool にプラグインをインストールして使用す

る方法を説明します。

第 13 章「Log Partition 
Monitoring の設定」

Log Partition Monitoring を設定して、特定のサーバ（またはクラス

タ内のすべてのサーバ）のログ パーティションでのディスク使用状

況をモニタする方法を説明します。

第 14 章「CDR Repository 
Manager の設定」

CDR Management ウィンドウを使用して、Call Detail Record（CDR;
コール詳細レコード）と Call Management Record（CMR; コール管理

レコード）のファイルに割り当てるディスク スペースの容量、およ

びそれらのファイルを削除するまでの保存日数を設定し、また CDR
の宛先として最大 3 つの課金アプリケーション サーバを設定する

方法を説明します。

第 15 章「Serviceability 
Reports Archive の設定」

Serviceability Reporter サービスによって生成されるレポートの表示

手順を説明します。

第 16 章「SNMP V1/V2c の設

定」

SNMP バージョン 1 および 2c の設定手順を説明します。

第 17 章「SNMP V3 の設定」 SNMP バージョン 3 の設定手順を説明します。

第 18 章「MIB2 システム グ
ループの設定」

システムの連絡先およびシステムの場所のオブジェクトを MIB-II
システム グループに設定する手順を説明します。
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このマニュアルについて

関連マニュアル

関連マニュアル

Cisco IP テレフォニー関連のアプリケーションと製品の詳細については、『Cisco Unified CallManager
Documentation Guide』を参照してください。次の URL は、ドキュメント ガイドにアクセスするた

めのパスの一例です。

http://www.cisco.com/univercd/cc/td/doc/product/voice/c_callmg/< リリース番号 >/doc_gd/index.htm

表記法

このマニュアルは、次の表記法を使用しています。

（注）は、次のように表しています。

（注） 「注釈」です。役立つ情報や、このマニュアル以外の参照資料などを紹介しています。

ワンポイント アドバイスは、次のように表しています。

ワンポイント・アドバイス 時間を節約する方法です。ここに紹介している方法で作業を行うと、時間を短縮できます。

表記法 説明

太字 コマンドおよびキーワードは、太字で示しています。

イタリック体 ユーザが値を指定する引数は、イタリック体で示しています。

[ ] 角カッコの中の要素は、省略可能です。

{ x | y | z } 必ずどれか 1 つを選択しなければならない必須キーワードは、波カッコ

で囲み、縦棒で区切って示しています。

[ x | y | z ] どれか 1 つを選択できる省略可能なキーワードは、角カッコで囲み、縦

棒で区切って示しています。

ストリング 引用符を付けない一組の文字。ストリングの前後には引用符を使用しま

せん。引用符を使用すると、その引用符も含めてストリングとみなされ

ます。

screen フォント システムが表示する端末セッションおよび情報は、screen フォントで示

しています。

太字の screen フォント ユーザが入力しなければならない情報は、太字の screen フォントで示

しています。

イタリック体の screen
フォント

ユーザが値を指定する引数は、イタリック体の screen フォントで示し

ています。

このポインタは、例文中の重要な行を強調表示します。

^ ^ 記号は、Ctrl キーを表します。たとえば、画面に表示される ^D という

キーの組み合せは、Ctrl キーを押しながら D キーを押すことを意味しま

す。

< > パスワードなどの出力されない文字は、かぎカッコで囲みます。
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表記法

ヒントは、次のように表しています。

ヒント 便利なヒントです。

注意は、次のように表しています。

注意 「要注意」の意味です。機器の損傷またはデータ損失を予防するための注意事項が記述されていま

す。

警告は、次のように表しています。

警告 「危険」の意味です。人身事故を予防するための注意事項が記述されています。機器の作業を行う

ときは、電気回路の危険性および一般的な事故防止対策に十分注意してください。
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技術情報の入手方法

技術情報の入手方法

シスコの製品マニュアルやその他の資料は、Cisco.com でご利用いただけます。また、テクニカル

サポートおよびその他のリソースを、さまざまな方法で入手することができます。ここでは、シス

コ製品に関する技術情報を入手する方法について説明します。

Cisco.com
次の URL から、シスコ製品の最新資料を入手することができます。

http://www.cisco.com/techsupport

シスコの Web サイトには、次の URL からアクセスしてください。

http://www.cisco.com

各国のシスコ Web サイトには、次の URL からアクセスできます。

http://www.cisco.com/public/countries_languages.shtml

シスコ製品の最新資料の日本語版は、次の URL からアクセスしてください。

http://www.cisco.com/jp

このマニュアルには、日本語化されたマニュアル名と英語版 URL が併記された箇所があります。日

本語版マニュアルを参照する場合は、次の URL にアクセスしてください。

http://www.cisco.com/japanese/warp/public/3/jp/service/manual_j/index.shtml

Product Documentation DVD（英語版）

シスコ製品のマニュアルおよびその他の資料は、製品に付属の Product Documentation DVD パッケー

ジでご利用いただけます。Product Documentation DVD は定期的に更新されるので、印刷資料よりも

新しい情報が得られます。

Product Documentation DVD は、技術情報を包含する製品マニュアルをポータブルなメディアに格納

した、包括的なライブラリです。この DVD を使用することにより、シスコ製の各ハードウェアや

ソフトウェアのインストール、コンフィギュレーション、およびコマンドに関する複数のバージョ

ンのマニュアルにアクセスし、技術情報を HTML で参照できます。また、この DVD を使用すると、

シスコの Web サイトで参照できるのと同じマニュアルに、インターネットに接続せずにアクセス

できます。一部の製品については、PDF 版のマニュアルもご利用いただけます。

Product Documentation DVD は、1 回単位で入手することも、または定期購読することもできます。

Cisco.com 登録ユーザ（Cisco Direct Customers）の場合、Cisco Marketplace から Product Documentation
DVD（Product Number DOC-DOCDVD=）を発注できます。

http://www.cisco.com/go/marketplace/

マニュアルの発注方法（英語版）

2005 年 6 月 30 日以降、Cisco.com 登録ユーザの場合、Cisco Marketplace の Product Documentation
Store からシスコ製品の英文マニュアルを発注できるようになっています。次の URL にアクセスし

てください。

http://www.cisco.com/go/marketplace/

Cisco.com に登録されていない場合、製品を購入された代理店へお問い合せください。

http://www.cisco.com/techsupport
http://www.cisco.com
http://www.cisco.com/public/countries_languages.shtml
http://www.cisco.com/go/marketplace/
http://www.cisco.com/go/marketplace/
mailto:tech-doc-store-mkpl@external.cisco.com
http://www.cisco.com/jp
http://www.cisco.com/japanese/warp/public/3/jp/service/manual_j/index.shtml
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このマニュアルについて

技術情報の入手方法

シスコシステムズマニュアルセンター

シスコシステムズマニュアルセンターでは、シスコ製品の日本語マニュアルの最新版を PDF 形式で

公開しています。また、日本語マニュアル、および日本語マニュアル CD-ROM もオンラインで発

注可能です。ご希望の方は、次の URL にアクセスしてください。

http://www2.hipri.com/cisco/

また、シスコシステムズマニュアルセンターでは、日本語マニュアル中の誤記、誤植に関するコメ

ントをお受けしています。次の URL の「製品マニュアル内容不良報告」をクリックすると、コメ

ント入力画面が表示されます。

http://www2.hipri.com/cisco/

なお、技術内容に関するお問い合せは、この Web サイトではお受けできませんので、製品を購入

された各代理店へお問い合せください。

http://www2.hipri.com/cisco/
http://www2.hipri.com/cisco/
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シスコ製品のセキュリティの概要

シスコ製品のセキュリティの概要

本製品には暗号化機能が備わっており、輸入、輸出、配布および使用に適用される米国および他の

国での法律を順守するものとします。シスコの暗号化製品を譲渡された第三者は、その暗号化技術

の輸入、輸出、配布、および使用を許可されたわけではありません。輸入業者、輸出業者、販売業

者、およびユーザは、米国および他の国での法律を順守する責任があります。本製品を使用するに

あたっては、関係法令の順守に同意する必要があります。米国および他の国の法律を順守できない

場合は、本製品を至急送り返してください。

シスコの暗号化製品に適用される米国の法律の概要については、

http://www.cisco.com/wwl/export/crypto/tool/stqrg.html で参照できます。

何かご不明な点があれば、export@cisco.com まで電子メールを送信してください。

シスコでは、オンラインの Security Vulnerability Policy ポータル（英文のみ）を無料で提供していま

す。URL は次のとおりです。

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html

このサイトは、次の目的に利用できます。

• シスコ製品のセキュリティ脆弱性を報告する。

• シスコ製品に伴うセキュリティ事象についてサポートを受ける。

• シスコからセキュリティ情報を受け取るための登録をする。

シスコ製品に関するセキュリティ勧告および注意事項の最新のリストには、次の URL からアクセ

スできます。

http://www.cisco.com/go/psirt

勧告および注意事項がアップデートされた時点でリアルタイムに確認する場合は、次の URL から

Product Security Incident Response Team Really Simple Syndication（PSIRT RSS）フィードにアクセス

してください。

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html

シスコ製品のセキュリティ問題の報告

シスコでは、セキュアな製品を提供すべく全力を尽くしています。製品のリリース前には内部でテ

ストを行い、すべての脆弱性を早急に修正するよう努力しています。万一、シスコ製品に脆弱性が

見つかった場合は、PSIRT にご連絡ください。

• 緊急の場合：security-alert@cisco.com（英語のみ）

緊急とは、システムがアクティブな攻撃を受けている場合、または至急の対応を要する重大な

セキュリティ上の脆弱性が報告されている場合を指します。これに該当しない場合はすべて、

緊急でないと見なされます。

• 緊急でない場合：psirt@cisco.com（英語のみ）

緊急の場合は、電話で PSIRT に連絡することもできます。

• 1 877 228-7302（英語のみ）

• 1 408 525-6532（英語のみ）

http://www.cisco.com/wwl/export/crypto/tool/stqrg.html
http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html
http://www.cisco.com/go/psirt
http://www.cisco.com/en/US/products/products_psirt_rss_feed.html
mailto:security-alert@cisco.com
mailto:psirt@cisco.com
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このマニュアルについて

シスコ製品のセキュリティの概要

ヒント シスコに機密情報をお送りいただく際には、PGP（Pretty Good Privacy）または互換製品を使用して、

暗号化することをお勧めします。PSIRT は、PGP バージョン 2.x から 8.x と互換性のある暗号化情

報に対応しています。 

無効になった、または有効期限が切れた暗号鍵は、絶対に使用しないでください。PSIRT に連絡す

る際に使用する正しい公開鍵には、Security Vulnerability Policy ページの Contact Summary セクショ

ンからリンクできます。次の URL にアクセスしてください。

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html

このページ上のリンクからは、現在使用されている最新の PGP 鍵の ID にアクセスできます。

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html
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テクニカル サポート

テクニカル サポート

Cisco Technical Support では、24 時間テクニカル サポートを提供しています。Cisco.com の Cisco
Technical Support & Documentation Web サイトでは、多数のサポート リソースをオンラインで提供

しています。また、シスコと正式なサービス契約を交わしているお客様には、Cisco Technical
Assistance Center（TAC）のエンジニアが電話でのサポートにも対応します。シスコと正式なサービ

ス契約を交わしていない場合は、代理店にお問い合せください。

Cisco Technical Support & Documentation Web サイト

Cisco Technical Support & Documentation Web サイトでは、シスコ製品やシスコの技術に関するトラ

ブルシューティングにお役立ていただけるように、オンラインでマニュアルやツールを提供してい

ます。この Web サイトは、24 時間、いつでも利用可能です。URL は次のとおりです。

http://www.cisco.com/techsupport

Cisco Technical Support & Documentation Web サイトのツールにアクセスするには、Cisco.com のユー

ザ ID とパスワードが必要です。サービス契約が有効で、ユーザ ID またはパスワードを取得してい

ない場合は、次の URL にアクセスして登録手続きを行ってください。

http://tools.cisco.com/RPF/register/register.do

（注） Web または電話でサービス リクエストを発行する前に、Cisco Product Identification（CPI）ツールを

使用して製品のシリアル番号を確認してください。CPI ツールには、Cisco Technical Support &
Documentation Web サイトから、Documentation & Tools の下の Tools & Resources リンクをクリック

するとアクセスできます。アルファベット順の索引ドロップダウン リストから Cisco Product
Identification Tool を選択するか、Alerts & RMAs の下の Cisco Product Identification Tool リンクを

クリックします。CPI ツールには、3 つの検索オプションがあります。製品 ID またはモデル名によ

る検索、ツリー表示による検索、show コマンド出力のコピー アンド ペーストによる特定製品の検

索です。検索結果では、製品が図示され、シリアル番号ラベルの位置が強調表示されます。ご使用

の製品でシリアル番号ラベルを確認し、その情報を記録してからサービス コールをかけてくださ

い。

Japan TAC Web サイト

Japan TAC Web サイトでは、利用頻度の高い TAC Web サイト（http://www.cisco.com/tac）のドキュ

メントを日本語で提供しています。Japan TAC Web サイトには、次の URL からアクセスしてくだ

さい。

http://www.cisco.com/jp/go/tac

サポート契約を結んでいない方は、「ゲスト」としてご登録いただくだけで、Japan TAC Web サイ

トのドキュメントにアクセスできます。Japan TAC Web サイトにアクセスするには、Cisco.com の
ログイン ID とパスワードが必要です。ログイン ID とパスワードを取得していない場合は、次の

URL にアクセスして登録手続きを行ってください。

http://www.cisco.com/jp/register

http://www.cisco.com/tac
http://www.cisco.com/techsupport
http://tools.cisco.com/RPF/register/register.do
http://www.cisco.com/jp/go/tac
http://www.cisco.com/jp/register
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テクニカル サポート

サービス リクエストの発行

オンラインの TAC Service Request Tool を使用すると、S3 と S4 のサービス リクエストを短時間で

オープンできます（S3：ネットワークに軽微な障害が発生した、S4：製品情報が必要である）。状

況を入力すると、その状況を解決するための推奨手段が検索されます。これらの推奨手段で問題を

解決できない場合は、シスコのエンジニアが対応します。TAC Service Request Tool には、次の URL
からアクセスできます。

http://www.cisco.com/techsupport/servicerequest

S1 または S2 のサービス リクエストの場合、またはインターネットにアクセスできない場合は、

Cisco TAC に電話でお問い合せください（S1：ネットワークがダウンした、S2：ネットワークの機

能が著しく低下した）。S1 および S2 のサービス リクエストには、シスコのエンジニアがすぐに割

り当てられ、業務を円滑に継続できるようサポートします。

Cisco TAC の連絡先については、次の URL を参照してください。

http://www.cisco.com/techsupport/contacts

サービス リクエストのシビラティの定義

シスコでは、報告されるサービス リクエストを標準化するために、シビラティを定義しています。

シビラティ 1（S1）：ネットワークが「ダウン」した状態か、業務に致命的な損害が発生した場合。

お客様およびシスコが、24 時間体制でこの問題を解決する必要があると判断した場合。 

シビラティ 2（S2）：既存のネットワーク動作が著しく低下したか、シスコ製品が十分に機能しない

ため、業務に重大な影響を及ぼした場合。お客様およびシスコが、通常の業務中の全時間を費やし

て、この問題を解決する必要があると判断した場合。

シビラティ 3（S3）：ネットワークの動作パフォーマンスが低下しているが、ほとんどの業務運用は

継続できる場合。お客様およびシスコが、業務時間中にサービスを十分なレベルにまで復旧させる

必要があると判断した場合。

シビラティ 4（S4）：シスコ製品の機能、インストレーション、コンフィギュレーションについて、

情報または支援が必要な場合。業務の運用には、ほとんど影響がありません。

http://www.cisco.com/techsupport/servicerequest
http://www.cisco.com/techsupport/contacts
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その他の資料および情報の入手方法

シスコの製品、テクノロジー、およびネットワーク ソリューションに関する情報について、さまざ

まな資料をオンラインおよび印刷物で入手できます。

• Cisco Marketplace では、シスコの書籍やリファレンス ガイド、マニュアル、ロゴ製品を数多く

提供しています。購入を希望される場合は、次の URL にアクセスしてください。

http://www.cisco.com/go/marketplace/

• Cisco Press では、ネットワーク全般、トレーニング、および認定資格に関する出版物を幅広く

発行しています。これらの出版物は、初級者にも上級者にも役立ちます。Cisco Press の最新の

出版物やその他の情報を調べるには、次の URL から Cisco Press にアクセスしてください。

http://www.ciscopress.com

• 『Packet』はシスコシステムズが発行する技術者向けの雑誌で、インターネットやネットワーク

への投資を最大限に活用するために役立ちます。本誌は季刊誌として発行され、業界の最先端

トレンド、最新テクノロジー、シスコ製品やソリューション情報が記載されています。また、

ネットワーク構成およびトラブルシューティングに関するヒント、コンフィギュレーション

例、カスタマー ケース スタディ、認定情報とトレーニング情報、および充実したオンライン

サービスへのリンクの内容が含まれます。『Packet』には、次の URL からアクセスしてください。

http://www.cisco.com/packet

日本語版『Packet』は、米国版『Packet』と日本版のオリジナル記事で構成されています。日本

語版『Packet』には、次の URL からアクセスしてください。

http://www.cisco.com/japanese/warp/public/3/jp/news/packet/

• 『iQ Magazine』はシスコシステムズの季刊誌で、成長企業が収益を上げ、業務を効率化し、サー

ビスを拡大するためには技術をどのように利用したらよいかを学べるように構成されていま

す。本誌では、実例とビジネス戦略を挙げて、成長企業が直面する問題とそれを解決するため

の技術を紹介し、読者が技術への投資に関して適切な決定を下せるよう配慮しています。『iQ
Magazine』には、次の URL からアクセスしてください。

http://www.cisco.com/go/iqmagazine

デジタル版には、次の URL からアクセスできます。

http://ciscoiq.texterity.com/ciscoiq/sample/

• 『Internet Protocol Journal』は、インターネットおよびイントラネットの設計、開発、運用を担

当するエンジニア向けに、シスコが発行する季刊誌です。『Internet Protocol Journal』には、次

の URL からアクセスしてください。

http://www.cisco.com/ipj

• シスコシステムズが提供するネットワーキング製品、および各種のカスタマー サポート サー

ビスは、次の URL から入手できます。

http://www.cisco.com/en/US/products/index.html

• Networking Professionals Connection は対話形式の Web サイトです。このサイトでは、ネットワー

キング製品やテクノロジーに関する質問、提案、および情報をネットワーキング担当者がシス

コの専門家や他のネットワーキング担当者と共有できます。次の URL にアクセスしてディス

カッションに参加してください。

http://www.cisco.com/discuss/networking

• シスコは、国際的なレベルのネットワーク関連トレーニングを実施しています。最新情報につ

いては、次の URL からアクセスしてください。

http://www.cisco.com/en/US/learning/index.html

http://www.cisco.com/go/marketplace/
http://www.ciscopress.com
http://www.cisco.com/packet
http://www.cisco.com/go/iqmagazine
http://ciscoiq.texterity.com/ciscoiq/sample/
http://www.cisco.com/ipj
http://www.cisco.com/en/US/products/index.html
http://www.cisco.com/discuss/networking
http://www.cisco.com/en/US/learning/index.html
http://www.cisco.com/japanese/warp/public/3/jp/news/packet/
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概要

この章は、次の項で構成されています。

• Cisco Unified CallManager Serviceability の概要（P.1-2）

• Cisco Unified CallManager Serviceability へのアクセス（P.1-3）

• Hypertext Transfer Protocol over Secure Sockets Layer（HTTPS）の使用方法（P.1-4）

• Cisco Unified CallManager Serviceability のインターフェイスの使用（P.1-7）

• アクセシビリティ機能（P.1-9）

• 参考情報（P.1-9）



第 1 章      概要

  Cisco Unified CallManager Serviceability の概要
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Cisco Unified CallManager Serviceability の概要

Cisco Unified CallManager の Web ベースのトラブルシューティング ツールである Cisco Unified
CallManager Serviceability は、次の機能を備えています。

• トラブルシューティングに備えて、 Cisco Unified CallManager サービスのアラームとイベントを

保存します。また、アラーム メッセージの定義も提供します。

• トラブルシューティングに備えて、Cisco Unified CallManager サービスのトレース情報を各種ロ

グ ファイルに保存します。システム管理者は、トレース情報の設定、収集、および表示を行う

ことができます。

• Real-Time Monitoring Tool（RTMT）を使用して、Cisco Unified CallManager クラスタ内のコン

ポーネントの動作をリアルタイムでモニタします。

• Cisco Unified CallManager CDR Analysis and Reporting（CAR）ツールを使用して、サービス品質、

トラフィック、および課金情報のレポートを生成します。

• Service Activation ウィンドウでアクティブ化、非アクティブ化、および表示できる機能サービ

スを提供します。 

• 機能サービスとネットワーク サービスを起動および停止するインターフェイスを提供します。

• Cisco Unified CallManager Serviceability ツールに関連付けられるレポートをアーカイブします。

• Cisco Unified CallManager が、SNMP リモート管理とトラブルシューティングのための管理対象

デバイスとして機能するのを可能にします。

• 1 つのサーバ（またはクラスタ内のすべてのサーバ）上のログ パーティションのディスク使用

状況をモニタします。
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Cisco Unified CallManager Serviceability へのアクセス

Cisco Unified CallManager Serviceability にアクセスするには、次の手順を実行します。

手順

ステップ 1 Netscape 7.1（またはそれ以降）あるいは Internet Explorer 6.0（またはそれ以降）を使用して、Cisco
Unified CallManager Serviceability サービスが動作している Cisco Unified CallManager 5.0 サーバをブ

ラウズします。 

ヒント サポートされているブラウザで、https://< サーバ名または IP アドレス >:8443 と入力しま

す。ここで、「サーバ名または IP アドレス」は Cisco Unified CallManager Serviceability サー

ビスが実行されているサーバ、8443 は HTTPS のポート番号を表します。

ブラウザで http://< サーバ名または IP アドレス >:8080 と入力すると、HTTPS を使用する

ようにシステムによってリダイレクトされます。HTTP は、ポート番号 8080 を使用しま

す。

ステップ 2 ［Cisco Unified CallManager の管理］リンクをクリックします。

ステップ 3 証明書に関するプロンプトが表示された場合は、P.1-4 の「Hypertext Transfer Protocol over Secure
Sockets Layer（HTTPS）の使用方法」を参照してください。

ステップ 4 システムでユーザ名とパスワードを尋ねるプロンプトが初めて表示されたときは、ユーザ名に

CCMAdministrator と入力し、パスワードには、インストール中に指定したアプリケーション ユー

ザ パスワードを入力します。

ヒント Standard CCMUsers ロールが割り当てられたユーザはすべて、Cisco Unified CallManager
Serviceability にアクセスできます。このロールをユーザに割り当てる方法の詳細について

は、『Cisco Unified CallManager アドミニストレーション ガイド』を参照してください。

ステップ 5 Cisco Unified CallManager の管理ページが表示されたら、ウィンドウの右上の［ナビゲーション］ド

ロップダウン リスト ボックスで［Cisco Unified CallManager のサービスアビリティ］を選択します。

Cisco Unified CallManager Serviceability が表示されます。

ヒント 設定の途中で Cisco Unified CallManager Serviceability メイン ウィンドウに戻るには、アプ

リケーション ウィンドウの右上のドロップダウン リストボックスから Cisco Unified 
CallManager Serviceability を選択して Go ボタンをクリックします。

追加情報

P.1-10 の「関連項目」を参照してください。
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Hypertext Transfer Protocol over Secure Sockets Layer（HTTPS）
の使用方法

この項は、次の内容で構成されています。

• Internet Explorer での HTTPS の概要（P.1-4）

• Internet Explorer の信頼できるフォルダへの証明書の保存（P.1-5）

（注） HTTPS の詳細については、『Cisco Unified CallManager セキュリティ ガイド』を参照してください。

ブラウザ クライアントと Tomcat Web サーバ間の通信を保護する Hypertext Transfer Protocol over
Secure Sockets Layer（HTTPS）は、証明書と公開鍵を使って、インターネット上で転送されるデー

タを暗号化します。HTTPS はサーバの ID を検証し、Cisco Unified CallManager Serviceability などの

アプリケーションをサポートします。また、ユーザ ログイン パスワードが Web を介して安全に送

信されるようにします。

Internet Explorer での HTTPS の概要

Cisco Unified CallManager 5.0 のインストールまたはアップグレード後に、Cisco Unified CallManager
の管理ページまたはその他の Cisco Unified CallManager SSL 対応の仮想ディレクトリに管理者また

はユーザが初めてアクセスすると、［セキュリティの警告］ダイアログボックスが開き、サーバを

信頼するかどうか確認します。このダイアログボックスが表示されたら、以下のいずれかの操作を

実行する必要があります。

• ［はい］をクリックして、現在の Web セッションの証明書だけを信頼する。現在のセッション

の証明書だけを信頼した場合、信頼できるフォルダに証明書がインストールされるまで、アプ

リケーションにアクセスするたびに［セキュリティの警告］ダイアログボックスが表示されま

す。 

• ［証明書の表示］>［証明書のインストール］をクリックして、常に証明書を信頼するように、

証明書のインストール タスクを実行する。信頼できるフォルダに証明書をインストールする

と、Web アプリケーションにアクセスするたびに［セキュリティの警告］ダイアログボックス

が表示されることはありません。

• ［いいえ］をクリックして、操作を中止する。認証は行われず、Web アプリケーションにアク

セスできません。Web アプリケーションにアクセスするには、［はい］をクリックするか、ま

たは［証明書の表示］>［証明書のインストール］オプションで証明書をインストールします。 

（注） システムは、ホスト名を使用して証明書を発行します。IP アドレスを使用して Web アプリケーショ

ンへのアクセスを試みると、クライアントに証明書がインストールされている場合でも、［セキュ

リティの警告］ダイアログボックスが表示されます。

追加情報

P.1-10 の「関連項目」を参照してください。
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Internet Explorer の信頼できるフォルダへの証明書の保存

信頼できるフォルダに CA ルート証明書を保存して、Web アプリケーションにアクセスするたびに

［セキュリティの警告］ダイアログボックスが表示されないようにするには、次の手順を実行しま

す。

手順

ステップ 1 Tomcat Web サーバでアプリケーションをブラウズします。

ステップ 2 ［セキュリティの警告］ダイアログボックスが表示されたら、［証明書の表示］ をクリックします。 

ステップ 3 ［証明書］ペインで、［証明書のインストール］をクリックします。

ステップ 4 ［次へ］をクリックします。

ステップ 5 ［証明書をすべて次のストアに配置する］オプション ボタンを選択して、［参照］をクリックします。

ステップ 6 ［信頼されたルート証明機関］を参照します。

ステップ 7 ［次へ］をクリックします。

ステップ 8 ［完了］をクリックします。

ステップ 9 証明書をインストールするには、［はい］をクリックします。

インポートが成功したというメッセージが表示されます。OK をクリックします。

ステップ 10 ダイアログボックスの右下にある OK をクリックします。

ステップ 11 証明書を信頼し、ダイアログボックスが再び表示されないようにするには、［はい］をクリックし

ます。

追加情報

P.1-10 の「関連項目」を参照してください。
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Netscape を使用した信頼できるフォルダへの証明書の保存

Netscape で HTTPS を使用すると、証明書のクレデンシャルを表示する、1 つのセッションでのみ証

明書を信頼する、証明書の有効期限まで信頼する、証明書を信頼しない、という選択肢を利用でき

ます。 

ヒント 1 つのセッションでのみ証明書を信頼する場合は、HTTPS をサポートするアプリケーションにアク

セスするたびに、この手順を繰り返す必要があります。証明書を信頼しない場合は、アプリケー

ションにアクセスできません。

信頼できるフォルダに証明書を保存するには、次の手順を実行します。

手順

ステップ 1 Netscape を使用して、Cisco Unified CallManager Serviceability などのアプリケーションを参照します。

認証局のダイアログボックスが表示されます。

ステップ 2 次のオプション ボタンのいずれかをクリックします。

• ［この証明書をこのセッションのために一時的に受け入れる］

• ［この証明書を受け入れない / この Web サイトに接続しない］

• ［この証明書を永続的に受け入れる］

（注） ［この証明書を受け入れない / この Web サイトに接続しない］を選択した場合、アプリケー

ションは表示されません。

（注） 次に進む前に証明書のクレデンシャルを表示するには、［証明書を調査］をクリックします。

クレデンシャルを確認し、［閉じる］をクリックします。

ステップ 3 OK をクリックします。

［セキュリティに関する警告］ダイアログボックスが表示されます。

ステップ 4 OK をクリックします。

追加情報

P.1-10 の「関連項目」を参照してください。
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Cisco Unified CallManager Serviceability のインターフェイスの使用

Cisco Unified CallManager Serviceability では、トラブルシューティングやサービス関連タスクの実行

に加えて、次のタスクを実行できます。

• Dialed Number Analyzer にアクセスして、Cisco Unified CallManager のダイヤル プラン設定のテ

ストと診断、テスト結果の分析、および結果を使用してダイヤル プランの調整を行うには、

Tools > Dialed Number Analyzer の順に選択して、Cisco Dialed Number Analyzer サービスをアク

ティブにします。Dialed Number Analyzer の使用方法の詳細については、『Cisco Unified 
CallManager Dialed Number Analyzer ガイド』を参照してください。

• 1 つの特定ウィンドウに関するドキュメントを表示するには、Cisco Unified CallManager 
Serviceability で、Help > This Page の順に選択します。

• このリリースの Cisco Unified CallManager で利用できるマニュアルのリストを表示（またはオ

ンライン ヘルプの索引にアクセス）するには、Cisco Unified CallManager Serviceability で Help
> Contents の順に選択します。

• Cisco Unified CallManager Serviceability で使用されるエラー コードを表示するには、Help > 
Error Codes の順に選択します。エラー コードと説明が表示されます。

• サーバ上で実行されている Cisco Unified CallManager Serviceability のバージョンを確認するに

は、Help > About の順に選択します。

• 設定のウィンドウから Cisco Unified CallManager Serviceability のホーム ページに直接移動する

には、ウィンドウの右上にあるドロップダウン リストボックスから Cisco Unified CallManager
Serviceability を選択して Go ボタンをクリックします。 

• Cisco Unified CallManager の管理ページまたは他のアプリケーションにアクセスするには、ウィ

ンドウの右上の［ナビゲーション］ドロップダウン リスト ボックスで適切なアプリケーショ

ンを選択します。 

• Cisco Unified CallManager Serviceability でアイコンを使用するには、表 1-1 を参照してください。

表 1-1 Cisco Unified CallManager Serviceability のアイコン

アイコン 目的

新しい設定を追加します。

操作を取り消します。

指定した設定をクリアします。

選択した設定を削除します。
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設定に関するオンライン ヘルプを表示します。

ウィンドウを更新して最新の設定を表示します。

選択したサービスを再起動します。

入力した情報を保存します。

設定のデフォルトを定義します。

選択したサービスを起動します。

選択したサービスを停止します。

表 1-1 Cisco Unified CallManager Serviceability のアイコン（続き）

アイコン 目的
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アクセシビリティ機能

Cisco Unified CallManager Serviceability の管理には、ユーザがマウスを使用せずにウィンドウ上のボ

タンにアクセスできる機能が用意されています。これらのナビゲーション ショートカットにより、

視覚障害を持つユーザにもアプリケーションが使用しやすくなります。 

表 1-2 は、キーボード ショートカットでインターフェイスをナビゲーションする際のガイドです。 

参考情報

• Cisco Unified CallManager アドミニストレーション ガイド

• Cisco Unified CallManager システム ガイド

• Cisco Unified CallManager Serviceability システム ガイド

• Cisco Unified CallManager CDR Analysis and Reporting アドミニストレーション ガイド

• Cisco Unified CallManager セキュリティ ガイド

• CiscoWorks2000 ユーザ マニュアル

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/index.htm

追加情報

P.1-10 の「関連項目」を参照してください。

表 1-2 Cisco Unified CallManager Serviceability のナビゲーション ショートカット

キーストローク 動作

Alt ブラウザのメニュー バーにフォーカスを移動します。

Enter 項目（メニュー オプション、ボタンなど）をフォーカスして選択します。

Alt、矢印キー ブラウザ メニュー間を移動します。

スペースバー チェックボックスのオン / オフなどのコントロールを切り替えます。

Tab タブ順の次の項目または次のコントロール グループにフォーカスを移動

します。

Shift+Tab タブ順の前の項目またはグループにフォーカスを移動します。

矢印キー グループ内でコントロール間を移動します。

Home 1 画面分を超える情報が存在する場合、ウィンドウの一番上に移動します。

また、ユーザが入力したテキストの最初の行に移動します。

End ユーザが入力したテキストの最後の行に移動します。

1 画面分を超える情報が存在する場合、ウィンドウの一番下に移動します。

Page Up 1 画面分だけ上にスクロールします。

Page Down 1 画面分だけ下にスクロールします。

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/index.htm
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関連項目

• Hypertext Transfer Protocol over Secure Sockets Layer（HTTPS）の使用方法（P.1-4）

• Internet Explorer での HTTPS の概要（P.1-4）

• Internet Explorer の信頼できるフォルダへの証明書の保存（P.1-5）
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2

サービスの管理

この章は、次の項で構成されています。

• 機能サービスのアクティブ化と非アクティブ化（P.2-2）

• Control Center におけるサービスの開始、停止、再起動、および更新状況（P.2-6）

• コマンドライン インターフェイスを使用したサービスの開始と停止（P.2-8）
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機能サービスのアクティブ化と非アクティブ化

Cisco Unified CallManager Serviceability では、Service Activation ウィンドウでサービスをアクティブ

または非アクティブにします。Service Activation ウィンドウに表示されているサービスは、アクティ

ブにするまで起動できません。

Cisco Unified CallManager では、機能サービスのみをアクティブおよび非アクティブにできます。必

要な数のサービスを同時にアクティブまたは非アクティブにすることができます。一部の機能サー

ビスは他のサービスに依存していますが、その場合は、対象の機能サービスがアクティブになる前

に従属サービスがアクティブになります。 

ヒント Service Activation ウィンドウでサービスをアクティブにする前に、表 2-1 を確認してください。

Cisco Unified CallManager Serviceability で Cisco Unified CallManager サービスをアクティブまたは非

アクティブにするには、次の手順を実行します。

手順

ステップ 1 Tools > Service Activation の順に選択します。

Service Activation ウィンドウが表示されます。

ステップ 2 Server ドロップダウン リストボックスで、サーバを選択します。

選択したサーバのサービス名およびサービスのアクティベーション ステータスがウィンドウに表

示されます。

ステップ 3 次のいずれかの操作を実行します。

• 単一サーバの設定でサービスをアクティブにする場合は、Set Default ボタンをクリックするか、

使用するサービスをアクティブにします。

Set Default ボタンをクリックすると、単一サーバ上での実行に必要なサービスをすべて選択で

きます。この操作を行うと、必要なサービスがすべて選択されるだけでなく、サービスの依存

関係もチェックされます。 

• 複数サーバの設定の場合は、表 2-1 でサービス アクティベーションに関する推奨事項を確認し

た後、アクティブにするサービスの横のチェックボックスをオンにします。
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表 2-1 サービス アクティベーションに関する推奨事項

サービス /servlet アクティベーションに関する推奨事項

CM Services

Cisco CallManager このサービスは Cisco Unified CallManager をサポートします。

Control Center - Network Services で、Cisco RIS Data Collector サービスと 
Database Layer Monitor サービスがサーバ上で動作していることを確認

します。

ヒント このサービスをアクティブにする前に、Cisco Unified 
CallManager の管理ページの［Cisco Unified CallManager の検索

と一覧表示 (Find and List Cisco Unified CallManagers)］ウィン

ドウに Cisco Unified CallManager が表示されていることを確

認します。サーバが表示されていない場合は、このサービス

をアクティブにする前に、Cisco Unified CallManager を追加し

ます。Cisco Unified CallManager の追加方法の詳細については、

『Cisco Unified CallManager アドミニストレーション ガイド』

を参照してください。

Cisco TFTP クラスタ内に複数のサーバが存在する場合、Cisco TFTP サービス専用の

1 つのサーバ上でこのサービスをアクティブにします。クラスタ内の複

数のサーバ上でこのサービスをアクティブにする場合は、Option 150 を
設定します。

Cisco Messaging Interface クラスタ内の 1 つのサーバ上でのみアクティブにします。Cisco Unity ボ
イス メッセージ システムを使用する予定がある場合は、このサービス

をアクティブにしないでください。

Cisco IP Voice Media 
Streaming Application

クラスタに複数のサーバが存在する場合は、クラスタごとに 1 つまたは

2 つのサーバをアクティブにします。Music On Hold 専用のサーバ上でア

クティブにすることもできます。このサービスを使用するには、クラス

タ内の 1 つのサーバ上で Cisco TFTP をアクティブにする必要がありま

す。Cisco CallManager サービスを実行するファースト ノード サーバや

その他のサーバ上では、このサービスをアクティブにしないでくださ

い。 

Cisco CTIManager JTAPI/TAPI アプリケーションが接続する各サーバでアクティブにしま

す。CTIManager をアクティブにするには、Cisco CallManager サービス

もサーバ上でアクティブにする必要があります。CTIManager と Cisco
CallManager サービスのインタラクションの詳細については、「Cisco
CallManager」 サービスを参照してください。 

Cisco CallManager 
Attendant Console Server

Cisco Unified CallManager Attendant Console を使用する場合は、Cisco
CallManager サービスを実行するクラスタ内のすべてのサーバ上でアク

ティブにします。

Cisco Extension Mobility Cisco Extension Mobility アプリケーションがアクセスする各サーバ上で

アクティブにします。

Cisco IP Phone Services クラスタ内の任意の 1 つのサーバでのみアクティブにします。

Cisco Dialed Number 
Analyzer

Cisco Unified CallManager Dialed Number Analyzer を使用する場合は、こ

のサービスをアクティブにします。このサービスは大量のリソースを消

費する可能性があるので、コール処理アクティビティが最も少ないノー

ドでアクティブにするか、オフピーク時にアクティブにします。 



第 2 章      サービスの管理

  機能サービスのアクティブ化と非アクティブ化

2-4
Cisco Unified CallManager Serviceability アドミニストレーション ガイド

OL-9418-01-J

Cisco Extension Mobility 
Application

このアプリケーションは、Cisco Extension Mobility がアクティブにされ

ると自動的にアクティブになります。

Cisco DHCP Monitor 
Service

DHCP Monitor サービスを有効にすると、IP Phone の IP アドレスに影響

を与えるデータベース内の変更が検出され、/etc/dhcpd.conf ファイルが

変更され、更新された設定ファイルを使用して DHCPD デーモンが停止

および再起動されます。このサービスは、DHCP が有効なサーバ上でア

クティブにします。

CTI Services

Cisco IP Manager 
Assistant

Cisco Unified CallManager Assistant を使用する場合は、クラスタの 2 つの

サーバ（プライマリとバックアップ）上でこのサービスをアクティブに

します。クラスタ内で Cisco CTI Manager サービスがアクティブにされ

ていることを確認します。その他の推奨事項については、『Cisco Unified
CallManager 機能およびサービス ガイド』を参照してください。

Cisco WebDialer Web 
Service

クラスタごとに 1 つのサーバ上でアクティブにします。 

CDR Services

Cisco 
Soap-CDRonDemand 
Service

Cisco Soap-CDRonDemand サービスは、ファースト ノードでのみアク

ティブにできます。そのためには、Cisco CDR Repository Manager サービ

スと Cisco CDR Agent サービスが同じサーバ上で動作している必要があ

ります。 

Cisco CAR Scheduler Cisco CAR Scheduler サービスは、ファースト ノードでのみアクティブ

にできます。そのためには、Cisco CDR Repository サービスと Cisco CDR
Agent サービスが同じサーバ上で動作している必要があります。

Cisco CAR Web Service Cisco CAR Web サービスは、ファースト ノードでのみアクティブにでき

ます。そのためには、Cisco CAR Scheduler サービスがアクティブにされ

てサーバ上で動作し、Cisco CallManager CDR Repository Manager が同じ

サーバ上で動作している必要があります。

Database and Admin Services

Cisco AXL Web Service ファースト ノードでのみアクティブにします。このサービスのアクティ

ブ化に問題があると、AXL を使用するクライアントベースのアプリケー

ションから Cisco Unified CallManager を更新できません。

Cisco Bulk Provisioning 
Service

Cisco Bulk Provisioning サービスは、ファースト ノードでのみアクティ

ブにできます。Bulk Administration Tool（BAT）を使用して電話機とユー

ザを管理する場合は、このサービスをアクティブにする必要がありま

す。 

Performance and Monitoring Services

Cisco Serviceability 
Reporter

ファースト ノードでのみアクティブにします。

（注） 他のノード上でサービスをアクティブにしても、ファースト
ノード上でレポートが生成されるだけです。

Cisco CCM SNMP 
Service

SNMP を使用する場合は、このサービスをクラスタ内のすべてのサーバ

上でアクティブにします。

Security Services

Cisco CTL Provider クラスタ内のすべてのサーバ上でアクティブにします。

表 2-1 サービス アクティベーションに関する推奨事項（続き）

サービス /servlet アクティベーションに関する推奨事項



第 2 章      サービスの管理

  機能サービスのアクティブ化と非アクティブ化

2-5
Cisco Unified CallManager Serviceability アドミニストレーション ガイド

OL-9418-01-J

ステップ 4 必要な変更を加えたら、Save をクリックします。

ヒント アクティブにしたサービスを非アクティブにするには、非アクティブにするサービスの

横にあるチェックボックスをオフにし、Save をクリックします。

追加情報

P.2-8 の「関連項目」を参照してください。

Cisco Certificate 
Authority Proxy Function 
(CAPF)

ファースト ノードでのみアクティブにします。

Directory Services

Cisco DirSync ファースト ノードでのみアクティブにします。 

Backup and Restore Services

Cisco DRF Master クラスタ内の任意の 1 つのサーバでのみアクティブにします。

表 2-1 サービス アクティベーションに関する推奨事項（続き）

サービス /servlet アクティベーションに関する推奨事項
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Control Center におけるサービスの開始、停止、再起動、および更新状況

Cisco Unified CallManager Serviceability の Control Center では、クラスタ内の特定のサーバについて、

状況の表示、状況の更新、および Cisco Unified CallManager サービスの開始、停止、再起動を行う

ことができます。Cisco CallManager サービスを開始、停止、または再起動すると、その Cisco 
CallManager サービスに登録されている Cisco Unified IP Phone とゲートウェイはすべて、セカンダ

リ Cisco CallManager サービスにフェールオーバーされます。別の Cisco CallManager サービスに登

録できない場合にだけ、デバイスと電話機を再起動する必要があります。Cisco CallManager サービ

スを開始、停止、または再起動すると、その Cisco Unified CallManager をホームとする他のインス

トール済みアプリケーション（Conference Bridge や Cisco Messaging Interface など）も同様に開始お

よび停止します。

（注） Cisco Unified CallManager をアップグレードする場合、システム上ですでに開始されていたサービ

スは、アップグレード後に開始されます。

注意 Cisco CallManager サービスを停止すると、そのサービスが制御しているすべてのデバイスに対する

コール処理も停止します。Cisco CallManager サービスを停止した場合、IP Phone から別の IP Phone
へのコールは維持され、IP Phone から Media Gateway Control Protocol（MGCP）ゲートウェイに対

して進行中のコールも維持されます。その他のタイプのコールはドロップされます。

クラスタ内の特定のサーバ上のサービスの状況を開始、停止、再起動または表示するには、次の手

順を実行します。一度に開始、停止、またはリフレッシュできるサービスは、1 つだけです。

手順

ステップ 1 開始、停止、再起動、リフレッシュするサービス タイプによって、次のいずれかのタスクを実行し

ます。

• Tools > Control Center - Feature Services の順に選択します。

ヒント 開始、停止、再起動できるのは、アクティブにされている機能サービスのみです。サー

ビスをアクティブにするには、P.2-2 の「機能サービスのアクティブ化と非アクティブ化」

を参照してください。

• Tools > Control Center - Network Services の順に選択します。

ステップ 2 Server ドロップダウン リストボックスで、サーバを選択します。

選択したサーバのサービス名、サービス タイプ、およびサービスの状況がウィンドウに表示されま

す。ウィンドウには、サービスの状況（Started、Running、または Stopped）も表示されます。
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ステップ 3 次のいずれかの操作を実行します。

• 開始するサービスの横にあるオプション ボタンをクリックし、Start ボタンをクリックします。

更新された状況を反映して、Status が変更されます。

• 再起動するサービスの横にあるオプション ボタンをクリックし、Restart ボタンをクリックし

ます。

再起動に少し時間がかかることを示すメッセージが表示されます。OK をクリックします。

• 停止するサービスの横にあるオプション ボタンをクリックし、Stop ボタンをクリックします。

更新された状況を反映して、Status が変更されます。

• サービスの最新状況を表示するには、Refresh ボタンをクリックします。

• Service Activation ウィンドウやその他の Control Center ウィンドウに移動するには、Related Links
ドロップダウン リスト ボックスでオプションを選択し、Go をクリックします。

追加情報

P.2-8 の「関連項目」を参照してください。
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コマンドライン インターフェイスを使用したサービスの開始と停止

次のサービスは、コマンド ライン インターフェイス（CLI）でコマンドを実行することで、開始お

よび停止できます。

• Cisco Tomcat

• Cisco DB

• Cisco CallManager Serviceability

サービスを開始するには、utils service start < サービス名 > と入力します。ここで、「サービス名」

はサービスの完全な名前を表します。

サービスを停止するには、utils service stop < サービス名 > と入力します。ここで、「サービス名」

はサービスの完全な名前を表します。

ヒント 他のすべてのサービスは、Cisco Unified CallManager Serviceability の Control Center から起動および

停止する必要があります。

追加情報

P.2-8 の「関連項目」を参照してください。

関連項目

• Control Center におけるサービスの開始、停止、再起動、および更新状況（P.2-6）

• 機能サービスのアクティブ化と非アクティブ化（P.2-2）

• 『Cisco Unified CallManager Serviceability システム ガイド』の「サービスの管理」
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3

アラームの設定

Cisco Unified CallManager Serviceability のアラームでは、管理者がアラームやイベントの設定とア

ラーム メッセージの定義を行えるので、システム管理者やサポート担当者が Cisco Unified 
CallManager の問題をトラブルシューティングするのに役立ちます。システム管理者は、アラーム

とトレースのパラメータを設定して、この情報をシスコ TAC のエンジニアに提供します。

管理者はアラームを使用すれば、システムの実行時の状況と状態を表示して、問題を解決する修正

処置をとることができます。たとえば、電話機が登録済みで機能しているかどうか判別できます。

アラームには、説明や推奨の対処法などの情報があります。また、アラームの情報には、アプリ

ケーション名、マシン名、およびクラスタ名が含まれているため、ローカル以外で起こった Cisco
Unified CallManager の問題をトラブルシューティングするときに役立ちます。

クラスタ内の Cisco Unified CallManager サーバ、および各サーバ用のサービス（Cisco Unified
CallManager、Cisco TFTP、Cisco CTIManager など）に対して、アラームを設定できます。アラーム

インターフェイスを設定する際には、アラーム情報を複数の宛先に送信することと、それぞれの宛

先に固有のアラーム イベント レベル（Debug から Emergency まで）を指定することができます。ア

ラームの収集および表示には、Real-Time Monitoring Tool を使用します。

サービスがアラームを発行すると、アラーム インターフェイスはアラームを選択されたモニタ（た

とえば SDI トレースや Cisco RIS Data Collector）に送信します。モニタは、アラームを転送するか、

または、最終的な宛先（ログ ファイルなど）に書き込みます。

この章は、次の項で構成されています。

• サービスに対するアラームの設定または更新（P.3-2）

• アラーム宛先の設定（P.3-3）

• アラーム イベント レベルの設定（P.3-4）
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サービスに対するアラームの設定または更新

ここでは、Cisco Unified CallManager サービスに対してアラームを設定する方法を説明します。

（注） SNMP トラップおよびカタログの設定は、変更しないことをお勧めします。

標準のレジストリ エディタの使用方法の詳細については、OS のオンライン マニュアルを参照して

ください。

手順

ステップ 1 Alarm > Configuration の順に選択します。

Alarm Configuration ウィンドウが表示されます。

ステップ 2 Server ドロップダウン ボックスから、アラームを設定する対象のサーバを選択します。

ステップ 3 Service ドロップダウン ボックスから、アラームを設定する対象のサービスを選択します。

（注） ドロップダウン リスト ボックスに、すべての（アクティブおよび非アクティブの）サービ

スが表示されます。

Alarm Configuration ウィンドウには、選択したサービスのアラーム モニタとイベント レベルのリス

トが表示されます。

ステップ 4 表 3-1 の説明に従って、使用するアラームの宛先のチェックボックス（1 つまたは複数）をオンに

します。

ステップ 5 Alarm Event Level ドロップダウン リスト ボックスの下向き矢印をクリックします。

イベント レベルを示すリストが表示されます。

ステップ 6 表 3-2 の説明に従って、使用するアラーム イベント レベルをクリックします。

ステップ 7 選択したサービスの現在の設定値をクラスタ内のすべてのノードに適用するには、Apply to All 
Nodes チェックボックスをオンにします。

ステップ 8 Save ボタンをクリックして、設定を保存します。

（注） デフォルトを設定するには、Set Default ボタンをクリックした後で、Save をクリックしま

す。 

追加情報

P.3-4 の「関連項目」を参照してください。
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アラーム宛先の設定

表 3-1 では、アラーム宛先の設定値について説明します。

追加情報

P.3-4 の「関連項目」を参照してください。

表 3-1 アラームの宛先

名前 宛先の説明

Enable Alarm for Local Syslogs SysLog Viewer。Cisco Unified CallManager のエラーは SysLog
Viewer 内のアプリケーション ログに記録され、アラームの説明

と推奨の対処法が提供されます。SysLog Viewer には、

Serviceability Real-Time Monitoring Tool からアクセスします。

SysLog Viewer でログを表示する方法については、P.11-1 の

「RTMT SysLog Viewer の使用」を参照してください。

Enable Alarm for Remote Syslogs Syslog ファイル。Syslog メッセージを Syslog サーバに格納し、

Syslog サーバ名を指定するには、このチェックボックスをオン

にします。この宛先を使用可能にして、サーバ名を指定しない

場合、Cisco Unified CallManager は Syslog メッセージを送信しま

せん。

（注） CiscoWorks 2000 にアラームを送信する場合は、
CiscoWorks 2000 サーバ名を指定します。

Enable Alarm for SDI Trace SDI トレース ライブラリ。 

アラームを SDI トレース ログ ファイルに記録するには、この

チェックボックスをオンにし、選択したサービスの Trace 
Configuration ウィンドウで Trace On チェックボックスをオンに

します。

Trace Configuration ウィンドウの使用方法の詳細については、

P.5-2 の「トレース パラメータの設定」を参照してください。

Enable Alarm for SDL Trace SDL トレース ライブラリ。この宛先は、Cisco CallManager サー

ビスと CTIManager サービスにだけ適用されます。Trace SDL 設
定を使用してこのアラーム宛先を設定します。 
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アラーム イベント レベルの設定

表 3-2 では、アラーム イベント レベルの設定値について説明します。

追加情報

P.3-4 の「関連項目」を参照してください。

関連項目

• サービスに対するアラームの設定または更新（P.3-2）

• アラーム宛先の設定（P.3-3）

• アラーム イベント レベルの設定（P.3-4）

• 『Cisco Unified CallManager Serviceability システム ガイド』の「アラーム」

表 3-2 アラーム イベント レベル

名前 説明

Emergency このレベルは、システムが使用不能であることを示します。

Alert このレベルは、ただちに処置が必要であることを示します。

Critical このレベルは、クリティカル条件が検出されたことを示します。

Error このレベルは、エラー状況が存在することを示します。

Warning このレベルは、警告状況が検出されたことを示します。

Notice このレベルは、正常ではあるが重要な状況を示します。

Informational このレベルは、情報メッセージだけを示します。

Debug このレベルは、シスコ TAC のエンジニアがデバッグに使用するための

詳細なイベント情報を示します。
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4

アラーム定義

この章では、サービスアビリティ アラーム定義で使用するユーザ情報を検索、表示、作成するため

の手順を説明します。

この章は、次の項で構成されています。

• アラーム定義の表示およびユーザ指定の記述の追加（P.4-2）

• アラーム定義のカタログ記述（P.4-3）

アラーム定義は、アラーム メッセージの内容を説明します。つまり、メッセージの意味とその回復

方法を示します。

アラームに関する情報を入手するには、アラーム定義データベースを検索します。サービス固有の

アラームをクリックすると、アラーム情報の説明とその推奨処置が表示されます。

Cisco Unified CallManager では、アラーム定義と推奨処置が SQL サーバ データベースに保存されま

す。システム管理者は、すべてのアラーム定義をこのデータベースで検索できます。定義の内容に

は、アラーム名、記述、説明、推奨処置、重大度、パラメータ、モニタなどがあります。この情報

は、システム管理者が Cisco Unified CallManager に発生した問題をトラブルシューティングすると

きに役立ちます。
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アラーム定義の表示およびユーザ指定の記述の追加

ここでは、アラーム定義を検索し、その内容を表示する方法を説明します。

手順

ステップ 1 Alarm > Definitions を選択します。

Alarm Message Definitions ウィンドウが表示されます。

ステップ 2 Equals フィールドからアラーム定義のカタログを選択するか、Enter Alarm Name フィールドにア

ラーム名を入力します。表 4-1 を参照してください。

ステップ 3 Find ボタンをクリックします。

選択したアラーム カタログの定義リストが表示されます。

（注） アラーム定義が複数のページにわたっている場合があります。別のページを表示するには、

Alarm Message Definitions ウィンドウの下部にある適切なボタンをクリックしてください。

ウィンドウに表示するアラームの数を変更するには、Rows Per Page ドロップダウン リスト

ボックスで別の値を選択します。

ステップ 4 表示されたリストの中から、アラームの詳細を表示する定義のハイパーリンクをクリックします。

Alarm Information ウィンドウが表示されます。

ステップ 5 アラームに情報を追加する場合は、User Defined Text ボックスにテキストを入力し、Save ボタンを

クリックします。

ステップ 6 Alarm Message Definitions ウィンドウに戻るには、Related Links ドロップダウン リスト ボックスか

ら Back to Find/List Alarms を選択し、Go をクリックします。

追加情報

P.4-3 の「関連項目」を参照してください。
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アラーム定義のカタログ記述

表 4-1 では、アラーム定義のカタログ記述を説明します。

追加情報

P.4-3 の「関連項目」を参照してください。

関連項目

• アラーム定義の表示およびユーザ指定の記述の追加（P.4-2）

• アラーム定義のカタログ記述（P.4-3）

表 4-1 アラーム定義カタログ

名前 説明

CallManager Cisco CallManager に対するすべてのアラーム定義

CDRRepAlarm Catalog CDRRep に対するすべてのアラーム定義

CEFAlarmCatalog Cisco Extended Functions に対するすべてのアラーム定義

CMIAlarmCatalog Cisco Messaging Interface に対するすべてのアラーム定義

CtiManagerAlarmCatalog Cisco Computer Telephony Integration（CTI）マネージャに対するすべて

のアラーム定義

DBAlarmCatalog Cisco データベース（Aupair）に対するすべてのアラーム定義

GenericAlarmCatalog アプリケーションに共通のすべての汎用アラーム定義

IpVmsAlarmCatalog IP Voice Media Streaming アプリケーションに対するすべてのアラーム

定義

JavaApplications Cisco CallManager Java Applications に対するすべてのアラーム定義

（注） JavaApplications アラームは、アラーム設定 Web ページからは
設定できません。通常これらのアラームには、これらのアラー
ムをイベント ログに送信して、CiscoWorks2000 との統合に必
要な SNMP トラップを生成するための設定を行います。アラー
ム定義およびパラメータを表示、または変更するには、オペ
レーティング システムに付属のレジストリ エディタを使用し
てください。

RTMTAlarm Catalog Real-Time Monitoring Tool に対するすべてのアラーム定義

TCDSRVAlarm Catalog Cisco Telephony Call Dispatcher サービスに対するすべてのアラーム定

義

TFTPAlarmCatalog Cisco TFTP に対するすべてのアラーム定義
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5

トレースの設定

Trace Configuration ウィンドウでは、Cisco Unified CallManager の問題をトラブルシューティングす

るときにトレースするパラメータを指定できます。トレースする情報のレベル（デバッグ レベル）、

トレース対象の情報（トレース フィールド）、およびトレース ファイルに関する情報（サービスご

とのファイル数、ファイル サイズなど）を設定できます。1 つのサービスに対してトレースを設定

することも、そのサービスに対するトレース設定をクラスタ内のすべてのサーバに適用することも

できます。サービスが Cisco CallManager や Cisco CTIManager などのコール処理アプリケーション

の場合は、電話機やゲートウェイなどのデバイスに対してトレースを設定できます。たとえば、555
で始まる電話番号をもつ、使用可能なすべての電話機にトレースを絞り込むことができます。

さまざまなサービスのトレース ファイルにどの情報を記録するかを設定した後、Real-Time 
Monitoring Tool（RTMT）で Trace ＆ Log Central オプションを使用してトレース ファイルを収集す

ることができます。トレースの収集の詳細については、P.10-1 の「RTMT のトレース収集とログ集

中管理」を参照してください。

（注） トレースを使用可能にするとシステム パフォーマンスが低下します。このため、トラブルシュー

ティングを行う場合にだけトレースを使用可能にしてください。トレースの使用方法については、

Cisco TAC にお問い合せください。

この章は、次の項で構成されています。

• トレース パラメータの設定（P.5-2）

• デバッグ トレース レベルの設定値（P.5-5）

• トレース フィールドの説明（P.5-6）

• トレース出力設定値の説明とデフォルト値（P.5-14）
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トレース パラメータの設定

ここでは、Cisco CallManager サービスに対してトレース パラメータを設定する方法を説明します。

手順

ステップ 1 Trace > Configuration を選択します。

Trace Configuration ウィンドウが表示されます。

ステップ 2 Server ドロップダウン リスト ボックスから、トレースを設定する対象のサービスが動作している

サーバを選択します。

ステップ 3 Service ドロップダウン リスト ボックスから、トレースを設定する対象のサービスを選択します。

（注） ドロップダウン リスト ボックスに、すべての（アクティブおよび非アクティブの）サービ

スが表示されます。

選択したサービスのトレース パラメータが表示されます。 

（注） このサービスに対してトラブルシューティング トレースを設定した場合、トラブルシュー

ティング トレースが設定されていることを示すメッセージがウィンドウの上部に表示され

ます。ウィンドウでは、Trace Output Settings 以外のすべてのフィールドが無効になります。

Trace Output Settings を設定するには、ステップ 19 に進みます。トラブルシューティング ト
レースをリセットするには、P.6-1 の「Troubleshooting Trace Setting の設定」を参照してく

ださい。

ステップ 4 Cisco CallManager または CTIManager サービスに対して SDL トレース パラメータを設定する場合

は、Related Links ドロップダウン リスト ボックスの横の Go ボタンをクリックします。 

ステップ 5 Trace On チェックボックスをオンにします。

ステップ 6 クラスタ内にあるすべての Cisco Unified CallManager サーバにトレースを適用する場合は、Apply to
All Nodes チェックボックスをオンにします。

ステップ 7 SDL トレース パラメータを設定している場合は、ステップ 10 に進みます。それ以外の場合は、ス

テップ 8 に進みます。

ステップ 8 Debug Trace Level ドロップダウン リスト ボックスで、P.5-5 の「デバッグ トレース レベルの設定

値」の説明に従って、トレースする情報のレベルを選択します。

ステップ 9 選択したサービスの Trace Fields チェックボックス（たとえば Cisco Unified CallManager Trace Fields）
をオンにします。

（注） Cisco CallManager サービスまたは Cisco CTIManager サービスに対してトレースを設定して

いて、特定の Cisco Unified CallManager デバイスに関するトレース情報が必要な場合は、ス

テップ 11 に進みます。
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ステップ 10 選択したサービスに複数のトレース フィールドが存在する場合は、有効にするトレース フィール

ドの横のチェックボックスをオンにするか、Enable All Trace チェックボックスをオンにします。ト

レース フィールドの詳細については、該当する項を参照してください。

• Cisco CallManager SDI トレース フィールド（P.5-6）

• Cisco CallManager SDL トレース フィールド（P.5-8）

• Cisco CallManager Attendant Console Server トレース フィールド（P.5-9）

• Cisco CTIManager SDL トレース フィールド（P.5-9）

• Cisco Database Layer Monitor トレース フィールド（P.5-10）

• Cisco Extended Functions トレース フィールド（P.5-11）

• Cisco Extension Mobility トレース フィールド（P.5-11）

• Cisco IP Manager Assistant トレース フィールド（P.5-12）

• Cisco IP Voice Media Streaming Application トレース フィールド（P.5-12）

• Cisco RIS Data Collector トレース フィールド（P.5-13）

• Cisco TFTP トレース フィールド（P.5-13）

• Cisco WebDialer Web サービス トレース フィールド（P.5-14）

ステップ 11 次のいずれかの操作を実行します。

• Cisco CallManager サービスまたは Cisco CTIManager サービスに対してトレースを設定してい

て、特定の Cisco Unified CallManager デバイスに関するトレース情報が必要な場合は、Device
Name Based Trace Monitoring チェックボックスをオンにし、ステップ 12 に進みます。Device
Name Based Trace Monitoring オプションを選択すると、選択されたデバイスのみがトレースさ

れるので、生成されるトレース ログの数が減少し、コール処理に対する影響が軽減されます。 

• Cisco CallManager サービスまたは Cisco CTIManager サービス以外のサービスを設定している

場合、または特定のデバイスの情報をトレースしない場合は、ステップ 19 に進みます。  

ステップ 12 Select Devices ボタンをクリックします。

Device Selection for Tracing ウィンドウが表示されます。

ヒント Cisco Unified CallManager の管理ページの［システム］ >［エンタープライズパラメータ］

を使用して、トレース可能なデバイスの最大数を設定します。Max Number of Device Level
Trace フィールドに値を入力します。デフォルトは 12 です。詳細については、『Cisco
Unified CallManager アドミニストレーション ガイド』を参照してください。

ステップ 13 Find ドロップダウン リスト ボックスから、トレースする対象のデバイスを選択します。

ステップ 14 トレース対象のデバイスを検索するための適切な検索条件を入力し、Find ボタンをクリックします。 

ウィンドウに検索結果が表示されます。

検索結果に続きのページがある場合は、First、Prev、Next、または Last ボタンをクリックします。

ステップ 15 デバイス名に基づくトレース モニタリングを行う対象のデバイスの Trace チェックボックスをク

リックします。 

ステップ 16 Save ボタンをクリックします。
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ステップ 17 更新が完了したら、ブラウザの Close ボタンをクリックして Device Selection for Tracing ウィンドウ

を閉じ、Trace Configuration ウィンドウに戻ります。

ステップ 18 デバイスのほかに非デバイスにもトレースを適用する場合は、Include Non-device Traces チェック

ボックスをオンにします。このチェックボックスをオンにした場合は、P.5-5 の「デバッグ トレー

ス レベルの設定値」の説明に従って、適切なデバッグ トレース レベルを設定してください。

ステップ 19 トレース ファイルの数とサイズを制限するには、トレース出力設定を指定します。説明とデフォル

ト値については、表 5-17 を参照してください。

ステップ 20 トレース パラメータの設定を保存するには、Save ボタンをクリックします。

Cisco Messaging Interface を除き、すべてのサービスに対するトレース設定の変更は、即時に有効に

なります。Cisco Messaging Interface に対するトレース設定の変更は、3 ～ 5 分以内に有効になります。

（注） デフォルトを設定するには、Set Default ボタンをクリックします。 

追加情報

P.5-15 の「関連項目」を参照してください。
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デバッグ トレース レベルの設定値

表 5-1 に、サービスのデバッグ トレース レベルの設定値を示します。 

表 5-2 に、servlet のデバッグ トレース レベルの設定値を示します。

追加情報

P.5-15 の「関連項目」を参照してください。

表 5-1 サービスのデバッグ トレース レベル

レベル 説明

Error アラーム状態とイベントをトレースします。異常なパスで生成されたすべ

てのトレースに使用されます。最小限の CPU サイクルを使用します。

Special すべての エラー 状態に加えて、プロセス メッセージとデバイス初期化

メッセージをトレースします。

State Transition すべての Special 状態に加えて、通常の動作時に発生するサブシステムの

状態遷移をトレースします。コール処理イベントをトレースします。

Significant すべての State Transition 状態に加えて、通常の動作中に発生するメディア

レイヤ イベントをトレースします。

Entry/Exit すべての Significant 状態に加えて、ルーチンの Entry Point と Exit Point を
トレースします。このトレース レベルを使用しないサービスもあります

（たとえば、Cisco CallManager は使用しません）。

Arbitrary すべての Entry/Exit 状態に加えて、低いレベルのデバッグ情報をトレース

します。 

（注） Cisco CallManager サービスまたは Cisco IP Voice Media Streaming
Application サービスに対して、通常の動作中にこのトレース レベ
ルを使用しないでください。

Detailed すべての Arbitrary 状態に加えて、詳細なデバッグ情報をトレースします。

（注） Cisco CallManager サービスまたは Cisco IP Voice Media Streaming
Application サービスに対して、通常の動作中にこのトレース レベ
ルを使用しないでください。

表 5-2 servlet のデバッグ トレース レベル

レベル 説明

Fatal アプリケーションの中止の原因となる、非常に重大なエラー イベントをト

レースします。

Error アラーム状態とイベントをトレースします。異常なパスで生成されたすべ

てのトレースに使用されます。

Warn 潜在的に有害な状況をトレースします。

Info servlet の問題の大部分をトレースします。システムのパフォーマンスに対

する影響は最小限です。

Debug すべての State Transition 状態に加えて、通常の動作中に発生するメディア

レイヤ イベントをトレースします。

すべてのログ記録をオンにするトレース レベルです。
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トレース フィールドの説明

次の項では、指定されたサービスのトレース フィールドについて説明します。

• Cisco CallManager SDI トレース フィールド（P.5-6）

• Cisco CallManager SDL トレース フィールド（P.5-8）

• Cisco CallManager Attendant Console Server トレース フィールド（P.5-9）

• Cisco CTIManager SDL トレース フィールド（P.5-9）

• Cisco Database Layer Monitor トレース フィールド（P.5-10）

• Cisco Extended Functions トレース フィールド（P.5-11）

• Cisco Extension Mobility トレース フィールド（P.5-11）

• Cisco IP Voice Media Streaming Application トレース フィールド（P.5-12）

• Cisco RIS Data Collector トレース フィールド（P.5-13）

• Cisco TFTP トレース フィールド（P.5-13）

• Cisco WebDialer Web サービス トレース フィールド（P.5-14）

Cisco CallManager SDI トレース フィールド

表 5-3 では、Cisco CallManager SDI トレース フィールドについて説明します。

表 5-3 Cisco CallManager SDI トレース フィールド

フィールド名 説明

Enable H245 Message Trace H245 メッセージのトレースをアクティブにします。

Enable DT-24+/DE-30+ Trace DT-24+/DE-30+ デバイス トレースの ISDN タイプのロギングを

アクティブにします。

Enable PRI Trace 一次群速度インターフェイス（PRI）デバイスのトレースをアク

ティブにします。

Enable ISDN Translation Trace ISDN メッセージのトレースをアクティブにします。通常のデ

バッグ時に使用されます。

Enable H225 & Gatekeeper Trace H.225 デバイスのトレースをアクティブにします。通常のデバッ

グ時に使用されます。

Enable Miscellaneous Trace 各種デバイスのトレースをアクティブにします。

（注） 通常のシステム操作時には、このチェックボックスをオ
ンにしないでください。

Enable Conference Bridge Trace Conference Bridge のトレースをアクティブにします。通常のデ

バッグ時に使用されます。

Enable Music on Hold Trace Music On Hold（MOH; 保留音）デバイスのトレースをアクティ

ブにします。Cisco Unified CallManager への登録、Cisco Unified
CallManager からの登録解除、リソース割り当て処理の成功や失

敗など、MOH デバイスの状況のトレースに使用します。

Enable Unified CMReal-Time 
Information Server Trace

リアルタイム情報サーバが使用する Cisco Unified CallManager
リアルタイム情報トレースをアクティブにします。

Enable SIP Stack Trace SIP スタックのトレースをアクティブにします。



第 5 章      トレースの設定

  トレース フィールドの説明

5-7
Cisco Unified CallManager Serviceability アドミニストレーション ガイド

OL-9418-01-J

追加情報

P.5-15 の「関連項目」を参照してください。

Enable Annunciator Trace Annunciator のトレースをアクティブにします。Annunciator は、

Cisco IP Voice Media Streaming Application サービスを使用する

SCCP デバイスです。これを使用すると、Cisco Unified IP Phone 、
ゲートウェイ、その他の設定可能なデバイスなどに対する、あ

らかじめ録音されたアナウンス（.wav ファイル）およびトーン

を Cisco Unified CallManager で再生できます。

Enable CDR Trace CDR のトレースをアクティブにします。

Enable Analog Trunk Trace Analog Trunk（AT; アナログ トランク）ゲートウェイすべての

トレースをアクティブにします。

Enable All Phone Device Trace 電話機のトレースをアクティブにします。トレース情報には

SoftPhone デバイスが含まれます。通常のデバッグ時に使用され

ます。

Enable MTP Trace Media Termination Point（MTP; メディア終端点）デバイスのト

レースをアクティブにします。通常のデバッグ時に使用されま

す。

Enable All Gateway Trace アナログおよびデジタルのゲートウェイすべてのトレースをア

クティブにします。

Enable Forward and Miscellaneous
Trace

コール転送、および他のチェックボックスに含まれないすべて

のサブシステムのトレースをアクティブにします。通常のデ

バッグ時に使用されます。

Enable MGCP Trace Media Gateway Control Protocol（MGCP）デバイスのトレースを

アクティブにします。通常のデバッグ時に使用されます。

Enable Media Resource Manager 
Trace

Media Resource Manager（MRM）のアクティビティのトレース

をアクティブにします。

Enable SIP Call Processing Trace SIP コール処理のトレースをアクティブにします。

Enable Keep Alive Trace Cisco CallManager トレースで、キープアライブ トレース情報の

トレースをアクティブにします。各 SCCP デバイスはキープア

ライブ メッセージを 30 秒ごとにレポートし、各キープアライ

ブ メッセージは 3 行のトレース データを作成するので、この

チェックボックスをオンにすると、大量のトレース データがシ

ステムによって生成されます。

表 5-3 Cisco CallManager SDI トレース フィールド（続き）

フィールド名 説明
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Cisco CallManager SDL トレース フィールド

表 5-4 では、Cisco CallManager SDL トレース フィルタの設定値について説明します。表 5-5 では、

Cisco CallManager SDL 設定の特性について説明します。

（注） Cisco のエンジニアから特別の指示がない限り、デフォルトを使用することをお勧めしま

す。

表 5-4 Cisco CallManager SDL 設定のトレース フィルタ設定値

設定名 説明

Enable all Layer 1 traces. レイヤ 1 のトレースをアクティブにします。

Enable detailed Layer 1 traces. 詳細なレイヤ 1 のトレースをアクティブにします。

Enable all Layer 2 traces. レイヤ 2 のトレースをアクティブにします。

Enable Layer 2 interface trace. レイヤ 2 インターフェイスのトレースをアクティブに

します。

Enable Layer 2 TCP trace. レイヤ 2 Transmission Control Program（TCP）トレース

をアクティブにします。

Enable detailed dump Layer 2 trace. ダンプ レイヤ 2 の詳細トレースをアクティブにしま

す。

Enable all Layer 3 traces. レイヤ 3 のトレースをアクティブにします。

Enable all call control traces. コール制御のトレースをアクティブにします。

Enable miscellaneous polls trace. 各種ポーリングのトレースをアクティブにします。

Enable miscellaneous trace (database signals). データベース信号などの各種トレースをアクティブに

します。

Enable message translation signals trace. メッセージ変換信号のトレースをアクティブにしま

す。

Enable UUIE output trace. user-to-user informational element（UUIE）出力のトレー

スをアクティブにします。

Enable gateway signals trace. ゲートウェイ信号のトレースをアクティブにします。

Enable CTI trace. CTI トレースをアクティブにします。

Enable network service data trace ネットワーク サービス データのトレースをアクティ

ブにします。

Enable network service event trace ネットワーク サービス イベントのトレースをアク

ティブにします。

Enable ICCP admin trace ICCP 管理のトレースをアクティブにします。

Enable default trace デフォルト トレースをアクティブにします。

表 5-5 Cisco CallManager SDL 設定のトレースの特性

特性 説明

Enable SDL link states trace. Intracluster Communication Protocol（ICCP; クラスタ内通信プ

ロトコル）リンク状態のトレースをアクティブにします。

Enable low-level SDL trace. 低レベル SDL のトレースをアクティブにします。

Enable SDL link poll trace. ICCP リンク ポーリングのトレースをアクティブにします。
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追加情報

P.5-15 の「関連項目」を参照してください。

Cisco CallManager Attendant Console Server トレース フィールド

表 5-6 では、Cisco CallManager Attendant Console Server トレース フィールドについて説明します。 

追加情報

P.5-15 の「関連項目」を参照してください。

Cisco CTIManager SDL トレース フィールド

表 5-7 では、Cisco CTIManager SDL 設定のトレース フィルタの設定値について説明します。表 5-8
では、Cisco CTIManager SDL 設定の特性について説明します。

（注） Cisco のエンジニアから特別の指示がない限り、デフォルトを使用することをお勧めしま

す。

Enable SDL link messages trace. ICCP の生のメッセージのトレースをアクティブにします。

Enable signal data dump trace. 信号データ ダンプのトレースをアクティブにします。

Enable correlation tag mapping trace. 相関タグ マッピングのトレースをアクティブにします。

Enable SDL process states trace. SDL プロセス状態のトレースをアクティブにします。

Disable pretty print of SDL trace. SDL の Pretty Print のトレースを使用不可にします。Pretty
Print は、後処理を実行せずにトレース ファイル内のタブと

スペースを追加します。

Enable SDL TCP event trace. SDL TCP イベントのトレースをアクティブにします。

表 5-5 Cisco CallManager SDL 設定のトレースの特性（続き）

特性 説明

表 5-6 Cisco CallManager Attendant Console Server トレース フィールド

フィールド名 説明

Enable low level trace 低レベルのトレースをアクティブにします。

Enable high level trace 高レベルのトレースをアクティブにします。

表 5-7 Cisco CTIManager SDL 設定のトレース フィルタ設定値

設定名 説明

Enable miscellaneous polls trace. 各種ポーリングのトレースをアクティブにします。

Enable miscellaneous trace (database signals). データベース信号などの各種トレースをアクティブ

にします。

Enable CTI trace. CTI トレースをアクティブにします。

Enable Network Service Data Trace ネットワーク サービス データのトレースをアクティ

ブにします。
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追加情報

P.5-15 の「関連項目」を参照してください。

Cisco Database Layer Monitor トレース フィールド

表 5-9 では、Cisco Database Layer Monitor トレース フィールドについて説明します。

追加情報

P.5-15 の「関連項目」を参照してください。

Enable Network Service Event Trace ネットワーク サービス イベントのトレースをアク

ティブにします。

Enable ICCP Admin Trace ICCP 管理のトレースをアクティブにします。

Enable Default Trace デフォルト トレースをアクティブにします。

表 5-8 Cisco CTIManager SDL 設定のトレースの特性

特性 説明

Enable SDL link states trace. ICCP リンク状態のトレースをアクティブにします。

Enable low-level SDL trace. 低レベル SDL のトレースをアクティブにします。

Enable SDL link poll trace. ICCP リンク ポーリングのトレースをアクティブにします。

Enable SDL link messages trace. ICCP の生のメッセージのトレースをアクティブにします。

Enable signal data dump trace. 信号データ ダンプのトレースをアクティブにします。

Enable correlation tag mapping trace. 相関タグ マッピングのトレースをアクティブにします。

Enable SDL process states trace. SDL プロセス状態のトレースをアクティブにします。

Disable pretty print of SDL trace. SDL の Pretty Print のトレースを使用不可にします。Pretty
Print は、後処理を実行せずにトレース ファイル内のタブと

スペースを追加します。

Enable SDL TCP Event trace SDL TCP イベントのトレースをアクティブにします。

表 5-7 Cisco CTIManager SDL 設定のトレース フィルタ設定値（続き）

設定名 説明

表 5-9 Cisco Database Layer Monitor トレース フィールド

フィールド名 説明

Enable DB Library Trace データベース ライブラリのトレースをアクティブにします。

Enable Service Trace サービスのトレースをアクティブにします。

Enable DB Change Notification Trace データベース変更通知のトレースをアクティブにします。

Enable Unit Test Trace このチェックボックスはオンにしません。シスコのエンジニ

アがデバッグ用に使用します。
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Cisco Extended Functions トレース フィールド

表 5-10 では、Cisco Extended Functions トレース フィールドについて説明します。

追加情報

P.5-15 の「関連項目」を参照してください。

Cisco Extension Mobility トレース フィールド

表 5-11 では、Cisco Extension Mobility トレース フィールドについて説明します。

追加情報

P.5-15 の「関連項目」を参照してください。

表 5-10 Cisco Extended Functions トレース フィールド

フィールド名 説明

Enable QBE Helper TSP Trace テレフォニー サービス プロバイダーのトレースをア

クティブにします。

Enable QBE Helper TSPI Trace QBE Helper TSP インターフェイス のトレースをアク

ティブにします。

Enable QRT Dictionary Trace Quality Report Tool サービス ディクショナリのトレー

スをアクティブにします。

Enable DOM Helper Traces DOM へルパーのトレースをアクティブにします。

Enable Redundancy and Change Notification 
Trace

データベース変更通知のトレースをアクティブにし

ます。

Enable QRT Report Handler Trace Quality Report Tool レポート ハンドラのトレースをア

クティブにします。

Enable QBE Helper CTI Trace QBE ヘルパー CTI のトレースをアクティブにします。

Enable QRT Service Trace Quality Report Tool サービス関連のトレースをアク

ティブにします。

Enable QRT DB Traces QRT DB アクセスのトレースをアクティブにします。

Enable Template Map Traces 標準テンプレート マップおよびマルチマップのト

レースをアクティブにします。

Enable QRT Event Handler Trace Quality Report Tool イベント ハンドラのトレースをア

クティブにします。

Enable QRT Real-Time Information Server 
Trace

Quality Report Tool のリアルタイム情報サーバのト

レースをアクティブにします。

表 5-11 Cisco Extension Mobility トレース フィールド

フィールド名 説明

Enable EM Service Trace Extension Mobility サービスのトレースをアクティブにしま

す。

Enable EM Application Trace Extension Mobility サービスのアプリケーション トレースを

アクティブにします。
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Cisco IP Manager Assistant トレース フィールド

表 5-12 では、Cisco IP Manager Assistant トレース フィールドについて説明します。

追加情報

P.5-15 の「関連項目」を参照してください。

Cisco IP Voice Media Streaming Application トレース フィールド

表 5-13 では、Cisco IP Voice Media Streaming Application トレース フィールドについて説明します。

表 5-12 Cisco IP Manager Assistant トレース フィールド

フィールド名 説明

Enable IPMA Service Trace Cisco IP Manager Assistant サービスのトレースをアク

ティブにします。

Enable IPMA Manager Configuration Change 
Log

マネージャとアシスタントの設定に対する変更のト

レースをアクティブにします。

Enable IPMA CTI Trace CTI Manager 接続のトレースをアクティブにします。

Enable IPMA CTI Security Trace CTIManager への安全な接続のトレースをアクティブ

にします。

表 5-13 Cisco IP Voice Media Streaming Application トレース フィールド

フィールド名 説明

Enable Service Initialization Trace 初期化情報のトレースをアクティブにします。

Enable MTP Device Trace MTP に関する処理済みメッセージをモニタするためのト

レースをアクティブにします。

Enable Device Recovery Trace MTP、Conference Bridge、および MOH のデバイス回復関

連情報のトレースをアクティブにします。

Enable Skinny Station Messages Trace Skinny Station Protocol のトレースをアクティブにします。

Enable WinSock Level 2 Trace 高レベルの詳細な WinSock 関連情報のトレースをアク

ティブにします。

Enable Music On Hold Manager Trace MOH オーディオ ソース マネージャをモニタするための

トレースをアクティブにします。

Enable Annunciator Trace Annunciator をモニタするためのトレースをアクティブに

します。

Enable DB Setup Manager Trace データベースのセットアップ、および MTP、Conference
Bridge、MOH の変更をモニタするためのトレースをアク

ティブにします。

Enable Conference Bridge Device Trace Conference Bridge に関する処理済みメッセージをモニタ

するためのトレースをアクティブにします。

Enable Device Driver Trace デバイス ドライバのトレースをアクティブにします。

Enable WinSock Level 1 Trace 低レベルの一般的な WinSock 関連情報のトレースをアク

ティブにします。

Enable Music on Hold Device Trace MOH に関する処理済みメッセージをモニタするための

トレースをアクティブにします。

Enable TFTP Downloads Trace MOH オーディオ ソース ファイルのダウンロードをモニ

タするためのトレースをアクティブにします。
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追加情報

P.5-15 の「関連項目」を参照してください。

Cisco RIS Data Collector トレース フィールド

表 5-14 では、Cisco RIS Data Collector トレース フィールドについて説明します。 

追加情報

P.5-15 の「関連項目」を参照してください。

Cisco TFTP トレース フィールド

表 5-15 では、Cisco TFTP トレース フィールドについて説明します。 

追加情報

P.5-15 の「関連項目」を参照してください。

表 5-14 Cisco RIS Data Collector トレース フィールド

フィールド名 説明

Enable RISDC Trace RIS データ コレクタ サービス（RIS）の RISDC スレッドのト

レースをアクティブにします。

Enable System Access Trace RIS データ コレクタにあるシステム アクセス ライブラリのト

レースをアクティブにします。

Enable Link Services Trace RIS データ コレクタにあるリンク サービス ライブラリのト

レースをアクティブにします。

Enable RISDC Access Trace RIS データ コレクタにある RISDC アクセス ライブラリのト

レースをアクティブにします。

Enable RISDB Trace RIS データ コレクタにある RISDB ライブラリのトレースをアク

ティブにします。

Enable PI Trace RIS データ コレクタにある PI ライブラリのトレースをアクティ

ブにします。

Enable XML Trace RIS データ コレクタ サービスの入出力 XML メッセージのト

レースをアクティブにします。

Enable Perfmon Logger Trace RIS データ コレクタにある、トラブルシューティング用の 
perfmon データ ロギングのトレースをアクティブにします。ロ

グ ファイル名、ロギングされたカウンタの合計数、Cisco Unified
CallManager やシステムのカウンタとインスタンスの名前、プロ

セスとスレッド CPU 使用率、およびログ ファイル ロールオー

バーと削除の発生回数のトレースに使用します。

表 5-15 Cisco TFTP トレース フィールド

フィールド名 説明

Enable Service System Trace サービス システムのトレースをアクティブにします。

Enable Build File Trace ファイルの作成に関するトレースをアクティブにします。

Enable Serve File Trace ファイルの提供に関するトレースをアクティブにします。
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Cisco WebDialer Web サービス トレース フィールド

表 5-16 では、Cisco WebDialer トレース フィールドについて説明します。 

追加情報

P.5-15 の「関連項目」を参照してください。

トレース出力設定値の説明とデフォルト値

表 5-17 に、トレース ログ ファイルの説明とデフォルト値を示します。 

注意 Maximum No. of Files または Maximum File Size のいずれかのパラメータを変更すると、サービスが

実行中の場合は、現在のファイルを除くすべてのサービス ログ ファイルが削除され、サービスが

アクティブにされていない場合は、サービスが最初にアクティブにされたときにファイルが削除さ

れます。ログ ファイルの記録を保存する場合は、必ず Maximum No. of Files パラメータまたは

Maximum File Size パラメータを変更する前に、サービス ログ ファイルをダウンロードして別の

サーバに保存してください。

追加情報

P.5-15 の「関連項目」を参照してください。

表 5-16 Cisco WebDialer Web サービス トレース フィールド

フィールド名 説明

Enable WebDialer Servlet Trace Cisco WebDialer servlet のトレースをアクティブにします。

Enable Redirector Servlet Trace Redirector servlet のトレースをアクティブにします。

表 5-17 トレース出力設定値

フィールド 説明

Maximum number of files このフィールドには、特定のサービスに対するトレース ファ

イルの合計数を指定します。Cisco Unified CallManager は、各

ファイルを識別するために、ファイル名にシーケンス番号を

自動的に追加します（例：ccm299.txt）。シーケンスの最後の

ファイルが満杯になると、トレース データは最初のファイル

に上書きされます。デフォルト値は、サービスによって異な

ります。

Maximum file size (MB) このフィールドには、トレース ファイルの最大サイズを MB
単位で指定します。デフォルト値は、サービスによって異な

ります。
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関連項目

• トレース パラメータの設定（P.5-2）

• トレース フィールドの説明（P.5-6）

• トレース出力設定値の説明とデフォルト値（P.5-14）

• デバッグ トレース レベルの設定値（P.5-5）
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6

Troubleshooting Trace Setting の設定

Troubleshooting Trace Settings ウィンドウでは、トラブルシューティング トレースの事前設定値を設

定する対象の Cisco Unified CallManager のサービスを選択できます。この章では、特定のサービス

のトラブルシューティング トレース設定値を設定またはリセットする方法を説明します。

（注） 長期間にわたってトラブルシューティング トレースを使用可能にすると、トレース ファイ

ルのサイズが大きくなり、サービスのパフォーマンスが低下する可能性があります。

手順

ステップ 1 Trace > Troubleshooting Trace Settings の順に選択します。

ステップ 2 次のいずれかの操作を実行します。

• トラブルシューティング トレースを設定する場合は、各ノードのサービス リストで、サービ

スのチェックボックスをオンにします。特定のノードにおいて、すべてのサービスをチェック

する場合は、そのノードの下にある Check all Services for a Node チェックボックスをオンにし

ます。すべてのノードのすべてのサービスをチェックする場合は、サービス リストで Check all
Services for a Node チェックボックスをオンにします。

次に、Apply Troubleshooting Traces ボタンをクリックします。

（注） Cisco Unified CallManager ノードでアクティブにされていないサービスは、N/A と表示され

ます。 

• クラスタ内のサービスの、元のトレース設定値を復元する場合は、Reset Troubleshooting Traces
をクリックします。

（注） Reset Troubleshooting Traces ボタンは、1 つ以上のサービスに対してトラブルシューティン

グ トレースを設定した場合にのみ表示されます。
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追加情報

P.6-2 の「関連項目」を参照してください。

関連項目

• トレースの設定（P.5-1）

• 『Cisco Unified CallManager Serviceability システム ガイド』の「トレース」
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7

Real-Time Monitoring の設定

この章は、Cisco Unified CallManager Real-Time Monitoring Tool（RTMT）の設定に関する次の項で構

成されています。 

• Real-Time Monitoring Tool（RTMT）のインストール（P.7-2）

• RTMT のアップグレード（P.7-3）

• RTMT のアンインストール（P.7-4）

• RTMT の使用（P.7-5）

• 電子メール通知の設定（P.7-7）

• 構成プロファイルの操作（P.7-8）

• 事前定義オブジェクトの操作（P.7-10）

• デバイスの操作（P.7-14）

• CTI アプリケーション、デバイス、および回線の操作（P.7-18）

• 参考情報（P.7-23）

ヒント アラート、パフォーマンス モニタリング、トレース収集、Syslog Viewer の設定については、P.7-23 の

「参考情報」を参照してください。
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Real-Time Monitoring Tool（RTMT）のインストール

RTMT は、800*600 以上の解像度で動作し、Windows 98、Windows XP、Windows 2000、または Red
Hat Linux with KDE や Gnome クライアントにインストールできます。 

（注） RTMT が、Microsoft Windows で稼働する Cisco Unified CallManager サーバと連携するようにすでに

インストールされている場合、Cisco Unified CallManager 5.0 対応の RTMT をローカル コンピュー

タの別のフォルダにインストールする必要があります。 

ヒント Cisco Unified CallManager がインストールされているサーバには RTMT をインストールしないこと

を強くお勧めします。Cisco Unified CallManager がインストールされているサーバで RTMT を使用

すると、コール処理が中断することがあります。

ツールをインストールするには、次の手順を実行します。

手順

ステップ 1 Cisco Unified CallManager の管理ページ で、［アプリケーション］>［プラグイン］の順に選択します。

ステップ 2 ［検索］ボタンをクリックします。

ステップ 3 Cisco Unified CallManager Real-Time Monitoring Tool の［ダウンロード］リンクをクリックします。

ステップ 4 実行ファイルを適切な場所にダウンロードします。

ステップ 5 デスクトップに表示された RTMT アイコンをダブルクリックするか、ファイルのダウンロード先の

ディレクトリから RTMT インストール ファイルを実行します。

抽出プロセスが開始します。

ステップ 6 ［Real Time Monitoring Tool の InstallShield ウィザードへようこそ］ウィンドウで［次へ］をクリッ

クします。

ステップ 7 ライセンス契約書に同意するには、［次へ］をクリックします。

ステップ 8 RTMT のインストール先を選択します。デフォルト以外の場所にインストールする場合は、［ブラ

ウズ］をクリックし、別の場所に移動します。［次へ］をクリックします。

ステップ 9 インストールを開始するには、［次へ］をクリックします。

設定状況に関するウィンドウが表示されます。［取り消し］をクリックしないでください。

ステップ 10 インストールを完了するには、［終了］をクリックします。
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追加情報

P.7-24 の「関連項目」を参照してください。

RTMT のアップグレード

ツール（RTMT）を使用すると、ユーザ プリファレンスやダウンロードされたモジュールの jar ファ

イルは、クライアント マシンにローカルに保存されます。システムはプロファイルを Cisco Unified
CallManager データベースに保存するので、RTMT のアップグレード後もこれらの項目に RTMT で
アクセスできます。

ヒント 互換性を確保するため、クラスタ内のすべてのサーバ上で Cisco Unified CallManager をアップグ

レードした後に RTMT をアップグレードすることをお勧めします。

RTMT をアップグレードするには、次の手順を実行します。

手順

ステップ 1 Cisco Unified CallManager の管理ページ で、［アプリケーション］>［プラグイン］の順に選択します。

ステップ 2 ［検索］ボタンをクリックします。

ステップ 3 Microsoft Windows オペレーティング システムを実行しているコンピュータに RTMT ツールをイン

ストールする場合は、Cisco Unified CallManager Real-Time Monitoring Tool-Windows の［ダウンロー

ド］リンクをクリックします。Linux オペレーティング システムを実行しているコンピュータに

RTMT ツールをインストールする場合は、Cisco Unified CallManager Real-Time Monitoring Tool-Linux
の［ダウンロード］リンクをクリックします。

ステップ 4 実行ファイルを適切な場所にダウンロードします。

ステップ 5 デスクトップに表示された RTMT アイコンをダブルクリックするか、ファイルのダウンロード先の

ディレクトリから RTMT インストール ファイルを実行します。

抽出プロセスが開始します。

ステップ 6 ［Real Time Monitoring Tool の InstallShield ウィザードへようこそ］ウィンドウで［次へ］をクリッ

クします。

ステップ 7 アップグレードの場合はインストール先を変更できないので、［次へ］をクリックします。

設定状況に関するウィンドウが表示されます。［取り消し］をクリックしないでください。

ステップ 8 ［メンテナンス完了］ウィンドウで［終了］をクリックします。

追加情報

P.7-24 の「関連項目」を参照してください。



第 7 章      Real-Time Monitoring の設定

  RTMT のアンインストール

7-4
Cisco Unified CallManager Serviceability アドミニストレーション ガイド

OL-9418-01-J

RTMT のアンインストール

Windows クライアントで RTMT をアンインストールするには、［コントロール パネル］の［アプリ

ケーションの追加と削除］を使用します（［スタート］>［設定］>［コントロール パネル］>［ア

プリケーションの追加と削除］）。

KDE や Gnome クライアントを使用した Red Hat Linux で RTMT をアンインストールするには、タ

スクバーから Start > Accessories > Uninstall Real-time Monitoring tool の順に選択します。

追加情報

P.7-24 の「関連項目」を参照してください。
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RTMT の使用

始める前に

RTMT を使用する前に、クラスタ内の各ノードで Cisco AMC Service をアクティブにする必要があ

ります。Cisco Unified CallManager Serviceability から Tools > Service Activation の順に選択し、Cisco
AMC Service チェックボックスをオンにします。Save をクリックします。

手順

ステップ 1 プラグインをインストールした後、次のいずれかの操作を実行します。

• Windows デスクトップで、Cisco Unified CallManager Real-Time Monitoring Tool アイコンをダ

ブルクリックします。

• ［スタート］>［プログラム］> Cisco CallManager Serviceability > Real-Time Monitoring Tool >
Real-Time Monitoring Tool の順に選択します。

Real-Time Monitoring Tool Login ウィンドウが表示されます。 

ステップ 2 Host IP Address フィールドに、ファースト ノードの IP アドレスまたはホスト名を入力します。

ステップ 3 User Name フィールドに、CCMAdministrator アプリケーションのユーザ名を入力します。たとえば、

このユーザのデフォルトのユーザ名は、CCMAdministrator です。

ステップ 4 Password フィールドに、CCMAdministrator アプリケーションのユーザ名に対応するユーザ パスワー

ドを入力します。たとえば、このユーザのデフォルトのユーザ名は、ciscocisco です。

（注） 認証に失敗した場合、またはサーバに到達できない場合は、サーバと認証の詳細を再入力

するように求められます。また、Cancel ボタンをクリックして、アプリケーションを終了

することもできます。認証に成功した場合は、RTMT により、ローカル キャッシュまたは

リモート ノードからモニタリング モジュールが起動されます。リモート ノードは、バック

エンドの Cisco Unified CallManager バージョンと一致するモニタリング モジュールがロー

カル キャッシュに含まれていない場合に使用されます。

ステップ 5 アプリケーションがサーバのリッスンに使用するポートを入力します。デフォルト設定は 8443 で
す。

ステップ 6 Secure Connection チェックボックスをオンにします。 

ステップ 7 OK をクリックします。

ステップ 8 Yes をクリックして、証明書ストアを追加します。 

ステップ 9 RTMT で実行できる操作については、次のリストを参照してください。

• 電子メール アラートのためのメール サーバを設定する場合は、P.7-7 の「電子メール通知の設

定」を参照してください。

• 構成プロファイルを作成する場合は、P.7-8 の「構成プロファイルの追加」を参照してください。

• 事前定義オブジェクトをモニタする場合は、P.7-10 の「事前定義オブジェクトの操作」を参照

してください。
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• デバイスを操作する場合は、P.7-14 の「デバイスの操作」を参照してください。

• CTI アプリケーション、デバイス、および回線を操作する場合は、P.7-18 の「CTI アプリケー

ション、デバイス、および回線の操作」を参照してください。

• アラートを操作する場合は、P.8-1 の「RTMT でのアラート設定」を参照してください。

• パフォーマンス モニタリング オブジェクトを操作する場合は、P.9-1 の「パフォーマンス モニ

タリングの設定と使用」を参照してください。

• トレースを収集して表示する場合は、P.10-1 の「RTMT のトレース収集とログ集中管理」を参

照してください。

• SysLog Viewer を使用する場合は、P.11-1 の「RTMT SysLog Viewer の使用」を参照してください。

• RTMT のトレース設定値を設定する場合は、Edit > Trace Setting の順に選択します。適切なオ

プション ボタンをクリックします。

• ウィンドウの左側に表示される Quick Launch Channel ペインを非表示にするには、Edit > Hide
Quick Launch Channel の順に選択します。

一度非表示にした Quick Launch Channel を表示するには、Edit > Hide Quick Launch Channel の
順に選択します。

• 1 つのモニタリング ウィンドウを閉じるには、Window > Close の順に選択します。表示されて

いるすべてのモニタリング ウィンドウを閉じるには、Window > Close All Windows の順に選択

します。

• RTMT ウィンドウから Cisco Unified CallManager の管理ページまたは Cisco Unified CallManager
Serviceability にアクセスするには、Application > CCM Admin Webpage（または CCM 
Serviceability Webpage）の順に選択します。

• RTMT から Serviceability Report Archive オプションにアクセスするには、System > Report
Archive の順に選択します。［セキュリティの警告］ウィンドウが表示されたら、［はい］をク

リックします。サーバの管理ユーザ名とパスワードを入力し、OK をクリックします。

• インストールされている RTMT のバージョンを確認するには、Help > About の順に選択しま

す。バージョン情報がウィンドウに表示されます。情報を確認したら、OK をクリックします。

• RTMT のマニュアルにアクセスするには、Help > Help Topics（または For this Window）の順

に選択します。RTMT または Cisco Unified CallManager Serviceability の詳細については、『Cisco
Unified CallManager Serviceability システム ガイド』も参照してください。

• JVM 情報をモニタするには、System > JVM Information の順にクリックします。JAVA ヒープ

メモリの使用状況がウィンドウに表示されます。OK をクリックします。

• RTMT からログアウトするには、System > Log Off の順に選択します。この操作を実行すると、

現在のユーザがログオフし、Real-Time Monitoring Tool Login ウィンドウが表示されます。 

• アプリケーションを終了するには、System > Exit の順に選択します。この操作を実行すると、

アプリケーションが終了します。

追加情報

P.7-24 の「関連項目」を参照してください。
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電子メール通知の設定

電子メール通知を設定するには、次の手順を実行します。

手順

ステップ 1 Mail Server フィールドに、電子メールの受信者の情報を入力します。

ステップ 2 Port フィールドに、メール サーバのポート番号を入力します。

ステップ 3 OK をクリックします。

追加情報

P.7-24 の「関連項目」を参照してください。
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構成プロファイルの操作

この項は、次の内容で構成されています。

• デフォルトの構成プロファイルの使用（P.7-8）

• 構成プロファイルの追加（P.7-8）

• プロファイルの復元（P.7-9）

• 構成プロファイルの削除（P.7-9）

デフォルトの構成プロファイルの使用

RTMT を初めてロードすると、CM-Default という名前のデフォルト設定が適用されます。RTMT を
初めて使用すると、CM-Default プロファイルが使用され、モニタ ペインに要約ページが表示され

ます。CM-Default は、Cisco Unified CallManager の全ノードにある登録済みの電話機をすべて動的

にモニタします。クラスタに 5 つの Cisco Unified CallManager 設定ノードがある場合、CM-Default
は Cisco Unified CallManager クラスタ内の各ノードの登録済み電話機すべて、進行中のコール、お

よびアクティブなゲートウェイ ポートとチャネルを表示します。 

独自の構成プロファイルを作成する方法については、P.7-8 の「構成プロファイルの追加」を参照

してください。

追加情報

P.7-24 の「関連項目」を参照してください。

構成プロファイルの追加

RTMT で複数のモニタリング ウィンドウ（CPU & Memory、SDL Queue、およびパフォーマンス カ
ウンタなど）を開いた後、独自の構成プロファイルを作成すると、これらのウィンドウを個別に開

かなくても 1 つの操作でこれらのモニタリング ウィンドウを復元できます。同じ RTMT セッショ

ンで複数の異なるプロファイルを切り替えたり、後続の RTMT セッションで同じプロファイルを使

用したりすることもできます。

プロファイルを作成する手順は、次のとおりです。

手順

ステップ 1 System > Profile の順に選択します。

Preferences ダイアログボックスが表示されます。

ステップ 2 Save をクリックします。

Save Current Configuration ダイアログボックスが表示されます。

ステップ 3 Configuration name フィールドに、この構成プロファイルの名前を入力します。

ステップ 4 Configuration description フィールドに、この構成プロファイルの説明を入力します。

（注） 構成プロファイルの名前と説明は任意に入力できます。
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システムにより新しい構成プロファイルが作成されます。

追加情報

P.7-24 の「関連項目」を参照してください。

プロファイルの復元

構成済みのプロファイルを復元するには、次の手順を実行します。

手順

ステップ 1 System > Profile の順に選択します。

Preferences ダイアログボックスが表示されます。

ステップ 2 復元するプロファイルをクリックします。

ステップ 3 Restore をクリックします。

復元された構成に対する、あらかじめ用意されている設定やパフォーマンス モニタリング カウン

タのすべてのウィンドウが開きます。

追加情報

P.7-24 の「関連項目」を参照してください。

構成プロファイルの削除

構成済みのプロファイルを削除するには、次の手順を実行します。

手順

ステップ 1 System > Profile の順に選択します。

Preferences ダイアログボックスが表示されます。

ステップ 2 削除するプロファイルをクリックします。

ステップ 3 Delete をクリックします。

ステップ 4 Close をクリックします。

追加情報

P.7-24 の「関連項目」を参照してください。
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事前定義オブジェクトの操作

ツール（RTMT）には、システムの状況をモニタするデフォルトのモニタリング オブジェクトの

セットが用意されています。デフォルト オブジェクトには、パフォーマンス カウンタや Cisco
Unified CallManager でサポートされているサービスについての重要なイベント ステータスが含ま

れています。 

この項は、次の内容で構成されています。

• 事前定義オブジェクトの表示とモニタリング（P.7-10）

• デバイスの操作（P.7-14）

• CTI アプリケーション、デバイス、および回線の操作（P.7-18）

事前定義オブジェクトの表示とモニタリング

カテゴリ、つまり事前定義のオブジェクトのモニタリング ペインには、事前定義のモニタリング

オブジェクトのアクティビティが表示されます。カテゴリの情報を表示する手順は、次のとおりで

す。

手順

ステップ 1 カテゴリを表示またはモニタするには、次のいずれかの操作を実行します。

• Quick Launch Channel で View タブをクリックします。次に、Summary、Server、Call Process
などのカテゴリをクリックします。カテゴリのアイコンが表示されている場合は、アイコンを

クリックして、モニタする情報を表示します。

• 表示するカテゴリに応じて、表 7-1 から次のいずれかのオプションを選択します。

表 7-1 カテゴリのメニュー パス

カテゴリ メニュー パス 表示されるデータ

Summary Monitor > Summary メモリの使用状況、CPU の使用状況、登録済みの電話機、進行中の

コール、アクティブなゲートウェイ ポートとチャネルを表示しま

す。

Server Monitor > Server > CPU and Memory
（または Process、Disk Usage、
Critical Services）

• CPU and Memory：メモリと CPU の使用状況を表示します。

• Process：プロセス名、プロセス ID（PID）、およびプロセス、常

駐メモリと共有メモリ、Nice（レベル）によって使用される CPU
とメモリの割合を表示します。

• Disk Usage：各ホストの最大パーティションが使用している

ディスク容量の割合を表示します。

• Critical Services：特定のサーバのサービスを表示します。
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Call Process Monitor > Call Process > Call 
Activity（または Gateway Activity、
Trunk Activity、SDL Queue、SIP 
Activity）

• Call Activity：クラスタ内の各 Cisco Unified CallManager サーバ

でのコール アクティビティを表示します。完了コール数、試行

されたコール数、進行中のコールなどの項目が含まれます。

• Gateway Activity：Cisco Unified CallManager クラスタでのゲート

ウェイ アクティビティを表示します。アクティブ ポート、処

理中のポート、完了コールなどの項目が含まれます。

• Trunk Activity：Cisco Unified CallManager クラスタのトランク ア
クティビティを表示します。進行中のコールや完了コールなど

の項目が含まれます。

• SDL Queue：SDL キュー情報を表示します。キューにある信号

数や処理された信号数などの項目が含まれます。

• SIP Activity：クラスタ内の各 Cisco Unified CallManager サーバ

の SIP アクティビティを表示します。要求の要約、応答の要約、

応答されなかった受信コールの要約、応答されなかった発信

コールの要約、発信要求の再試行、発信応答の再試行などの項

目が含まれます。

Service Monitor > Service > Cisco TFTP
（または Heartbeat、Database 
Summary）

• Cisco TFTP：クラスタ内の各 Cisco Unified CallManager サーバの

Cisco TFTP ステータスを表示します。TFTP 要求合計、検出さ

れた TFTP 要求合計、中止された TFTP 要求合計などの項目が

含まれます。

• Heartbeat：Cisco Unified CallManager、Cisco TFTP、Cisco 
CallManager Attendant Console サービスのハートビート情報を

表示します。

• Database Summary：Cisco Unified CallManager サーバ上のデータ

ベースに関する要約情報を表示します。データベースのキュー

に登録された接続要求、メモリのキューに登録された接続要

求、接続されたクライアントの合計数、およびキュー登録中に

リセットされたデバイスの数などの項目が含まれます。

表 7-1 カテゴリのメニュー パス（続き）

カテゴリ メニュー パス 表示されるデータ
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Device Monitor > Device Summary
（または Phone Summary）

Device Summary は、クラスタ内の各 Cisco Unified CallManager サー

バの情報として、登録済みの電話機数、登録済みのゲートウェイ デ
バイス数、登録済みのメディア リソース デバイス数などを表示し

ます。

Device Search は、クラスタ名とデバイス タイプをツリー階層に表示

し、電話機やデバイスに関する情報のクエリーを受け付けます。

Phone Summary は、クラスタ内の各 Cisco Unified CallManager サー

バに関する情報として、登録済みの電話機数、登録済みの SIP 電話

機数、登録済みの SCCP 電話機数、登録未完了の電話機数、失敗し

た登録試行数などを表示します。

ヒント Monitor > Device Summary または Monitor > Phone Summary
の順に選択する代わりに、Device > Open Device Search の
順に選択すると、クラスタ名とデバイスまたは電話機の

タイプをツリー階層に表示することができます。

ヒント デバイスをモニタするには、P.7-14 の「モニタ対象の特定

のデバイスの検索」の説明に従って、追加の設定手順を

実行する必要があります。

CTI Manager Monitor > CTI Manager クラスタ名と CTI タイプ（アプリケーション、デバイス、および回

線）をツリー階層に表示します。

特定の CTI タイプをモニタするには、次の項の説明に従って、追加

の設定手順を実行する必要があります。

• モニタ対象の CTI アプリケーションの検索（P.7-18）

• モニタ対象の CTI デバイスの検索（P.7-19）

• モニタ対象の CTI 回線の検索（P.7-20）

メニューバーを使用して CTI Manager を選択することはできませ

ん。各 Cisco Unified CallManager サーバの 1 つのウィンドウで、開

いているデバイス、回線、CTI 接続数をモニタするには、P.7-14 の

「デバイスの操作」を参照してください。

Performance Performance > Open Performance perfmon カウンタを表示します。 

perfmon カウンタの使用方法の詳細については、P.9-1 の「パフォー

マンス モニタリングの設定と使用」を参照してください。

表 7-1 カテゴリのメニュー パス（続き）

カテゴリ メニュー パス 表示されるデータ
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ステップ 2 一部のカテゴリでは、特定のサーバやデバイス タイプを選択してモニタできます。特定のサーバや

デバイス タイプを選択してモニタするには、リストされたペインで次の操作のいずれかを実行しま

す。

• CPU and Memory Usage ペイン：特定のサーバの CPU やメモリの使用状況をモニタするには、

Host ドロップダウン リスト ボックスからサーバを選択します。

• Disk Usage ペイン：特定のサーバのディスク使用状況をモニタするには、Host ドロップダウン

リスト ボックスの Disk Usage からサーバを選択します。

• Critical Services ペイン：特定のサーバの重要なサービスをモニタするには、Host ドロップダウ

ン リスト ボックスの Critical Services からサーバを選択します。

• Gateway Activity ペイン：特定のゲートウェイ タイプのゲートウェイ アクティビティをモニタ

するには、Gateway Type ドロップダウン リスト ボックスからゲートウェイ タイプを選択しま

す。

• Trunk Activity ペイン：特定のトランク タイプのトランク アクティビティをモニタするには、

Trunk Type ドロップダウン リスト ボックスからトランク タイプを選択します。

• SDL Queue ペイン：特定の SDL キュー タイプの SDL キュー情報をモニタするには、SDL Queue
Type ドロップダウン リスト ボックスからタイプを選択します。

追加情報

P.7-24 の「関連項目」を参照してください。
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デバイスの操作

この項は、次の内容で構成されています。

• モニタ対象の特定のデバイスの検索（P.7-14）

• 電話機情報の表示（P.7-15）

• デバイスのプロパティの表示（P.7-16）

• デバイスとパフォーマンス モニタリング カウンタのポーリング レートの設定（P.7-17）

モニタ対象の特定のデバイスの検索

次の手順を実行すると、次のデバイス タイプのデータをモニタできます。

• 電話機

• ゲートウェイ デバイス

• H.323 デバイス

• CTI デバイス

• ボイスメール デバイス

• メディア リソース

• ハント リスト

• SIP トランク

手順

ステップ 1 次のいずれかの操作を実行します。

• Search > Device > <Phone、Gateway、Hunt List などのデバイス タイプ > の順に選択します。検

索条件を入力するための、デバイス選択ウィンドウが表示されます。ステップ 4 に進みます。

• Quick Launch Channel ペインで、Device をクリックしてから Device Search アイコンをクリック

します。

• Device > Open Device Search の順に選択します。

Device Search ウィンドウに、クラスタ名とモニタ可能なすべてのデバイス タイプがリストされたツ

リー階層が表示されます。

ヒント Device Search または CTI Search ペインを表示したら、デバイス タイプを右クリックし、

CCMAdmin を選択して Cisco Unified CallManager の管理ページ に移動できます。

ステップ 2 クラスタ内のすべてのデバイスを検索するか、デバイス モデルの完全なリストを表示して選択する

には、クラスタ名を右クリックし、Monitor を選択します。

ステップ 3 特定のデバイス タイプをモニタするには、ツリー階層からデバイス タイプを右クリックまたはダ

ブルクリックします。

ヒント デバイス タイプを右クリックした場合は、Monitor を選択してデバイス選択ウィンドウ

を表示する必要があります。
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ステップ 4 Select device with status ウィンドウで、適切なオプション ボタンをクリックします。

ステップ 5 クリックしたオプション ボタンの横のドロップダウン リスト ボックスで、Any CallManager また

はデバイス情報を表示する特定の Cisco Unified CallManager サーバを選択します。

ヒント この後のステップでは、< Back、Next >、Finish、または Cancel の各ボタンを選択できます。

ステップ 6 Next > ボタンをクリックします。

ステップ 7 Search by device model ペインで、適切なオプション ボタンをクリックします。

ヒント Device Model を選択した場合は、デバイス情報を表示するデバイス タイプを選択します。

ステップ 8 Next をクリックします。

ステップ 9 Search with name ペインで、いずれかのオプション ボタンを選択し、必要に応じて、対応するフィー

ルドに適切な情報を入力します。

ステップ 10 Next をクリックします。

ステップ 11 Monitor following attributes ペインで、1 つまたはすべての検索属性をオンにします。 

ステップ 12 Finish をクリックします。

追加情報

P.7-24 の「関連項目」を参照してください。

電話機情報の表示

RTMT Device Monitoring ペインに表示されている電話機の情報を見ることができます。ここでは、

電話機の情報を表示する方法を説明します。

手順

ステップ 1 RTMT Device Monitoring ペインに電話機を表示するには、P.7-14 の「モニタ対象の特定のデバイス

の検索」を参照します。

ステップ 2 次のいずれかの操作を実行します。

• 情報を表示する電話機を右クリックし、Open を選択します。

• 電話機をクリックし、Device > Open の順に選択します。

ステップ 3 Select Device with Status ペインで、適切なオプション ボタンをクリックします。
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ステップ 4 クリックしたオプション ボタンの横のドロップダウン リスト ボックスで、Any CallManager また

はデバイス情報を表示する特定の Cisco Unified CallManager サーバを選択します。

ステップ 5 Search By Device Model ペインで、表示する電話プロトコルを選択します。

ステップ 6 Any Model または Device Model オプション ボタンをクリックします。Device Model オプション ボ
タンをクリックした場合、表示する特定の電話機モデルを選択します。 

ステップ 7 Next をクリックします。

ステップ 8 Search With Name ペインで適切なオプション ボタンをクリックし、対応するフィールドに適切な情

報を入力します。  

ステップ 9 Monitor following attributes ペインで、1 つまたはすべての検索属性をオンにします。 

ステップ 10 Finish をクリックします。

Device Information ウィンドウが表示されます。デバイスについて詳しい情報を表示するには、ウィ

ンドウの左側のペインに表示されるフィールドを選択します。

追加情報

P.7-24 の「関連項目」を参照してください。

デバイスのプロパティの表示

デバイスのプロパティは、RTMT Device Monitoring ペインに表示できます。ここでは、デバイスの

プロパティを表示する方法を説明します。

手順

ステップ 1 RTMT device monitoring ペインにデバイスを表示します。P.7-14 の「モニタ対象の特定のデバイス

の検索」を参照してください。

ステップ 2 次のいずれかの操作を実行します。

• プロパティ情報を表示するデバイスを右クリックし、Properties を選択します。

• プロパティ情報を表示するデバイスをクリックし、Device > Properties の順に選択します。

ステップ 3 デバイスの説明を表示するには、Description タブをクリックします。

ステップ 4 その他のデバイス情報を表示するには、Other Info タブをクリックします。

追加情報

P.7-24 の「関連項目」を参照してください。
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デバイスとパフォーマンス モニタリング カウンタのポーリング レートの設定

Cisco Unified CallManager は、カウンタ、デバイス、ゲートウェイ ポートをポーリングしてステー

タス情報を収集します。RTMT monitoring ペインでは、パフォーマンス モニタリング カウンタとデ

バイスのポーリング間隔を設定します。

（注） ポーリング レートの頻度を高くすると、Cisco Unified CallManager のパフォーマンスに悪影響を及

ぼすことがあります。図形式のパフォーマンス カウンタをモニタする場合、最小ポーリング レー

トは 5 秒です。表形式の パフォーマンス カウンタをモニタする場合、最小レートは 1 秒です。デ

フォルト値はいずれも 10 秒です。 

デバイスのデフォルト値は 10 秒です。

ポーリング レートを更新するには、次の手順を実行します。

手順

ステップ 1 RTMT monitoring ペインに、デバイスまたはパフォーマンス モニタリング カウンタを表示します。

ステップ 2 デバイスをクリックし、Edit > Polling Rate の順に選択します。

ステップ 3 Polling Interval ペインで、使用する時間間隔を指定します。

ステップ 4 OK をクリックします。

追加情報

P.7-24 の「関連項目」を参照してください。
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CTI アプリケーション、デバイス、および回線の操作

この項は、次の内容で構成されています。

• CTI Manager 情報の表示（P.7-18）

• モニタ対象の CTI アプリケーションの検索（P.7-18）

• モニタ対象の CTI デバイスの検索（P.7-19）

• モニタ対象の CTI 回線の検索（P.7-20）

• アプリケーション情報の表示（P.7-21）

CTI Manager 情報の表示

クラスタ内の各 Cisco Unified CallManager サーバについて、開かれているデバイス、回線、CTI 接
続の図を表示するには、Quick Launch Channel で CTI をクリックし、CTI Manager アイコンをク

リックします。

追加情報

P.7-24 の「関連項目」を参照してください。

モニタ対象の CTI アプリケーションの検索

モニタ対象の特定の CTI アプリケーションを検索するには、次の手順を実行します。

手順

ステップ 1 次のいずれかの操作を実行します。

• Search > CTI > CTI Applications の順に選択します。検索条件を入力できる選択ウィンドウが

表示されます。ステップ 3 に進みます。

• Quick Launch Channel ペインで、CTI をクリックしてから CTI Search アイコンをクリックしま

す。CTI 検索ウィンドウに、クラスタ名と、モニタ可能なすべての CTI タイプがリストされた

ツリー階層が表示されます。

ステップ 2 ツリー階層で、Applications を右クリックまたはダブルクリックします。

ヒント オプションを右クリックした場合は、Monitor を選択します。

ステップ 3 CTI Manager ドロップダウン リスト ボックスから、モニタの対象とする CTI Manager を選択します。

ステップ 4 Application Status ドロップダウン リストボックスで、アプリケーション ステータスを選択します。

ステップ 5 Next をクリックします。

ステップ 6 Application Pattern ペインで、適切なオプション ボタンをクリックします。

ステップ 7 クリックしたオプション ボタンのフィールドに情報を入力します。たとえば、IP Subnet オプショ

ン ボタンをクリックした場合は、フィールドに IP アドレスとサブネット マスクを入力します。
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ステップ 8 Next をクリックします。

ステップ 9 Monitor following attributes ウィンドウで、モニタする属性に対応した 1 つまたはすべてのチェック

ボックスをオンにします。

ステップ 10 Finish をクリックします。

Application Monitoring ペインに、選択した情報が表示されます。

追加情報

P.7-24 の「関連項目」を参照してください。

モニタ対象の CTI デバイスの検索

モニタ対象の特定の CTI デバイスを検索するには、次の手順を実行します。

手順

ステップ 1 次のいずれかの操作を実行します。

• Monitor > CTI > CTI Devices の順に選択します。検索条件を入力できる選択ウィンドウが表示

されます。ステップ 3 に進みます。

• Quick Launch Channel ペインで、CTI をクリックしてから CTI Search アイコンをクリックしま

す。CTI 検索ウィンドウに、クラスタ名と、モニタ可能なすべての CTI タイプがリストされた

ツリー階層が表示されます。

ステップ 2 ツリー階層で、Devices を右クリックまたはダブルクリックします。

ヒント オプションを右クリックした場合は、Monitor を選択します。

ステップ 3 CTI Manager ドロップダウン リスト ボックスから、モニタの対象とする CTI Manager を選択します。

ステップ 4 Devices Status ドロップダウン リストボックスで、デバイス ステータスを選択します。

ステップ 5 Devices ペインで、適切なオプション ボタンをクリックします。

ヒント Device Name を選択した場合は、フィールドにデバイス名を入力します。

ステップ 6 Next をクリックします。

ステップ 7 Application Pattern ウィンドウで、適切なオプション ボタンをクリックします。

ステップ 8 クリックしたオプション ボタンのフィールドに情報を入力します。たとえば、IP Subnet をクリッ

クした場合は、フィールドに IP アドレスとサブネット マスクを入力します。
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ステップ 9 Next をクリックします。

ステップ 10 Monitor following attributes ウィンドウで、モニタする属性に対応した 1 つまたはすべてのチェック

ボックスをオンにします。

ステップ 11 Finish をクリックします。

Device Monitoring ペインに、選択した情報が表示されます。

追加情報

P.7-24 の「関連項目」を参照してください。

モニタ対象の CTI 回線の検索

モニタ対象の特定の CTI 回線を検索するには、次の手順を実行します。

手順

ステップ 1 次のいずれかの操作を実行します。

• Monitor > CTI > CTI Lines の順に選択します。検索条件を入力できる選択ウィンドウが表示さ

れます。ステップ 3 に進みます。

• Quick Launch Channel ペインで、CTI をクリックしてから CTI Search アイコンをクリックしま

す。CTI Search ウィンドウに、クラスタ名と、モニタ可能なすべての CTI タイプがリストされ

たツリー階層が表示されます。

ステップ 2 ツリー階層で、Lines を右クリックまたはダブルクリックします。

ヒント オプションを右クリックした場合は、Monitor を選択します。

ステップ 3 CTI Manager & Status ドロップダウン リスト ボックスから、モニタの対象とする CTI Manager を選

択します。

ステップ 4 Lines Status ドロップダウン リストボックスで、ステータスを選択します。

ステップ 5 Device ペインで、適切なオプション ボタンをクリックします。 

ヒント Device Name を選択した場合は、フィールドにデバイス名を入力します。

ステップ 6 Lines ペインで、適切なオプション ボタンをクリックします。

（注） Directory Number を選択した場合は、フィールドに電話番号を入力します。
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ステップ 7 Next をクリックします。

ステップ 8 Application Pattern ペインで、適切なオプション ボタンをクリックします。

ステップ 9 クリックしたオプション ボタンのフィールドに情報を入力します。たとえば、IP Subnet をクリッ

クした場合は、フィールドに IP アドレスとサブネット マスクを入力します。

ステップ 10 Next をクリックします。

ステップ 11 Monitor following attributes ウィンドウで、モニタする属性に対応した 1 つまたはすべてのチェック

ボックスをオンにします。

ステップ 12 Finish をクリックします。

Lines Monitoring ペインに、選択した情報が表示されます。

追加情報

P.7-24 の「関連項目」を参照してください。

アプリケーション情報の表示

Cisco IP Phone、CTI ポート、CTI ルート ポイントなどの選択されたデバイスに対するアプリケー

ション情報を表示できます。ここでは、アプリケーション情報を表示する方法を説明します。

手順

ステップ 1 P.7-19 の「モニタ対象の CTI デバイスの検索」の説明に従って、RTMT monitoring ペインにデバイ

スを表示します。

ステップ 2 次のいずれかの操作を実行します。

• アプリケーション情報を表示するデバイス（たとえば、CTI）を右クリックし、App Info を選

択します。

• アプリケーション情報を表示するデバイスをクリックし、Device > App Info の順に選択します。

Application Information ウィンドウに、CTI マネージャのノード名、アプリケーション ID、ユーザ

ID、アプリケーション IP アドレス、アプリケーションの状況、アプリケーションのタイム スタン

プ、デバイスのタイム スタンプ、デバイス名、および CTI デバイスのオープン状況が表示されます。

ステップ 3 表示された情報を更新するには、Refresh をクリックします。OK をクリックして、ウィンドウを

閉じます。

追加情報

P.7-24 の「関連項目」を参照してください。
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カテゴリの操作

カテゴリを使用すると、パフォーマンス モニタリング カウンタとデバイスをモニタできます。た

とえば、デフォルト カテゴリの CallManager では、6 つのパフォーマンス モニタリング カウンタを

グラフ形式でモニタできます。それ以上のカウンタを使用する場合は、新しいカテゴリを設定して、

データを表形式で表示できます。

電話やゲートウェイなどのデバイスに関するさまざまな検索を実行する場合、検索ごとにカテゴリ

を作成し、結果をカテゴリに保存することができます。

カテゴリの追加

カテゴリを追加するには、次の手順を実行します。

手順

ステップ 1 Performance Monitoring または Devices ツリー階層を表示します。

ステップ 2 Edit > Add New Category の順に選択します。

ステップ 3 カテゴリ名を入力し、OK をクリックします。

ウィンドウの下部に、カテゴリのタブが表示されます。 

追加情報

• P.7-24 の「関連項目」を参照してください。

カテゴリ名の変更

カテゴリ名を変更するには、次の手順を実行します。

手順

ステップ 1 次のいずれかの操作を実行します。

• 名前を変更するカテゴリのタブを右クリックし、Rename Category を選択します。

• 名前を変更するカテゴリのタブをクリックし、Edit > Rename Category の順に選択します。

ステップ 2 新しいカテゴリ名を入力し、OK をクリックします。

ウィンドウの下部に、変更後のカテゴリ名が表示されます。

追加情報

• P.7-24 の「関連項目」を参照してください。
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カテゴリの削除

カテゴリを削除するには、次のいずれかの操作を実行します。

• 削除するカテゴリのタブを右クリックし、Remove Category を選択します。

• 削除するカテゴリのタブをクリックし、Edit > Remove Category の順に選択します。

追加情報

P.7-24 の「関連項目」を参照してください。

参考情報

• RTMT でのアラート設定（P.8-1）

• パフォーマンス モニタリングの設定と使用（P.9-1）

• RTMT のトレース収集とログ集中管理（P.10-1）

• 『Cisco Unified CallManager Serviceability システム ガイド』の「Real-Time Monitoring ツール 」

• 『Cisco Unified CallManager Serviceability システム ガイド』の「アラート」

• 『Cisco Unified CallManager Serviceability システム ガイド』の「パフォーマンス オブジェクトと

パフォーマンス カウンタ」 

追加情報

P.7-24 の「関連項目」を参照してください。
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関連項目

• カテゴリの追加（P.7-22）

• カテゴリ名の変更（P.7-22）

• カテゴリの削除（P.7-23）

• 「Real-Time Monitoring の設定」

• CTI Manager 情報の表示（P.7-18）

• モニタ対象の CTI アプリケーションの検索（P.7-18）

• モニタ対象の CTI デバイスの検索（P.7-19）

• モニタ対象の CTI 回線の検索（P.7-20）

• パフォーマンス モニタリングの設定と使用（P.9-1）

• デバイスの操作（P.7-14）

• デバイスのプロパティの表示（P.7-16）

• モニタ対象の特定のデバイスの検索（P.7-14）

• 電話機情報の表示（P.7-15）

• デバイスとパフォーマンス モニタリング カウンタのポーリング レートの設定（P.7-17）

• デフォルトの構成プロファイルの使用（P.7-8）

• プロファイルの復元（P.7-9）

• デフォルトの構成プロファイルの使用（P.7-8）

• 構成プロファイルの削除（P.7-9）

• 構成プロファイルの追加（P.7-8）

• 構成プロファイルの操作（P.7-8）

• 事前定義オブジェクトの操作（P.7-10）

• RTMT でのアラート設定（P.8-1）

• パフォーマンス モニタリングの設定と使用（P.9-1）

• RTMT SysLog Viewer の使用（P.11-1）

• Real-Time Monitoring Tool（RTMT）のインストール（P.7-2）

• RTMT のアンインストール（P.7-4）

• RTMT のアップグレード（P.7-3）

• RTMT の使用（P.7-5）
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RTMT でのアラート設定

RTMT には、あらかじめ設定されているアラートとユーザ定義のアラートという 2 つの種類のア

ラートがあります。どちらの種類のアラートも設定できますが、あらかじめ設定されているアラー

トは削除できません。あらかじめ設定されているアラートやユーザ定義のアラートを RTMT で使用

不可にすることができます。

あらかじめ設定されているアラート、アラートのカスタマイゼーション、およびアラートを設定で

きるアラート アクション フィールドについては、『Cisco Unified CallManager Serviceability システム

ガイド』の「アラート」を参照してください。

アクティブにされているサービスが稼働状態から停止状態になると、RTMT によりアラートが生成

されます。Alert Central を使用して、RTMT によって生成されるアラートの状況と履歴を表示でき

ます。 

この章は、次の項で構成されています。

• アラートの操作（P.8-2）

• アラート プロパティの設定（P.8-4）

• Cisco Unified CallManager ノードまたはクラスタ上のアラートの一時停止（P.8-7）

• アラート通知用電子メールの設定（P.8-8）

• アラート アクションの設定（P.8-8）
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アラートの操作

次の手順を実行して、Alert Central へのアクセス、アラート情報のソート、アラートの有効化、無

効化、削除、アラートのクリア、またはアラート詳細の表示などの操作を実行できます。

手順

ステップ 1 次のいずれかの操作を実行します。

• Quick Launch Channel で、Tools タブ、Alert タブの順にクリックし、Alert Central アイコンを

クリックします。

• Tools > Alert > Alert Central の順に選択します。

RTMT が Cisco Unified CallManager クラスタ内で生成したアラートの状況と履歴を示す Alert Central
モニタリング ウィンドウが表示されます。

ステップ 2 次のいずれかの操作を実行します。

• アラートのプロパティを設定する場合は、P.8-4 の「アラート プロパティの設定」を参照して

ください。

• Cisco Unified CallManager ノードのアラートを一時停止する場合は、P.8-7 の「Cisco Unified 
CallManager ノードまたはクラスタ上のアラートの一時停止」を参照してください。

• アラートの電子メール通知を設定する場合は、P.8-8 の「アラート通知用電子メールの設定」を

参照してください。

• アラート アクションを設定する場合は、P.8-8 の「アラート アクションの設定」を参照してく

ださい。

• Alert Status ペイン内のアラート情報をソートする場合は、列見出しで上向き矢印または下向き

矢印をクリックします。たとえば、Enabled 列や InSafeRange 列の上向き矢印または下向き矢印

をクリックします。

Alert History ペインの列の上向き矢印または下向き矢印をクリックすると、アラート履歴情報を
ソートできます。ペインに表示されていないアラート履歴を表示するには、Alert History ペイン
の右側にあるスクロール バーを使用します。

• アラートを有効化、無効化、または削除するには、次のいずれかの操作を実行します。

－ Alert Status ウィンドウで、アラートを右クリックし、目的の操作に応じて、Disable/Enable
Alert（オプション トグル）または Remove Alert を選択します。

－ Alert Status ウィンドウでアラートを強調表示し、Tools > Alert > Disable/Enable（または
Remove）Alert の順に選択します。

ヒント ユーザ定義のアラートに限り、RTMT から削除できます。あらかじめ設定されているア

ラートを選択すると、Remove Alert オプションがグレー表示されます。

• アラートを解決した後、アラートを個別に、またはまとめてクリアするには、次のいずれかの

操作を実行します。

－ Alert Status ウィンドウが表示されたら、アラートを右クリックし、Clear Alert（または 
Clear All Alerts）を選択します。

－ Alert Status ウィンドウでアラートを強調表示し、Tools > Alert > Clear Alert（または Clear
All Alerts）の順に選択します。

アラートをクリアすると、アラートの色が赤から黒に変わります。
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• アラートの詳細を表示するには、次のいずれかの操作を実行します。

－ Alert Status ウィンドウが表示されたら、アラートを右クリックし、Alert Details を選択し
ます。

－ Alert Status ウィンドウでアラートを強調表示し、Tools > Alert > Alert Details の順に選択し
ます。

ヒント アラートの詳細を確認したら、OK をクリックします。

追加情報

P.8-8 の「関連項目」を参照してください。
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アラート プロパティの設定

アラート プロパティを設定する手順は、次のとおりです。

手順

ステップ 1 P.8-2 の「アラートの操作」の説明に従って、Alert Central を表示します。

ステップ 2 Alert Status ウィンドウで、アラート プロパティを設定するアラートをクリックします。

ステップ 3 次のいずれかの操作を実行します。

• アラートを右クリックし、Set Alert/Properties を選択します。

• Tools > Alert > Set Alert/Properties の順に選択します。

（注） Cisco Unified CallManager のクラスタ全体のアラートの場合は、Alert Properties ウィンドウ

に Enable/Disable this alert on following server(s): ボックスが表示されません。クラスタ全体の

アラートには、登録済みの電話機の数、ゲートウェイの数、メディア デバイスの数、すべ

て使用されたルート リスト、すべて使用されたメディア リスト、稼働していない MGCP D
チャネル、悪意のあるコールのトレース、および限度を超えている品質レポートが含まれ

ます。

ステップ 4 アラートを使用可能にするには、Enable Alert チェックボックスをオンにします。

ステップ 5 Severity ドロップダウン リスト ボックスから、アラートの重大度を選択します。

ステップ 6 Enable/Disable this alert on following server(s) ペインで、このアラートを有効にするサーバの Enable
チェックボックスをオンにします。

あらかじめ設定されているアラートについては、Description 情報ペインにアラートの説明が表示さ

れます。

ステップ 7 Next をクリックします。

ステップ 8 Threshold ペインに、システムがアラートをトリガーする条件を入力します。

ステップ 9 Duration ペインで、次のオプション ボタンのいずれかをクリックします。

• Trigger alert only when below or over.... オプション ボタン：値が特定の期間（秒単位）に常にし

きい値を下回るまたは上回る場合に限り、アラートがトリガーされます。秒数を入力します。

• Trigger alert immediately：アラートがすぐにトリガーされます。

ステップ 10 Next をクリックします。

ステップ 11 Frequency ペインで、次のオプション ボタンのいずれかをクリックします。

• trigger alert on every poll：ポーリングのたびにアラートがトリガーされます。

• trigger up to <numbers> of alerts within <number> of minutes：特定の分数の間に、特定の数のア

ラートがトリガーされます。アラートの数と分数を入力します。
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ステップ 12 Schedule ペインで、次のオプション ボタンのいずれかをクリックします。

• 24-hours daily：アラートが 1 日 24 時間トリガーされます。

• Start time/Stop time：特定の開始時刻と終了時刻の間のみアラートがトリガーされます。開始時

刻と終了時刻を入力します。

ステップ 13 Next をクリックします。

ステップ 14 このアラートの電子メールを使用可能にする場合は、Enable Email チェックボックスをオンにしま

す。

ステップ 15 このアラートでアラート アクションをトリガーするには、ドロップダウン リスト ボックスから、

送信するアラート アクションを選択します。

ステップ 16 新しいアラート アクションを設定する場合、または既存のアラート アクションを編集する場合は、

Configure をクリックします。

ステップ 17 新しいアラート アクションを追加するには、次の手順を実行します。

a. Add をクリックします。

b. Name フィールドに、アラート アクションの名前を入力します。

c. Description フィールドに、アラート アクションの説明を入力します。

d. 電子メール受信者を追加するには、Add をクリックします。

e. Enter email/epage address フィールドに、アラート アクションを受信する受信者の電子メールま

たは電子ページのアドレスを入力します。

f. OK をクリックします。

Action Configuration ウィンドウに、追加した受信者が表示され、その Enable チェックボックスがオ

ンになっています。

ヒント 電子メールの受信者を削除するには、その受信者を強調表示し、Delete をクリックしま

す。選択した受信者が、受信者リストから削除されます。

g. すべての受信者を追加したら、OK をクリックします。

ステップ 18 既存のアラート アクションを編集するには、次の手順を実行します。

a. アラート アクションを強調表示し、Edit をクリックします。

選択したアラート アクションの Action Configuration ウィンドウが表示されます。

b. 設定を変更して、OK をクリックします。

ステップ 19 アラート アクションの設定を終了したら、Close をクリックします。
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ステップ 20 トレースのダウンロードが許可されていないアラートの場合は、Alert Properties: Email Notification
ウィンドウで Activate をクリックします。

CriticalServiceDown や CodeYellow のようにトレースのダウンロードが許可されているアラートの

場合は、次の手順を実行します。

a. Next をクリックします。

b. Alert Properties： TCT Download ウィンドウで、Enable TCT Download チェックボックスをオン

にします。

c. SFTP Parameters Dialog ウィンドウが表示されます。IP アドレス、ユーザ名、パスワード、ポー

ト、およびトレースを保存するためのダウンロード ディレクトリ パスを入力します。SFTP サー

バとの接続を確認するには、Test Connection をクリックします。接続テストに失敗した場合、

設定は保存されません。

d. OK をクリックして、設定を保存します。 

e. TCT Download Parameters ウィンドウに、ダウンロードの回数と頻度を入力します。ダウンロー

ドの回数と頻度を設定すると、ダウンロードされるトレース ファイルを制限するのに役立ちま

す。設定されたポーリングが、頻度のデフォルト設定の基準となります。

注意 TCT Download を有効にすると、サーバ上のサービスに影響が生じることがあります。ダ

ウンロード回数を大きくすると、サーバのサービス品質に悪影響が生じます。

（注） アラート アクションを削除するには、そのアクションを強調表示し、Delete をクリックし

て、Close をクリックします。

追加情報

P.8-8 の「関連項目」を参照してください。
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Cisco Unified CallManager ノードまたはクラスタ上のアラートの一時
停止

特定の Cisco Unified CallManager ノードまたはクラスタ全体で、一部のアラートまたはすべてのア

ラートを一時的に停止する必要が生じる場合があります。たとえば、Cisco Unified CallManager を新

しいリリースにアップグレードする場合、アップグレードが完了するまですべてのアラートを一時

停止する必要があります。アラートを一時停止することにより、アップグレード中に電子メールや

電子ページを受信しなくなります。Alert Central でアラートを一時停止する手順は、次のとおりで

す。

手順

ステップ 1 Tools > Alert > Suspend cluster/node Alerts の順に選択します。

（注） サーバごとの一時停止状況は、Cisco Unified CallManager クラスタ全体のアラートには適用

されません。

ステップ 2 クラスタ内のすべてのアラートを一時停止するには、Cluster Wide オプション ボタンを選択し、

suspend all alerts チェックボックスをオンにします。

ステップ 3 サーバごとにアラートを一時停止するには、Per Server オプション ボタンを選択し、アラートを一

時停止するサーバの Suspend チェックボックスをオンにします。

ステップ 4 OK をクリックします。

（注） アラートを再開するには、再び Alert > Suspend cluster/node Alerts の順に選択し、suspend
チェックボックスをオフにします。

追加情報

P.8-8 の「関連項目」を参照してください。
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アラート通知用電子メールの設定

アラート通知用の電子メールを設定するには、次の手順を実行します。

手順

ステップ 1 Tools > Alert > Config Email Server の順に選択します。

Mail Server Configuration ウィンドウが表示されます。

ステップ 2 Mail Server フィールドに、電子メールの受信者の情報を入力します。

ステップ 3 Port フィールドに、メール サーバのポート番号を入力します。

ステップ 4 OK をクリックします。

追加情報

P.8-8 の「関連項目」を参照してください。

アラート アクションの設定

新しいアラート アクションを設定する手順は、次のとおりです。

手順

ステップ 1 P.8-2 の「アラートの操作」の説明に従って、Alert Central を表示します。

ステップ 2 Alert > Config Alert Action の順に選択します。

ステップ 3 P.8-4 の「アラート プロパティの設定」のステップ 17 ～ステップ 20 を実行して、アラート アク

ションを追加、編集、または削除します。

追加情報

P.8-8 の「関連項目」を参照してください。

関連項目

• アラートの操作（P.8-2）

• アラート プロパティの設定（P.8-4）

• Cisco Unified CallManager ノードまたはクラスタ上のアラートの一時停止（P.8-7）

• アラート通知用電子メールの設定（P.8-8）

• 『Cisco Unified CallManager Serviceability システム ガイド』の「アラート」

• アラート アクションの設定（P.8-8）
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9

パフォーマンス モニタリングの設定と
使用 

Cisco Unified CallManager のパフォーマンスをモニタするには、RTMT を使用してオブジェクトのカ

ウンタを選択します。フォルダを展開すると、各オブジェクトのカウンタが表示されます。トラブ

ルシューティング用の perfmon データのログ記録を有効にし、システム状態に関する包括的な情報

を備えた統計情報を一連の perfmon カウンタから自動的に収集することもできます。トラブル

シューティング用の perfmon データのログ記録を有効にすると、多大なシステム リソースが消費さ

れ、システム パフォーマンスに影響が生じることがあるので注意してください。

この章は、次の項で構成されています。

• パフォーマンス カウンタの表示（P.9-2）

• RTMT Performance Monitoring ペインからのカウンタの削除（P.9-3）

• カウンタ インスタンスの追加（P.9-4）

• カウンタのアラート通知の設定（P.9-5）

• カウンタの詳細表示（P.9-8）

• カウンタの説明の表示（P.9-9）

• サンプル データの設定（P.9-10）

• カウンタ データの表示（P.9-11）
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パフォーマンス カウンタの表示

RTMT は、パフォーマンス カウンタを図形式または表形式で表示します。図形式では、線グラフを

使用してパフォーマンス カウンタ情報を表示します。作成したカテゴリ タブごとに、最大 6 つの

図を RTMT Perfmon Monitoring ペインに表示できます。1 つの図には、最大 3 つのカウンタを表示

できます。 

ヒント RTMT Perfmon Monitoring ペインの 1 つの図には、カウンタを 3 つまで表示できます。図に別のカ

ウンタを追加するには、カウンタをクリックして RTMT Perfmon Monitoring ペインにドラッグしま

す。この操作をもう一度繰り返して、最大 3 つのカウンタを追加します。

デフォルトでは、RTMT はパフォーマンス カウンタを図形式で表示します。パフォーマンス カウ

ンタを表形式で表示するように選択することもできます。パフォーマンス カウンタを表形式で表示

するには、新しいカテゴリを作成するときに Present Data in Table View チェックボックスをオンに

します。 

機能ベースの一連のカウンタを表示するようにパフォーマンス カウンタを整理して、それをカテゴ

リに保存することができます。RTMT プロファイルを保存した後は、必要なカウンタにすばやくア

クセスできます。カテゴリを作成した後に、図形式から表形式あるいはその逆に表示方法を変更す

ることはできません。

手順

ステップ 1 次のいずれかの操作を実行します。

• Quick Launch Channel ペインで、Perfmon をクリックしてから Perfmon Monitoring アイコンを

クリックします。

• Perfmon > Open Perfmon Monitoring の順に選択します。

ステップ 2 モニタするカウンタの追加先であるサーバの名前をクリックします。

ツリー階層が展開され、そのノードのすべてのパフォーマンス オブジェクトが表示されます。

ステップ 3 カウンタを表形式でモニタするには、ステップ 4 を参照します。カウンタを図形式でモニタするに

は、ステップ 5 を参照します。

ステップ 4 カウンタを表形式でモニタするには、次の手順を実行します。

a. Edit > New Category の順に選択します。

b. Enter Name フィールドにタブ名を入力します。

c. パフォーマンス カウンタを表形式で表示するには、Present Data in Table View チェックボック

スをオンにします。

d. OK をクリックします。

入力した名前の付いた新規タブが、ペインの下部に表示されます。

e. モニタするカウンタを含むオブジェクト名の隣にあるファイル アイコンをクリックします。
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ヒント カウンタを表形式で表示した後、図形式に変更するには、カテゴリ タブを右クリックし、

Remove Category を選択します。カウンタが図形式で表示されます。

ステップ 5 カウンタを図形式でモニタするには、次の操作を実行します。

• モニタするカウンタを含むオブジェクト名の隣にあるファイル アイコンをクリックします。

カウンタのリストが表示されます。

• カウンタ情報を表示するには、カウンタを右クリックして Counter Monitoring をクリックする

か、カウンタをダブルクリックするか、カウンタを RTMT Perfmon Monitoring ペインにドラッ

グ アンド ドロップします。

RTMT Perfmon Monitoring ペインにカウンタの図が表示されます。

追加情報

P.9-12 の「関連項目」を参照してください。

RTMT Performance Monitoring ペインからのカウンタの削除

カウンタが必要なくなったときは、RTMT Perfmon Monitoring ペインからカウンタを削除できます。

ここでは、ペインからカウンタを削除する方法を説明します。

次のいずれかの操作を実行します。

• 削除するカウンタを右クリックし、Remove を選択します。

• 削除するカウンタをクリックし、Perfmon > Remove Chart/Table Entry の順に選択します。

RTMT Perfmon Monitoring ペインからカウンタの図が消去されます。

追加情報

P.9-12 の「関連項目」を参照してください。
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カウンタ インスタンスの追加

カウンタ インスタンスを追加するには、次の手順を実行します。

手順

ステップ 1 P.9-2 の「パフォーマンス カウンタの表示」の説明に従って、パフォーマンス モニタリング カウン

タを表示します。

ステップ 2 次のいずれかの操作を実行します。

• パフォーマンス モニタリング ツリー階層で、パフォーマンス モニタリング カウンタをダブル

クリックします。

• パフォーマンス モニタリング ツリー階層でパフォーマンス モニタリング カウンタをクリック

し、Performance > Counter Instances の順に選択します。

• パフォーマンス モニタリング ツリー階層でパフォーマンス モニタリング カウンタを右クリッ

クし、Counter Instances を選択します。

ステップ 3 Select Instance ウィンドウで、インスタンスをクリックし、Add をクリックします。

カウンタが表示されます。

追加情報

P.9-12 の「関連項目」を参照してください。
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カウンタのアラート通知の設定

カウンタに関するアラート通知を設定する手順は、次のとおりです。

ヒント カウンタのアラートを削除するには、カウンタを右クリックし、Remove Alert を選択します。アラー

トを削除すると、オプションがグレー表示されます。

手順

ステップ 1 P.9-2 の「パフォーマンス カウンタの表示」の説明に従って、パフォーマンス カウンタを表示します。

ステップ 2 カウンタの図または表で、アラート通知を設定するカウンタを右クリックし、Alert/Threshold を選

択します。

ステップ 3 Enable Alert チェックボックスをオンにします。

ステップ 4 Severity ドロップダウン リスト ボックスで、通知する重大度を選択します。

ステップ 5 Description ペインに、アラートの説明を入力します。

ステップ 6 Next をクリックします。

ステップ 7 表 9-1 を使用して、Threshold、Value Calculated As、Duration、Frequency、Schedule の各ペインの設

定を行います。ウィンドウに設定を入力したら、Next をクリックして次のペインに進みます。

表 9-1 カウンタのアラート設定パラメータ

設定値 説明

Threshold ペイン

Trigger alert when following 
conditions met（Over、Under）

チェックボックスをオンにし、適切な値を入力します。

• Over：アラート通知がアクティブになる前に満たされている必

要のある最大しきい値を設定するには、このチェックボックス

をオンにします。Over value フィールドに値を入力します。た

とえば、進行中のコール数の値を入力します。

• Under：アラート通知がアクティブになる前に満たされている

必要のある最小しきい値を設定するには、このチェックボック

スをオンにします。Under value フィールドに値を入力します。

たとえば、進行中のコール数の値を入力します。

ヒント これらのチェックボックスは、Frequency と Schedule の
設定パラメータと組み合せて使用します。
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ステップ 8 システムがアラートとして電子メール メッセージを送信するように設定する場合は、Enable Email
チェックボックスをオンにします。

ステップ 9 すでに設定されているアラート アクションをトリガーする場合は、Trigger Alert Action ドロップダ

ウン リスト ボックスから目的のアラート アクションを選択します。

Value Calculated As ペイン

Absolute、Delta、% Delta 適切なオプション ボタンをクリックします。

• Absolute：一部のカウンタ値は累積値なので（例：CallsAttempted
や CallsCompleted）、データの現在の状況を表示するには

Absolute を選択します。 

• Delta：現在のカウンタ値と直前のカウンタ値の差を表示する

には、Delta を選択します。 

• % Delta：カウンタのパフォーマンスの変化をパーセントで表

示するには、% Delta を選択します。

Duration ペイン

Trigger alert only when value 
constantly...、Trigger alert 
immediately

• Trigger alert only when value constantly...：値が特定の期間（秒単

位）に常にしきい値を下回るまたは上回る場合に限りアラート

通知が必要な場合は、このオプション ボタンを選択し、アラー

トを送信するまでの秒数を入力します。

• Trigger alert immediately：アラート通知をすぐに送信する場合

は、このオプション ボタンをクリックします。

Frequency ペイン

Trigger alert on every poll、
trigger up to...

適切なオプション ボタンをクリックします。

• trigger alert on every poll：しきい値に達したときにポーリング

ごとにアラート通知をアクティブにする場合は、このオプショ

ン ボタンをクリックします。

進行中のコール数がしきい値を上回るか下回る状態が続いて

も、アラート通知は再び送信されません。しきい値が正常（進

行中のコール数が 50 ～ 100）になると、アラート通知は非ア

クティブになります。ただし、しきい値が再びしきい値を上回

るか下回ると、アラート通知は再度アクティブになります。

• trigger up to...：特定の間隔でアラート通知をアクティブにする

場合は、このオプション ボタンをクリックし、送信するアラー

ト数、およびアラートの送信期間（分単位）を入力します。

Schedule ペイン

24-hours daily、start/stop 適切なオプション ボタンをクリックします。

• 24-hours daily：1 日 24 時間アラートをトリガーする場合は、こ

のオプション ボタンをクリックします。

• start/stop：特定の時間枠内でアラート通知をアクティブにする

場合は、このオプション ボタンをクリックし、開始時刻と停

止時刻を入力します。このチェックボックスをオンにした場合

は、毎日の作業の開始時刻と停止時刻を入力します。たとえ

ば、毎日午前 9:00 ～午後 5:00、または午後 9:00 ～午前 9:00 に
カウンタがチェックされるように設定できます。

表 9-1 カウンタのアラート設定パラメータ（続き）

設定値 説明
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ステップ 10 アラートに新しいアラート アクションを設定する場合は、Configure をクリックします。

（注） 指定したアラートがトリガーされるたびに、そのアラート アクションが送信されます。

Alert Action ダイアログボックスが表示されます。

ステップ 11 新しいアラート アクションを追加するには、Add をクリックします。

Action Configuration ダイアログボックスが表示されます。

ステップ 12 Name フィールドに、アラート アクションの名前を入力します。 

ステップ 13 Description フィールドに、アラート アクションの説明を入力します。

ステップ 14 アラート アクションの新しい電子メール受信者を追加するには、Add をクリックします。

Input ダイアログボックスが表示されます。

ステップ 15 アラート アクション通知を受信する受信者の電子メールまたは電子ページのアドレスを入力します。

ステップ 16 OK をクリックします。

Recipient リストに、受信者のアドレスが表示されます。Enable チェックボックスがオンになります。

ヒント 受信者のアドレスを使用不可にするには、Enable チェックボックスをオフにします。

Recipient リストから受信者のアドレスを削除するには、そのアドレスを強調表示し、

Delete をクリックします。

ステップ 17 OK をクリックします。

ステップ 18 追加したアラート アクションが Action List に表示されます。

ヒント Action List からアラート アクションを削除するには、そのアラート アクションを強調表

示し、Delete をクリックします。Edit をクリックして、既存のアラート アクションを編

集することもできます。

ステップ 19 Close をクリックします。

ステップ 20 User-defined email text ボックスに、電子メール メッセージに表示するテキストを入力します。

ステップ 21 Activate をクリックします。

追加情報

P.9-12 の「関連項目」を参照してください。
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カウンタの詳細表示

パフォーマンス カウンタの詳細を表示するには、RTMT Perfmon Monitoring ペインのパフォーマン

ス モニタ カウンタを詳細表示します。

手順

ステップ 1 次のいずれかの操作を実行します。

• RTMT Performance Monitoring ペイン内で、詳細表示するカウンタをダブルクリックします。カ

ウンタのボックスが強調表示され、Zoom ウィンドウが自動的に表示されます。

• RTMT Performance Monitoring ペイン内で、詳細表示するカウンタをクリックします。カウンタ

のボックスが強調表示されます。Perfmon > Zoom Chart の順に選択します。Zoom ウィンドウ

が自動的に表示されます。

カウンタのモニタリングが開始されてからの、カウンタの最小、最大、平均、および最新の値の

フィールドが表示されます。

ステップ 2 OK をクリックして、ウィンドウを閉じます。

追加情報

P.9-12 の「関連項目」を参照してください。
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カウンタの説明の表示

カウンタの説明を表示するには、次のどちらかの方法を使います。

手順

ステップ 1 次のいずれかの操作を実行します。

• Perfmon ツリー階層でプロパティ情報を表示するカウンタを右クリックし、Counter Description
を選択します。

• RTMT Performance Monitoring ペインでカウンタをクリックし、Perfmon > Counter Description
の順に選択します。

ヒント カウンタの説明を表示し、データサンプリング パラメータを設定するには、P.9-10 の「サ

ンプル データの設定」を参照してください。

Counter Property ウィンドウにカウンタの説明が表示されます。説明には、ホスト アドレス、カウ

ンタが属するオブジェクト、カウンタ名、カウンタの機能の要旨などがあります。

ステップ 2 OK ボタンをクリックして、Counter Property ウィンドウを閉じます。

追加情報

P.9-12 の「関連項目」を参照してください。
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サンプル データの設定

Counter Property ウィンドウには、カウンタのサンプル データを設定するためのオプションがあり

ます。RTMT Perfmon Monitoring ペインに表示されるパフォーマンス カウンタには、緑のドットが

あり、サンプル データがある期間存在していることを示します。収集するサンプル データの数と、

図に表示されるデータ ポイント数を設定できます。サンプル データを設定した後、View All 
Data/View Current Data メニュー オプションを使用して情報を表示します。P.9-11 の「カウンタ デー

タの表示」を参照してください。

ここでは、カウンタに対して収集するサンプル データの数を設定する方法を説明します。

手順

ステップ 1 P.9-2 の「パフォーマンス カウンタの表示」の説明に従って、カウンタを表示します。

ステップ 2 次のいずれかの操作を実行します。

• サンプル データ情報を収集するカウンタを右クリックし、図形式を使用している場合は 
Monitoring Properties を、表形式を使用している場合は Properties を選択します。

• サンプル データ情報を収集するカウンタをクリックし、Perfmon > Monitoring Properties の順

に選択します。

Counter Property ウィンドウに、カウンタの説明、およびサンプル データ設定用のタブが表示され

ます。説明には、ホスト アドレス、カウンタが属するオブジェクト、カウンタ名、カウンタの機能

の要旨などがあります。

ステップ 3 カウンタのサンプル データ数を設定するには、Data Sample タブをクリックします。

ステップ 4 No. of data samples ドロップダウン リスト ボックスから、サンプル数（100 ～ 1000）を選択します。

デフォルトは 100 です。

ステップ 5 No. of data points shown on chart ドロップダウン リスト ボックスから、図に表示するデータ ポイン

トの数（10 ～ 50）を選択します。デフォルトは 20 です。

ステップ 6 表 9-2 で説明されているパラメータのいずれかをクリックします。

ステップ 7 OK ボタンをクリックして、Counter Property ウィンドウを閉じ、RTMT Perfmon Monitoring ペイン

に戻ります。

追加情報

P.9-12 の「関連項目」を参照してください。

表 9-2 サンプル データ パラメータ

パラメータ 説明

Absolute 一部のカウンタ値は累積値なので（例：CallsAttempted や CallsCompleted）、
データの現在の状況を表示するには Absolute を選択します。 

Delta 現在のカウンタ値と直前のカウンタ値の差を表示するには、Delta を選択

します。 

% Delta カウンタのパフォーマンスの変化をパーセントで表示するには、% Delta
を選択します。
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カウンタ データの表示

パフォーマンス カウンタに関する収集データを表示するには、次の手順を実行します。 

手順

ステップ 1 RTMT Perfmon Monitoring ペイン内で、サンプル データを表示するカウンタの図を右クリックし、

View All Data を選択します。

サンプリングされたデータはカウンタの図にすべて表示されます。緑のドットは密に表示されるた

め、ほとんど実線のように見えます。

ステップ 2 現在表示されているカウンタを右クリックし、View Current を選択します。

最後に設定および収集されたサンプル データが、カウンタの図に表示されます。サンプル データ

の設定手順については、P.9-10 の「サンプル データの設定」を参照してください。

追加情報

P.9-12 の「関連項目」を参照してください。
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関連項目

• パフォーマンス カウンタの表示（P.9-2）

• RTMT Performance Monitoring ペインからのカウンタの削除（P.9-3）

• カウンタのアラート通知の設定（P.9-5）

• カウンタの詳細表示（P.9-8）

• カウンタの説明の表示（P.9-9）

• サンプル データの設定（P.9-10）

• カウンタ データの表示（P.9-11）
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10

RTMT のトレース収集とログ集中管理

Cisco Unified CallManager Real-Time Monitoring Tool（RTMT）の Trace and Log Central 機能を使用す

ると、特定の日付範囲または絶対時間におけるオンデマンドのトレース収集を設定できます。指定

した検索条件を含むトレース ファイルを収集して後で使用するためにトレース収集条件を保存し

たり、定期的なトレース収集をスケジュールしてトレース ファイルをネットワーク上の SFTP サー

バにダウンロードしたり、クラッシュ ダンプ ファイルを収集したりできます。ファイルを収集し

たら、Real-Time Monitoring Tool 内の適切なビューアにそのファイルを表示できます。

（注） RTMT から、指定されたノードのトレースに関するトレースの設定を編集することもできます。ト

レースの設定を使用可能にするとシステム パフォーマンスが低下します。このため、トラブル

シューティングを行う場合にだけトレースを使用可能にしてください。

（注） RTMT で Trace and Log Central 機能を使用するには、RTMT が Network Access Translation（NAT）を

使用せずにクラスタ内のすべてのノードに直接アクセスできることを確認する必要があります。デ

バイスにアクセスするように NAT を設定した場合は、IP アドレスではなくホスト名を使用して

Cisco Unified CallManager を設定し、ホスト名とそのルータブル IP アドレスが DNS サーバ内または

ホスト ファイル内にあることを確認します。

（注） 暗号化をサポートするデバイスの場合、SRTP 鍵関連情報はトレース ファイルに表示されません。 

この章は、次の項で構成されています。

• 証明書のインポート（P.10-2）

• RTMT の Trace & Log Central オプションの表示（P.10-3）

• トレースの収集（P.10-4）

• Query Wizard の使用（P.10-7）

• トレース収集のスケジュール（P.10-11）

• トレース収集状況の表示とスケジュールされた収集の削除（P.10-14）

• クラッシュ ダンプの収集（P.10-15）
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• Local Browse の使用（P.10-17）

• Remote Browse の使用（P.10-18）

• Q931 Translator の使用（P.10-20）

• QRT レポート情報の表示（P.10-22）

• Real Time Trace の使用（P.10-23）

• RTMT のトレース設定の更新（P.10-27）

証明書のインポート

クラスタ内のサーバごとに認証局が提供するサーバ認証証明書をインポートできます。Trace and
Log Central オプションを使用する前に、証明書をインポートすることをお勧めします。証明書をイ

ンポートしない場合、RTMT にログインして Trace and Log Central オプションを使用するたびに、ク

ラスタ内のノードごとのセキュリティ証明書が表示されます。証明書に表示されるデータは変更で

きません。 

証明書をインポートするには、Tools > Trace > Import Certificate の順に選択します。

サーバ証明書のインポートが完了したことを示すメッセージが表示されます。OK をクリックしま

す。
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RTMT の Trace & Log Central オプションの表示

開始する前に、P.10-2 の「証明書のインポート」の説明に従って、セキュリティ証明書がインポー

トされていることを確認します。

Trace & Log Central ツリー階層を表示するには、次のいずれかの操作を実行します。

• Quick Launch Channel で Tools タブをクリックし、Trace および Trace & Log Central アイコン

をクリックします。

• Tools > Trace > Open Trace & Log Central の順に選択します。

ヒント ツリー階層に表示される任意のオプションから、トレースする対象のサービス / アプリケーション

の指定、使用するログとサーバの指定、収集の時刻と日付のスケジュール、ファイルのダウンロー

ド機能の設定、zip ファイルの設定、および収集したトレース ファイルの削除を行うことができま

す。

Real-Time Monitoring Tool の Trace & Log Central オプションが表示されたら、次のいずれかの操作を

実行します。

• クラスタ内の 1 台以上のサーバについて、サービス、アプリケーション、システム ログのト

レースを収集します。P.10-4 の「トレースの収集」を参照してください。

• 指定した検索条件を含むトレース ファイルを収集してダウンロードし、トレース収集条件を後

で使用するために保存します。P.10-7 の「Query Wizard の使用」を参照してください。

• 定期的なトレース収集をスケジュールし、トレース ファイルをネットワーク上の SFTP サーバ

にダウンロードします。P.10-11 の「トレース収集のスケジュール」を参照してください。

• 1 台以上のサーバについて、クラッシュ ダンプ ファイルを収集します。P.10-15 の「クラッシュ

ダンプの収集」を参照してください。

• 収集したトレース ファイルを表示します。P.10-17 の「Local Browse の使用」を参照してくだ

さい。

• サーバ上のすべてのトレース ファイルを表示します。P.10-18 の「Remote Browse の使用」を参

照してください。

• アプリケーションごとに、サーバ上で現在書き込まれているトレース ファイルを表示します。

トレース ファイルに検索文字列が書き込まれた場合、指定した操作を実行できます。P.10-23 の

「Real Time Trace の使用」を参照してください。
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トレースの収集

Trace and Log Central 機能の Collect Traces オプションを使用すると、クラスタ内の 1 台以上のサー

バについて、サービス、アプリケーション、システム ログのトレースを収集できます。トレースを

収集する日時の範囲、トレース ファイルのダウンロード先のディレクトリ、サーバから収集した

ファイルを削除するかどうかなどを指定します。Trace and Log Central 機能を使用してトレースを収

集する手順は、次のとおりです。

（注） アクティブにしていないサービスも表示されるため、そのサービスのトレースを収集でき

ます。

指定した検索条件を含むトレース ファイルを収集する場合、または後で使用するために保存したト

レース収集条件を使用する場合は、P.10-7 の「Query Wizard の使用」を参照してください。

始める前に

次の 1 つ以上の操作を実行します。

• Trace Configuration ウィンドウで、さまざまなサービスのトレース ファイルに記載する情報を

設定します。 詳細については、P.5-1 の「トレースの設定」を参照してください。

• アラームをトレース ファイルに送信する場合は、Alarm Configuration ウィンドウで、アラーム

の宛先として SDI トレース ファイルまたは SDL トレース ファイルを選択します。 詳細につい

ては、P.3-1 の「アラームの設定」を参照してください。

手順

ステップ 1 P.10-3 の「RTMT の Trace & Log Central オプションの表示」の説明に従って、Trace & Log Central の
オプションを表示します。

ステップ 2 ツリー階層で、Collect Files をダブルクリックします。

Select CallManager Services/Applications タブが表示されます。

（注） クラスタ内に使用できないサーバがある場合は、使用できないサーバを特定するメッセー

ジがダイアログボックスに表示されます。使用できないサーバは、Trace & Log Central ウィ

ンドウには表示されません。

ステップ 3 次のいずれかの操作を実行します。

• クラスタ内のすべてのサーバ上の、すべてのサービスおよびアプリケーションのトレースを収

集するには、Select All Services on All Servers チェックボックスをオンにします。 

• 特定のサーバ上の、すべてのサービスおよびアプリケーションのトレースを収集するには、

サーバの IP アドレスの横にあるチェックボックスをオンにします。

• 特定のサーバ上の、特定のサービスまたはアプリケーションのトレースを収集する場合は、該

当するチェックボックスをオンにします。

• サービスまたはアプリケーションのトレースを収集せずにトレース収集ウィザードを続行す

る場合は、ステップ 4 に進みます。
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（注） アクティブにしていないサービスも表示されるため、そのサービスのトレースを収集できます。

（注） リストされている一部のサービス / アプリケーションは、クラスタ内の特定のノードにのみインス

トールできます。これらのサービス / アプリケーションのトレースを収集するには、サービス / ア
プリケーションをアクティブにしたサーバからトレースを収集することを確認します。 

ステップ 4 Next をクリックします。

System Logs タブが表示されます。

ステップ 5 次のいずれかの操作を実行します。

• クラスタ内のすべてのサーバ上の、すべてのシステム ログを収集する場合は、Select All Logs
on all Servers チェックボックスをオンにします。

• 特定のサーバ上の、すべてのシステム ログのトレースを収集する場合は、サーバの IP アドレ

スの横にあるチェックボックスをオンにします。

• 特定のサーバ上の、特定のシステム ログのトレースを収集する場合は、該当するチェックボッ

クスをオンにします。

• システム ログのトレースを収集せずにトレース収集ウィザードを続行する場合は、ステップ 6
に進みます。

ステップ 6 Next をクリックします。

ステップ 7 Collection Time グループ ボックスで、トレースを収集する時間範囲を指定します。次のいずれかの

オプションを選択します。

• Absolute Range：トレースを収集する対象のサーバの時間帯と時間範囲（開始日時と終了日時）

を指定します。

クライアント マシンの時間帯は、Select Reference Server Time Zone フィールドのデフォルト設

定値です。Daylight Savings 設定値を持つすべての時間帯の個別のエントリ セットとともに、す

べての標準時間帯が、Select Time Zone ドロップダウン リスト ボックスに表示されます。

選択した時間帯がサーバ（たとえば、Server 1）の時間帯設定と一致する場合は、その日付範囲

内（開始日付と終了日付の間）の修正されたトレース ファイルが収集されます。同じ

Cisco Unified CallManager クラスタ内に別のサーバ（Server 2）が存在し、そのサーバが別の時

間帯である場合、Server 2 の対応する日付範囲内の修正されたトレース ファイルが Server 2 か
ら収集されます。

トレースを収集する日付範囲を設定する場合は、From Date/Time フィールドと To Date/Time
フィールドでドロップダウン リストボックスを選択します。

• Relative Range：現在時刻から遡ってトレースを収集する時間を（分、時間、日、週、月のい

ずれかの単位で）指定します。 
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ステップ 8 Select Partition ドロップダウン リスト ボックスから、トレースを収集する対象のログを含むパー

ティションを選択します。

Cisco Unified CallManager Serviceability では、Cisco Unified CallManager の最大 2 つの Linux ベースの

バージョンについてログを保存します。Cisco Unified CallManager Serviceability は、ユーザがログイ

ンしているバージョンの Cisco Unified CallManager のログをアクティブなパーティションに保存

し、他のバージョンの Cisco Unified CallManager（インストールされている場合）のログをアクティ

ブでないディレクトリに保存します。

したがって、Linux プラットフォームで実行されている Cisco Unified CallManager の 1 つのバージョ

ンから別のバージョンにアップグレードし、Linux プラットフォームで実行されている新しいバー

ジョンの Cisco Unified CallManager にログインすると、Cisco Unified CallManager Serviceability は前

バージョンのログをアクティブでないパーティションに移動し、新しいバージョンのログをアク

ティブなパーティションに保存します。ユーザが古いバージョンの Cisco Unified CallManager にロ

グインすると、Cisco Unified CallManager Serviceability は新しいバージョンの Cisco Unified 
CallManager のログをアクティブでないパーティションに移動し、古いバージョンのログをアク

ティブなディレクトリに保存します。

（注） Cisco Unified CallManager Serviceability では、Windows プラットフォームで実行されている Cisco
Unified CallManager のバージョンのログは保存されません。

ステップ 9 トレース ファイルのダウンロード先ディレクトリを指定するには、Download File Directory フィー

ルドの横にある Browse ボタンをクリックし、該当するディレクトリに移動して Open をクリック

します。デフォルトでは、C:\Program Files\Cisco\CallManager Serviceability\jrtmt\< サーバ IP アドレ

ス >\< ダウンロード時刻 > が指定されます。

ステップ 10 収集するトレース ファイルの zip ファイルを作成するには、Zip File オプション ボタンを選択しま

す。トレース ファイルを zip 圧縮せずにダウンロードするには、Do Not Zip Files オプション ボタ

ンを選択します。

ステップ 11 サーバから収集したログ ファイルを削除するには、Delete Collected Log Files from the server チェッ

クボックスをオンにします。

ステップ 12 Finish をクリックします。

ウィンドウにトレース収集の進行状況が表示されます。トレース収集を中止する場合は、Cancel を
クリックします。

トレース収集プロセスが完了すると、ウィンドウの下部に「Completed downloading for node <IP ア
ドレス >」というメッセージが表示されます。

ステップ 13 収集したトレース ファイルを表示するには、トレース収集機能の Local Browse オプションを使用し

ます。詳細については、P.10-17 の「Local Browse の使用」を参照してください。

追加情報

P.10-27 の「関連項目」を参照してください。
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Query Wizard の使用

Trace Collection Query Wizard を使用すると、指定した検索条件を含むトレース ファイルを収集して

ダウンロードし、後で使用するためにトレース収集条件を保存することができます。Trace Collection
Query Wizard を使用するには、次の手順を実行します。

始める前に

次の 1 つ以上の操作を実行します。

• Trace Configuration ウィンドウで、さまざまなサービスのトレース ファイルに記載する情報を

設定します。詳細については、P.5-1 の「トレースの設定」を参照してください。 

• アラームをトレース ファイルに送信する場合は、Alarm Configuration ウィンドウで、アラーム

の宛先として SDI トレース ファイルまたは SDL トレース ファイルを選択します。 詳細につい

ては、P.3-1 の「アラームの設定」を参照してください。

手順

ステップ 1 P.10-3 の「RTMT の Trace & Log Central オプションの表示」の説明に従って、Trace & Log Central オ
プションを表示します。

ステップ 2 ツリー階層で、Query Wizard をダブルクリックします。

（注） クラスタ内に使用できないサーバがある場合は、使用できないサーバを特定するメッセー

ジがダイアログボックスに表示されます。使用できないサーバは、Trace & Log Central ウィ

ンドウには表示されません。

ステップ 3 開いたウィンドウで、次のオプション ボタンのいずれかをクリックします。

• Saved Query

Browse ボタンをクリックし、使用するクエリーに移動します。クエリーを選択し、Open をク

リックします。

Single Node Generic Query を選択した場合は、RTMT の接続先のノードが Browse ボタンの横に

チェックマーク付きで表示されます。追加のノードの横にチェックマークを入れると、該当す

るサーバに関するクエリーを実行できます。

All Node Generic Query を選択した場合は、すべてのノードが Browse ボタンの横にチェックマー

ク付きで表示されます。クエリーを実行する対象に含まれないサーバがある場合は、その

チェックマークを外すことができます。

Regular Query を選択した場合は、クエリーを保存するときに選択したすべてのノードがチェッ

クマーク付きで表示されます。リストに表示される任意のサーバについて、チェックを入れる

か外すことができます。新しいサーバを選択する場合は、ウィザードを使用してそのノードの

サービスを選択する必要があります。

変更せずにクエリーを実行するには、Run Query をクリックし、ステップ 17 に進みます。ク

エリーを変更するには、ステップ 4 に進みます。

• Create Query

ステップ 4 Next をクリックします。

Select Cisco CallManager Services/Applications タブが表示されます。
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ステップ 5 Saved Query オプション ボタンをクリックしてクエリーを選択した場合は、クエリーに指定した条

件が表示されます。 必要に応じて、トレースを収集する対象のサービス / アプリケーションのリス

トを変更します。Create Query オプション ボタンをクリックした場合は、トレースを収集するすべ

てのサービス / アプリケーションを選択する必要があります。

ヒント クラスタ内のすべてのサーバ上の、すべてのサービスおよびアプリケーションのトレー

スを収集するには、Select All Services on All Servers チェックボックスをオンにします。

特定のサーバ上の、すべてのサービスおよびアプリケーションのトレースを収集するに

は、サーバの IP アドレスの横にあるチェックボックスをオンにします。

（注） アクティブにしていないサービスも表示されるため、そのサービスのトレースを収集できます。

（注） リストされている一部のサービス / アプリケーションは、クラスタ内の特定のノードにのみインス

トールできます。これらのサービス / アプリケーションのトレースを収集するには、サービス / ア
プリケーションをアクティブにしたサーバからトレースを収集することを確認します。 

ステップ 6 Next をクリックします。

ステップ 7 Select System Logs タブで、該当するすべてのチェックボックスをチェックします。

ヒント クラスタ内のすべてのサーバ上の、すべてのサービスおよびアプリケーションのシステ

ム ログのトレースを収集するには、Select All Logs on All Servers チェックボックスをオ

ンにします。特定のサーバ上の、すべてのサービスおよびアプリケーションのトレース

を収集するには、サーバの IP アドレスの横にあるチェックボックスをオンにします。

ステップ 8 Next をクリックします。

ステップ 9 Collection Time グループ ボックスで、トレースを収集する時間範囲を指定します。次のいずれかの

オプションを選択します。

• All Available Traces：このオプションは、選択したサーバ上のサービスに関するすべてのトレー

スを収集する場合に選択します。

• Absolute Range：トレースを収集する対象のサーバの時間帯と時間範囲（開始日時と終了日時）

を指定します。

クライアント マシンの時間帯は、Select Reference Server Time Zone フィールドのデフォルト設

定値です。Daylight Savings 設定値を持つすべての時間帯の個別のエントリ セットとともに、す

べての標準時間帯が、Select Time Zone ドロップダウン リスト ボックスに表示されます。

選択した時間帯がサーバ（たとえば、Server 1）の時間帯設定と一致する場合は、その日付範囲

内（開始日付と終了日付の間）の修正されたトレース ファイルが収集されます。同じ Cisco
Unified CallManager クラスタ内に別のサーバ（Server 2）が存在し、そのサーバが別の時間帯で

ある場合、Server 2 の対応する日付範囲内の修正されたトレース ファイルが Server 2 から収集

されます。
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トレースを収集する日付範囲を設定する場合は、From Date/Time フィールドと To Date/Time
フィールドでドロップダウン リストボックスを選択します。

• Relative Range：現在時刻から遡ってトレースを収集する時間を（分、時間、日、週、月のい

ずれかの単位で）指定します。 

ステップ 10 トレース ファイルに含まれる単語や句で検索するには、Search String フィールドに該当する単語ま

たは句を入力します。このツールは、入力した単語または句への完全一致を検索します。

ステップ 11 Select Impact Level ドロップダウン リスト ボックスから、文字列検索アクティビティがコール処理

に与える影響のレベルを指定します。指定できるオプションには、Low、Medium、High がありま

す。Low を選択すると、コール処理への影響は最小になりますが、時間がかかります。High を選択

すると、コール処理への影響は最大になりますが、時間は短縮されます。

ステップ 12 次のいずれかのオプションを選択します。

• クエリーを実行する場合は、Run Query をクリックします。 

Query Results フォルダが表示されます。クエリーが完了すると、クエリーの実行が完了したこ

とを示すダイアログボックスが表示されます。OK をクリックし、ステップ 17 に進みます。

• クエリーを保存する場合は、Save Query ボタンをクリックし、ステップ 13 に進みます。

ステップ 13 作成するクエリー タイプの横のチェックボックスをオンにします。

• Generic Query：このオプションは、クエリーを作成したノード以外のノードで実行できるクエ

リーを作成する場合に選択します。Generic Query を作成できるのは、選択したサービスがシン

グル ノード上に存在する場合のみです。複数のノード上のサービスを選択すると、エラー メッ

セージが表示されます。この場合は、クエリーを Regular Query として保存するか、シングル

ノード上のサービスを選択します。 

次に、Single Node Query または All Node Query のいずれかのオプションを選択します。Single
Node Query を選択すると、トレース収集ツールは、クエリーを実行するときにデフォルトで、

クエリーを作成したサーバを選択します。All Node Query オプションを選択すると、トレース

収集ツールは、クエリーを実行するときにデフォルトで、クラスタ内のすべてのサーバを選択

します。 

（注） クエリーを実行する前に、デフォルト以外のサーバを選択できます。

• Regular Query：このオプションは、クエリーを作成したノードまたはクラスタ上でクエリーを

実行する場合にのみ選択します。

ステップ 14 Finish をクリックします。

ステップ 15 クエリーを保存する場所に移動し、File Name フィールドにクエリーの名前を入力し、Save をクリッ

クします。

ステップ 16 次のいずれかの操作を実行します。

• 保存したクエリーを実行する場合は、Run Query をクリックし、ステップ 17 に進みます。

• 作成したクエリーを実行せずに Query Wizard を終了する場合は、Cancel をクリックします。
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ステップ 17 クエリーの実行が完了したら、次の 1 つ以上の操作を実行します。

• 収集したファイルを表示する場合は、Query Results をダブルクリックし、<node> フォルダ

（<node> はウィザードで指定したサーバの IP アドレスまたはホスト名を表す）をダブルクリッ

クし、表示するファイルが含まれているフォルダをダブルクリックしてファイルに移動しま

す。ファイルの場所に移動したら、そのファイルをダブルクリックします。ファイル タイプに

対応した既定のビューアに、ファイルが表示されます。

（注） ファイルに Q931 メッセージが含まれる場合は、P.10-20 の「Q931 Translator の使用」に進み、Q931
メッセージを表示します。QRT Quality Report Tool（QRT）で生成されたレポートを表示する場合

は、P.10-22 の「QRT レポート情報の表示」を参照してください。

• トレース ファイルとクエリーで収集したトレース ファイルのリストを含む結果のファイルを

ダウンロードします。そのためには、ダウンロードするファイルを選択して Download をクリッ

クし、ダウンロードの条件を指定して Finish をクリックします。 

－ トレース ファイルと結果のファイルをダウンロードするディレクトリを指定する場合は、
Download all files フィールドの横にある Browse ボタンをクリックし、該当するディレクト
リを表示して Open をクリックします。デフォルトでは、C:\Program Files\Cisco\CallManager
Serviceability\jrtmt\< サーバ IP アドレス >\< ダウンロード時刻 > が指定されます。

－ 収集するトレース ファイルの zip ファイルを作成するには、Zip File チェックボックスを
オンにします。

－ サーバから収集したログ ファイルを削除する場合は、Delete Collected Log Files from Server
チェックボックスをオンにします。

ヒント トレース ファイルをダウンロードしたら、Trace and Log Central 機能の Local Browse オプ

ションを使用してそれらのファイルを表示できます。詳細については、P.10-17 の「Local
Browse の使用」を参照してください。

• クエリーを保存する場合は、Save Query をクリックし、ステップ 13 からステップ 15 を実行し

ます。

追加情報

P.10-27 の「関連項目」を参照してください。
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トレース収集のスケジュール

Trace and Log Central 機能の Schedule Collection オプションを使用すると、同時に最大 6 件の定期的

なトレース収集をスケジュールしたり、ネットワーク上の SFTP サーバにトレース ファイルをダウ

ンロードしたり、保存された別のクエリーを実行したり、syslog ファイルを作成したりできます。

スケジュールされた収集をシステムに入力した後で変更するには、そのスケジュールされた収集を

削除して新しい収集イベントを追加する必要があります。トレース収集をスケジュールするには、

次の手順を実行します。

（注） 最大 10 件のトレース収集をスケジュールできますが、同時に実行できるのは 6 件までです。つま

り、同時に実行中の状態にできるのは 6 件までです。

始める前に

次の 1 つ以上の操作を実行します。

• Trace Configuration ウィンドウで、さまざまなサービスのトレース ファイルに記載する情報を

設定します。 詳細については、P.5-1 の「トレースの設定」を参照してください。 

• アラームをトレース ファイルに送信する場合は、Alarm Configuration ウィンドウで、アラーム

の宛先として SDI トレース ファイルまたは SDL トレース ファイルを選択します。 詳細につい

ては、P.3-1 の「アラームの設定」を参照してください。

手順

ステップ 1 P.10-3 の「RTMT の Trace & Log Central オプションの表示」 の説明に従って、Trace & Log Central オ
プションを表示します。

ステップ 2 ツリー階層で、Schedule Collection をダブルクリックします。

Select CallManager Services/Applications タブが表示されます。

（注） クラスタ内に使用できないサーバがある場合は、使用できないサーバを特定するメッセー

ジがダイアログボックスに表示されます。使用できないサーバは、Trace & Log Central ウィ

ンドウには表示されません。

ステップ 3 次のいずれかの操作を実行します。

• クラスタ内のすべてのサーバ上の、すべてのサービスおよびアプリケーションのトレースを収

集するには、Select All Services on All Servers チェックボックスをオンにします。

• 特定のサーバ上の、すべてのサービスおよびアプリケーションのトレースを収集するには、

サーバの IP アドレスの横にあるチェックボックスをオンにします。

• 特定のサーバ上の、特定のサービスまたはアプリケーションのトレースを収集する場合は、該

当するチェックボックスをオンにします。

• サービスまたはアプリケーションのトレースを収集せずにトレース収集ウィザードを続行す

る場合は、ステップ 4 に進みます。

（注） アクティブにしていないサービスも表示されるため、そのサービスのトレースを収集できます。
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（注） リストされている一部のサービス / アプリケーションは、クラスタ内の特定のノードにのみインス

トールできます。これらのサービス / アプリケーションのトレースを収集するには、サービス / ア
プリケーションをアクティブにしたサーバからトレースを収集することを確認します。 

ステップ 4 Next をクリックします。

System Logs タブが表示されます。

ステップ 5 システム ログのトレースを収集するには、次のいずれかの操作を実行します。

• クラスタ内のすべてのサーバ上の、すべてのシステム ログを収集する場合は、Select All Logs
on all Servers チェックボックスをオンにします。

• 特定のサーバ上の、すべてのシステム ログのトレースを収集する場合は、サーバの IP アドレ

スの横にあるチェックボックスをオンにします。

• 特定のサーバ上の、特定のシステム ログのトレースを収集する場合は、該当するチェックボッ

クスをオンにします。

• システム ログのトレースを収集せずにトレース収集ウィザードを続行する場合は、ステップ 6
に進みます。

ステップ 6 Next をクリックします。

ステップ 7 トレースを収集する対象のサーバの時間帯と時間範囲を指定します。

クライアント マシンの時間帯は、Select Reference Server Time Zone フィールドのデフォルト設定値

です。Daylight Savings 設定値を持つすべての時間帯の個別のエントリ セットとともに、すべての

標準時間帯が、Select Time Zone ドロップダウン リスト ボックスに表示されます。

ステップ 8 トレース収集を開始する日時を指定するには、Schedule Start Date/Time フィールドの横にある下向

き矢印ボタンをクリックします。Date タブで、適切な日付を選択します。Time タブで、適切な時

刻を選択します。

ステップ 9 トレース収集を終了する日時を指定するには、Schedule End Date/Time フィールドの横にある下向き

矢印ボタンをクリックします。Date タブで、適切な日付を選択します。Time タブで、適切な時刻

を選択します。

（注） トレース収集は、設定した終了時刻を過ぎても完了しますが、Trace and Log Central 機能は

この収集をスケジュールから削除します。

ステップ 10 Scheduler Frequency ドロップダウン リスト ボックスから、設定されたトレース収集を実行する頻度

を選択します。 

ステップ 11 Collect Files generated in the last ドロップダウン リスト ボックスから、現在時刻から遡ってトレー

スを収集する時間を（分、時間、日、週、月のいずれかの単位で）指定します。

ステップ 12 トレース ファイルに含まれる単語や句で検索するには、Search String フィールドに該当する単語ま

たは句を入力します。このツールは、入力した単語または句への完全一致を検索し、検索条件に一

致するファイルのみを収集します。
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ステップ 13 収集するトレース ファイルの zip ファイルを作成するには、Zip File チェックボックスをオンにし

ます。

ステップ 14 サーバから収集したログ ファイルを削除するには、Delete Collected Log Files from the Server チェッ

クボックスをオンにします。

ステップ 15 次の 1 つ以上の操作を選択します。

• Download Files

• Run Another Query

• Generate Syslog

ステップ 16 次のいずれかの操作を実行します。

• Download Files または Run Another Query を選択した場合は、ステップ 17 に進みます。 

• Generate Syslog を選択した場合は、ステップ 19 に進みます。

ステップ 17 SFTP Server Parameters グループ ボックスで、Trace and Log Central 機能が結果をダウンロードする

サーバのクレデンシャルを入力し、Test Connection をクリックします。Trace and Log Central 機能

が SFTP サーバへの接続を検証したら、OK をクリックします。

（注） Download Directory Path フィールドに、Trace and Log Central 機能が収集ファイルを保存す

るためのディレクトリを指定します。トレース収集機能はデフォルトで、SFTP パラメータ

のフィールドに指定したユーザ ID を持つユーザのホーム ディレクトリ（/home/< ユーザ

>/Trace）に収集ファイルを保存します。

ステップ 18 Run Another Query オプションを選択した場合は、Browse ボタンをクリックして実行するクエリー

を選択し、OK をクリックします。

（注） Trace and Log Central 機能は、第 1 のクエリーの結果が生成された場合にのみ、指定さ

れたクエリーを実行します。

ステップ 19 Finish をクリックします。

スケジュールされたトレースが正常に追加されたことを示すメッセージが表示されます。 

（注） Real-Time Monitoring Tool が SFTP サーバにアクセスできない場合は、メッセージが表示されます。

入力した IP アドレス、ユーザ名、パスワードが正しいことを確認します。 

ステップ 20 OK をクリックします。
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ステップ 21 スケジュールされた収集のリストを表示するには、Quick Launch Channel の Job Status アイコンを

クリックします。

ヒント スケジュールされた収集を削除するには、収集イベントを選択し、Delete をクリックします。確認

メッセージが表示されます。OK をクリックします。

追加情報

P.10-27 の「関連項目」を参照してください。

トレース収集状況の表示とスケジュールされた収集の削除

トレース収集イベントの状況を表示し、スケジュールされたトレース収集を削除するには、次の手

順を実行します。

手順

ステップ 1 P.10-3 の「RTMT の Trace & Log Central オプションの表示」の説明に従って、Trace & Log Central オ
プションを表示します。

ステップ 2 Quick Launch Channel で、Job Status アイコンをクリックします。

ステップ 3 Select a Node ドロップダウン リスト ボックスから、トレース収集イベントを表示または削除する対

象のサーバを選択します。

スケジュールされたトレース収集のリストが表示されます。

ジョブ タイプには、Scheduled Job、OnDemand、RealTimeFileMon、RealTimeFileSearch があります。

状況には、Pending、Terminated、Running、Cancel、Terminated があります。

ステップ 4 スケジュールされた収集を削除するには、削除するイベントを選択し、Delete をクリックします。 

（注） 削除できるのは、状況が「Pending」または「Running」で、ジョブ タイプが「ScheduleTask」
のジョブのみです。

追加情報

P.10-27 の「関連項目」を参照してください。
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クラッシュ ダンプの収集

トレース ファイルのコア ダンプを収集するには、次の手順を実行します。

手順

ステップ 1 P.10-3 の「RTMT の Trace & Log Central オプションの表示」の説明に従って、Trace & Log Central ツ
リー階層を表示します。

ステップ 2 Collect Crash Dump をダブルクリックします。

（注） クラスタ内に使用できないサーバがある場合は、使用できないサーバを特定するメッセー

ジがダイアログボックスに表示されます。使用できないサーバは、Trace & Log Central ウィ

ンドウには表示されません。

ステップ 3 Select Core Files タブで、該当するサーバの Core Files チェックボックスをオンにします。

ステップ 4 Next をクリックします。

ステップ 5 Collection Time グループ ボックスで、トレースを収集する時間範囲を指定します。次のいずれかの

オプションを選択します。

• Absolute Range：トレースを収集する対象のサーバの時間帯と時間範囲（開始日時と終了日時）

を指定します。

クライアント マシンの時間帯は、Select Reference Server Time Zone フィールドのデフォルト設

定値です。Daylight Savings 設定値を持つすべての時間帯の個別のエントリ セットとともに、す

べての標準時間帯が、Select Time Zone ドロップダウン リスト ボックスに表示されます。

選択した時間帯がサーバ（たとえば、Server 1）の時間帯設定と一致する場合は、その日付範囲

内（開始日付と終了日付の間）の修正されたクラッシュ ファイルが収集されます。同じ

Cisco Unified CallManager クラスタ内に別のサーバ（Server 2）が存在するが、そのサーバが別

の時間帯である場合、Server 2 の対応する日付範囲内の修正されたクラッシュ ファイルが

Server 2 から収集されます。

クラッシュ ファイルを収集する日付範囲を設定する場合は、From Date/Time フィールドと To
Date/Time フィールドでドロップダウン リストボックスを選択します。

• Relative Range：現在時刻から遡ってクラッシュ ファイルを収集する時間を（分、時間、日、

週、月のいずれかの単位で）指定します。

ステップ 6 Select Partition ドロップダウン リスト ボックスから、トレースを収集する対象のログを含むパー

ティションを選択します。

Cisco Unified CallManager Serviceability では、Cisco Unified CallManager の最大 2 つの Linux ベースの

バージョンについてログを保存します。Cisco Unified CallManager Serviceability は、ユーザがログイ

ンしているバージョンの Cisco Unified CallManager のログをアクティブなパーティションに保存

し、他のバージョンの Cisco Unified CallManager（インストールされている場合）のログをアクティ

ブでないディレクトリに保存します。
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したがって、Linux プラットフォームで実行されている Cisco Unified CallManager の 1 つのバージョ

ンから別のバージョンにアップグレードし、Linux プラットフォームで実行されている新しいバー

ジョンの Cisco Unified CallManager にログインすると、Cisco Unified CallManager Serviceability は前

バージョンのログをアクティブでないパーティションに移動し、新しいバージョンのログをアク

ティブなパーティションに保存します。ユーザが古いバージョンの Cisco Unified CallManager にロ

グインすると、Cisco Unified CallManager Serviceability は新しいバージョンの Cisco Unified 
CallManager のログをアクティブでないパーティションに移動し、古いバージョンのログをアク

ティブなディレクトリに保存します。

（注） Cisco Unified CallManager Serviceability では、Windows プラットフォームで実行されている Cisco
Unified CallManager のバージョンのログは保存されません。

ステップ 7 トレース ファイルのダウンロード先ディレクトリを指定するには、Download File Directory フィー

ルドの横にある Browse ボタンをクリックし、該当するディレクトリに移動して Open をクリック

します。デフォルトでは、C:\Program Files\Cisco\CallManager Serviceability\jrtmt\< サーバ IP アドレ

ス >\< ダウンロード時刻 > が指定されます。

ステップ 8 収集するクラッシュ ダンプ ファイルの zip ファイルを作成するには、Zip File オプション ボタンを

選択します。クラッシュ ダンプ ファイルを zip 圧縮せずにダウンロードするには、Do Not Zip Files
オプション ボタンを選択します。

（注） クラッシュ ダンプの zip ファイルが 2 ギガバイトを超える場合、そのファイルはダウンロー

ドできません。 

ステップ 9 収集されたクラッシュ ダンプ ファイルを削除するには、Delete Collected Log Files from Server
チェックボックスをオンにします。

ステップ 10 Finish をクリックします。

コア ダンプを収集しようとしていることを示すメッセージが表示されます。Yes をクリックして続

行します。

（注） Zip File オプション ボタンを選択し、クラッシュ ダンプ ファイルが 2 ギガバイトを超えた

場合、Zip File オプション ボタンを選択した状態ではこのサイズのクラッシュ ダンプ ファ

イルを収集できないことを示すメッセージが表示されます。 Do Not Zip Files オプション ボ
タンを選択してから、もう一度収集してください。

追加情報

P.10-27 の「関連項目」を参照してください。
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Local Browse の使用

トレース ファイルを収集して PC にダウンロードしたら、UNIX 系の行末記号を処理できる 
WordPad のようなテキスト エディタを使用して、PC 上でトレース ファイルを表示できます。

Real-Time Monitoring Tool 内のビューアで表示することもできます。

Trace and Log Central 機能で収集したログ ファイルを表示するには、次の手順を実行します。トレー

ス ファイルを PC にダウンロードするときに zip 圧縮した場合は、これを解凍してから Real-Time
Monitoring Tool 内のビューアで表示する必要があります。

始める前に

次のいずれかの項の説明に従って、トレース ファイルを収集します。

• トレースの収集（P.10-4）

• Query Wizard の使用（P.10-7）

• トレース収集のスケジュール（P.10-11）

手順

ステップ 1 P.10-3 の「RTMT の Trace & Log Central オプションの表示」の説明に従って、Trace & Log Central オ
プションを表示します。

ステップ 2 Local Browse をダブルクリックします。

ステップ 3 ログ ファイルを保存したディレクトリをブラウズし、表示するファイルを選択します。

ステップ 4 結果を表示するには、ファイルをダブルクリックするか、Finish をクリックします。

Real-Time Monitoring Tool では、ファイル タイプに対応したビューアでファイルが表示されます。

他に適切なビューアがない場合は、Generic Log Viewer でファイルが開きます。QRT Viewer の使用

方法の詳細については、P.10-22 の「QRT レポート情報の表示」を参照してください。QRT Translator
の詳細については、P.10-20 の「Q931 Translator の使用」を参照してください。

追加情報

P.10-27 の「関連項目」を参照してください。
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Remote Browse の使用

システムがトレース ファイルを生成したら、サーバで Real-Time Monitoring Tool 内のビューアにそ

のファイルを表示できます。Remote Browse 機能を使用して、トレースを PC にダウンロードする

こともできます。

Trace and Log Central 機能でサーバ上のログ ファイルを表示またはダウンロードするには、次の手

順を実行します。 

始める前に

次のいずれかの項の説明に従って、トレース ファイルを収集します。

• トレースの収集（P.10-4）

• Query Wizard の使用（P.10-7）

• トレース収集のスケジュール（P.10-11）

手順

ステップ 1 P.10-3 の「RTMT の Trace & Log Central オプションの表示」の説明に従って、Trace & Log Central オ
プションを表示します。

ステップ 2 Remote Browse をダブルクリックします。

ステップ 3 適切なオプション ボタンを選択し、Next をクリックします。Trace Files を選択する場合は、ステッ

プ 4 に進みます。Crash Dump を選択する場合は、ステップ 8 に進みます。

ステップ 4 次のいずれかの操作を実行します。

• クラスタ内のすべてのサーバ上の、すべてのサービスおよびアプリケーションのトレースを選

択する場合は、Select All Services on All Servers チェックボックスをオンにします。 

• 特定のサーバ上のすべてのサービスおよびアプリケーションのトレースを選択する場合は、

サーバの IP アドレスの横にあるチェックボックスをオンにします。

• 特定のサーバ上の、特定のサービスまたはアプリケーションのトレースを選択する場合は、該

当するチェックボックスをオンにします。

• サービスまたはアプリケーションのトレースを選択せずにリモート ブラウズ ウィザードを続

行する場合は、ステップ 5 に進みます。

（注） アクティブにしていないサービスも表示されるため、そのサービスのトレースを選択できます。

（注） リストされている一部のサービス / アプリケーションは、クラスタ内の特定のノードにのみインス

トールできます。これらのサービス / アプリケーションのトレースを選択するには、サービス / ア
プリケーションをアクティブにしたサーバからトレースを選択することを確認します。 

ステップ 5 Next をクリックします。

System Logs タブが表示されます。
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ステップ 6 次のいずれかの操作を実行します。

• クラスタ内のすべてのサーバ上の、すべてのサービスおよびアプリケーションのシステム ログ

を選択する場合は、Select All Logs on all Servers チェックボックスをオンにします。

• 特定のサーバ上の、すべてのシステム ログのトレースを選択する場合は、サーバの IP アドレ

スの横にあるチェックボックスをオンにします。

• 特定のサーバ上の、特定のシステム ログのトレースを選択する場合は、該当するチェックボッ

クスをオンにします。

• システム ログのトレースを収集せずにリモート ブラウズ ウィザードを続行する場合は、ス

テップ 9 に進みます。

ステップ 7 ステップ 9 に進みます。

ステップ 8 次のいずれかの操作を実行します。

• クラスタ内のすべてのサーバ上の、すべてのサービスおよびアプリケーションのクラッシュ ダ
ンプ ファイルを選択する場合は、Select All Services on All Servers チェックボックスをオンに

します。 

• 特定のサーバ上のすべてのサービスおよびアプリケーションのクラッシュ ダンプ ファイルを

選択する場合は、サーバの IP アドレスの横にあるチェックボックスをオンにします。

• 特定のサーバ上の特定のサービスまたはアプリケーションのクラッシュ ダンプ ファイルを選

択する場合は、該当するチェックボックスをオンにします。

ステップ 9 Finish をクリックします。

トレースが使用可能な場合は、メッセージが表示されます。OK をクリックします。

ステップ 10 次のいずれかの操作を実行します。

• 結果を表示する場合は、ファイルをダブルクリックするか、Finish をクリックします。

Real-Time Monitoring Tool では、ファイル タイプに対応したビューアでファイルが表示されま

す。他に適切なビューアがない場合は、Generic Log Viewer でファイルが開きます。QRT Viewer
の使用方法の詳細については、P.10-22 の「QRT レポート情報の表示」を参照してください。

QRT Translator の詳細については、P.10-20 の「Q931 Translator の使用」を参照してください。

• トレース ファイルをダウンロードします。そのためには、ダウンロードするファイルを選択し

て Download をクリックし、ダウンロードの条件を指定して Finish をクリックします。 

－ トレース ファイルをダウンロードするディレクトリを指定する場合は、Download all files
フィールドの横にある Browse ボタンをクリックし、該当するディレクトリを表示して
Open をクリックします。デフォルトでは、C:\Program Files\Cisco\CallManager Serviceability\
jrtmt\< サーバ IP アドレス >\< ダウンロード時刻 > が指定されます。

－ 収集するトレース ファイルの zip ファイルを作成するには、Zip File チェックボックスを
オンにします。

－ サーバから収集したログ ファイルを削除する場合は、Delete Files on server チェックボッ
クスをオンにします。

ヒント トレース ファイルをダウンロードしたら、Trace and Log Central 機能の Local Browse オプ

ションを使用してそれらのファイルを表示できます。詳細については、P.10-17 の「Local
Browse の使用」を参照してください。
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追加情報

P.10-27 の「関連項目」を参照してください。

Q931 Translator の使用

Cisco Unified CallManager では、ISDN トレース ファイルを生成し、Cisco CallManager インストレー

ションの接続に関する問題の診断とトラブルシューティングに役立てています。このログ ファイル

には、Q.931 タイプのメッセージ（ISDN レイヤ 3 プロトコル）が収集されています。

メッセージ変換の機能は、Cisco Unified CallManager SDI ログ ファイルからの入力データをフィル

タリングし、構文解析して Cisco IOS と同等のメッセージに変換することです。メッセージ変換プ

ログラムでは、XML とテキスト ファイルをサポートしています。 

シスコ サポート エンジニアは、メッセージ変換ツールを使用して、お客様から寄せられたデバッ

グ情報を Cisco IOS と同等の分かりやすいメッセージに変換します。

始める前に

次のいずれかの項の説明に従って、トレース ファイルを収集します。

• トレースの収集（P.10-4）

• Query Wizard の使用（P.10-7）

• トレース収集のスケジュール（P.10-11）

手順

ステップ 1 P.10-7 の「Query Wizard の使用」で説明する Query Wizard を使用するか、P.10-17 の「Local Browse
の使用」で説明する Trace and Log Central 機能の Local Browse オプションを使用して、ログ ファイ

ル エントリを表示します。

（注） CTIManager および Cisco CallManager SDI トレース ファイルには、Q931 メッセージを含め

ることができます。

ステップ 2 Q931 メッセージの変換を行うログ エントリをクリックします。

ステップ 3 Translate Q931 Messages をクリックします。

選択したトレース ファイルに ISDN メッセージがない場合、「No ISDN Messages in the File」という

メッセージが表示されます。

選択したトレース ファイルに ISDN メッセージが含まれる場合、Q931 Translator ダイアログボック

スには、メッセージのリストが表示されます。
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ステップ 4 次のいずれかの操作を実行します。

• 特定のメッセージの詳細を表示する場合は、リストからそのメッセージを選択します。Detailed
Message グループ ボックスに詳細が表示されます。

• 結果をフィルタリングする場合は、リストから Q931 メッセージを選択し、ドロップダウン リ
スト ボックスからオプション（filter by gateway など）を選択するか、Filter by Search String
フィールドにテキストを入力します。フィルタを削除する場合は、Clear Filter をクリックしま

す。フィルタを削除すると、すべてのログが表示されます。

• Q931 Translator ダイアログボックスを閉じる場合は、Close ボタンをクリックします。

追加情報

P.10-27 の「関連項目」を参照してください。
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QRT レポート情報の表示

QRT Viewer を使用すると、Quality Report Tool（QRT）によって生成された IP Phone Problem レポー

トを表示できます。QRT は、Cisco Unified CallManager IP Phone に関する音声品質および一般問題

のレポート ツールです。QRT Viewer を使用すると、生成された IP Phone Problem レポートのフィ

ルタリング、フォーマット、および表示を実行できます。QRT Viewer を使用して Cisco Unified 
CallManager IP Phone Problem レポートを一覧表示するには、次の手順を実行します。QRT の設定お

よび使用方法については、『Cisco Unified CallManager 機能およびサービス ガイド』を参照してくだ

さい。 

始める前に

次のいずれかの項の説明に従って、トレース ファイルを収集します。

• トレースの収集（P.10-4）

• Query Wizard の使用（P.10-7）

• トレース収集のスケジュール（P.10-11）

手順

ステップ 1 P.10-7 の「Query Wizard の使用」で説明する Query Wizard を使用するか、P.10-17 の「Local Browse
の使用」で説明する Trace and Log Central 機能の Local Browse オプションを使用して、ログ ファイ

ル エントリを表示します。

QRT Viewer ウィンドウが表示されます。

（注） QRT 情報は、Cisco Extended Functions サービスによるログ ファイルにのみ含まれています。

QRT データを含むログ ファイル名の形式は、qrtXXX.xml です。

ステップ 2 Extension ドロップダウン リスト ボックスから、レポートに含める内線（複数可）を選択します。

ステップ 3 Device ドロップダウン リスト ボックスから、レポートに含めるデバイス（複数可）を選択します。

ステップ 4 Category ドロップダウン リスト ボックスから、レポートに含める問題カテゴリを選択します。

ステップ 5 List of Fields ドロップダウン リスト ボックスから、レポートに含めるフィールドを選択します。

（注） ここでフィールドを選択した順序で、QRT Report Result ペインにフィールドが表示されま

す。

ステップ 6 QRT Report Result ペインにレポートを表示するには、Display Records をクリックします。
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Real Time Trace の使用

RTMT の Trace and Log Central 機能の Real Time Trace オプションを使用すると、アプリケーション

ごとに、サーバ上で現在書き込まれているトレース ファイルを表示できます。システムがトレース

ファイルへの書き込みを開始すると、リアルタイム トレースはトレース ファイルの先頭からでは

なく、モニタリングを開始したポイントからこのファイルの読み取りを開始します。以前の内容を

読み取ることはできません。

リアルタイム トレースには、次のオプションがあります。

• View Real Time Data（P.10-23）

• Monitor User Event（P.10-24）

View Real Time Data
Trace and Log Central 機能の View Real Time Data オプションを使用すると、システムがデータを書

き込むとおりにトレース ファイルを表示できます。Generic Log Viewer には、最大 10 個のサービス

のリアルタイム トレース データを表示できます。シングル ノードについては 5 つのサービスまで

です。ログ ビューアは 5 秒ごとに更新されます。トレースが新しいファイルに切り替わると、Generic
Log Viewer はその内容をビューアに追加します。 

（注） サービスが書き込むトレースの頻度によっては、View Real Time Data オプションを選択した場合

に、Generic Log Viewer にデータを表示できるようになるまで遅延が発生することがあります。 

手順

ステップ 1 P.10-3 の「RTMT の Trace & Log Central オプションの表示」の説明に従って、Trace & Log Central ツ
リー階層を表示します。

ステップ 2 Real Time Trace をダブルクリックします。

（注） クラスタ内に使用できないサーバがある場合は、使用できないサーバを特定するメッセー

ジがダイアログボックスに表示されます。使用できないサーバは、Trace & Log Central ウィ

ンドウには表示されません。

ステップ 3 View Real Time Data をダブルクリックします。

Real Time Data ウィザードが表示されます。

ステップ 4 Nodes ドロップダウン リスト ボックスから、リアルタイム データを表示する対象のノードを選択

し、Next をクリックします。
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ステップ 5 リアルタイム データを表示する対象のサービスとトレース ファイル タイプを選択し、Finish をク

リックします。

（注） アクティブにしていないサービスも表示されるため、そのサービスのトレースを収集できます。

選択したサービスのリアルタイム データが Generic Log Viewer に表示されます。

ステップ 6 カーソルをウィンドウの末尾に固定し、新しいトレースが生成されたときにそのトレースを表示す

る場合は、Show New Data チェックボックスをオンにします。新しいトレースが表示されるときに

カーソルをウィンドウの最下部に移動しない場合は、Show New Data チェックボックスをオフにし

ます。

ステップ 7 その他のサービスについても、この手順を繰り返します。最大 10 個のサービスのデータを表示で

きます。ただし、シングル ノードについては 5 つのサービスまでです。データを表示する対象の

サービスが多すぎる場合、またはシングル ノード上のサービスが多すぎる場合は、メッセージが表

示されます。

ステップ 8 リアルタイム データの表示を完了する場合は、Generic Log Viewer で Close をクリックします。

追加情報

P.10-27 の「関連項目」を参照してください。

Monitor User Event
Trace and Log Central 機能の Monitor User Event オプションを使用すると、リアルタイム トレース

ファイルがモニタされ、トレース ファイル内に検索文字列が見つかったときに指定された操作が実

行されます。システムは、トレース ファイルを 5 秒ごとにポーリングします。ポーリング間隔内に

検索文字列が複数回発生しても、システムが操作を実行するのは 1 回だけです。イベントごとに、

1 つのノード上の 1 つのサービスをモニタできます。

始める前に

モニタ対象のトレース ファイル内に指定の検索文字列があるときにアラームを生成する場合は、

TraceCollectionToolEvent アラートを有効にします。アラート有効化の詳細については、P.8-4 の「ア

ラート プロパティの設定」を参照してください。

手順

ステップ 1 P.10-3 の「RTMT の Trace & Log Central オプションの表示」の説明に従って、Trace & Log Central ツ
リー階層を表示します。

ステップ 2 Real Time Trace をダブルクリックします。

（注） クラスタ内に使用できないサーバがある場合は、使用できないサーバを特定するメッセー

ジがダイアログボックスに表示されます。使用できないサーバは、Trace & Log Central ウィ

ンドウには表示されません。
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ステップ 3 Monitor User Event をダブルクリックします。

Monitor User Event ウィザードが表示されます。

ステップ 4 次のいずれかの操作を実行します。

• すでに設定されているモニタリング イベントを表示する場合は、View Configured Events オプ

ション ボタンを選択し、ドロップダウン リスト ボックスからサーバを選択し、Finish をクリッ

クします。 

選択したサーバ用に設定されたイベントが表示されます。 

（注） イベントを削除する場合は、イベントを選択し、Delete をクリックします。

• 新しいモニタリング イベントを設定する場合は、Create Events オプション ボタンを選択し、

Next をクリックして ステップ 5 に進みます。

ステップ 5 Nodes ドロップダウン リスト ボックスから、システムがモニタするノードを選択し、Next をクリッ

クします。

ステップ 6 システムがモニタするサービスとトレース ファイル タイプを選択し、Next をクリックします。 

（注） アクティブにしていないサービスも表示されるため、そのサービスのトレースを収集できます。

ステップ 7 Search String フィールドに、トレース ファイル内でシステムが検索する単語または句を指定しま

す。このツールは、入力した単語または句への完全一致を検索します。

ステップ 8 システムがトレース ファイルをモニタする対象のサーバの、時間帯と時間範囲（開始日時と終了日

時）を指定します。

クライアント マシンの時間帯は、Select Reference Server Time Zone フィールドのデフォルト設定値

です。Daylight Savings 設定値を持つすべての時間帯の個別のエントリ セットとともに、すべての

標準時間帯が、Select Time Zone ドロップダウン リスト ボックスに表示されます。

選択した時間帯がサーバ（たとえば、Server 1）の時間帯設定と一致する場合は、その日付範囲内

（開始日付と終了日付の間）の修正されたトレース ファイルがモニタされます。同じ Cisco Unified
CallManager クラスタ内に別のサーバ（Server 2）が存在し、そのサーバが別の時間帯である場合、

Server 2 の対応する日付範囲内の修正されたトレース ファイルが Server 2 からモニタされます。

トレースをモニタする日付範囲を設定するには、From Date/Time フィールドと To Date/Time フィー

ルドでドロップダウン リストボックスを選択します。

ステップ 9 Search String フィールドに指定した検索文字列が見つかった場合にシステムが実行する操作とし

て、次の 1 つ以上の操作を選択します。

• Alert：このオプションは、指定した検索文字列が見つかったときにアラームを生成する場合に

選択します。システムがアラームを生成するには、TraceCollectionToolEvent アラートを有効に

する必要があります。アラート有効化の詳細については、P.8-4 の「アラート プロパティの設

定」を参照してください。
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• Local Syslog：このオプションは、システムがアプリケーション ログ領域のエラーを SysLog
Viewer に記録する場合に選択します。システムは、アラームと推奨処置に関する説明を記録し

ます。SysLog Viewer には、RTMT からアクセスできます。 

• Remote Syslog：このオプションは、システムが syslog メッセージを syslog サーバに保存するの

を可能にする場合に選択します。Server Name フィールドに、syslog サーバ名を指定します。 

• Download File：このオプションは、指定した検索文字列を含むトレース ファイルをダウンロー

ドする場合に選択します。SFTP Server Parameters グループ ボックスに、トレース ファイルを

ダウンロードするサーバのサーバ クレデンシャルを入力し、Test Connection をクリックしま

す。Trace and Log Central 機能が SFTP サーバへの接続を検証したら、OK をクリックします。

（注） Download Directory Path フィールドには、Trace and Log Central 機能が収集ファイルを保

存するためのディレクトリを指定します。トレース収集機能はデフォルトで、SFTP パ
ラメータのフィールドに指定したユーザ ID を持つユーザのホーム ディレクトリ

（/home/< ユーザ >/Trace）に収集ファイルを保存します。

（注） システムはトレース ファイルを 5 秒ごとにポーリングし、検索文字列が見つかった場合は

指定された操作を実行します。ポーリング間隔内に検索文字列が複数回発生しても、シス

テムが操作を実行するのは 1 回だけです。 

ステップ 10 Finish をクリックします。

追加情報

P.10-27 の「関連項目」を参照してください。
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RTMT のトレース設定の更新

Real-Time Monitoring プラグインのトレース設定を編集するには、Edit > Trace Settings の順に選択

し、該当するオプション ボタンをクリックします。システムにより、rtmt.log ファイルが、RTMT
プラグインがインストールされているログ ディレクトリ

（たとえば C:\Program Files\Cisco\CallManager Serviceability\jrtmt\log）に保存されます。 

ヒント Error オプション ボタンはデフォルト設定です。

追加情報

P.10-27 の「関連項目」を参照してください。

関連項目

• Query Wizard の使用（P.10-7）

• Local Browse の使用（P.10-17）

• トレースの収集（P.10-4）

• トレース収集のスケジュール（P.10-11）

• RTMT の Trace & Log Central オプションの表示（P.10-3）

• クラッシュ ダンプの収集（P.10-15）

• Local Browse の使用（P.10-17）

• トレースの設定（P.5-1）

• RTMT でのアラート設定（P.8-1）

• 『Cisco Unified CallManager Serviceability システム ガイド』の「トレース」
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RTMT SysLog Viewer の使用

SysLog Viewer にメッセージを表示するには、次の手順を実行します。

手順

ステップ 1 次のいずれかの操作を実行します。

• Quick Launch Channel で Tools タブをクリックし、SysLog Viewer および SysLog Viewer アイコ

ンをクリックします。

• Tools > SysLog Viewer > Open SysLog Viewer の順に選択します。

ステップ 2 Select a Node ドロップダウン リスト ボックスから、表示するログが保存されているサーバを選択し

ます。

ステップ 3 表示するログのタブをクリックします。

ステップ 4 ログが表示されてから、ログ アイコンをダブルクリックし、同じウィンドウにファイル名のリスト

を表示します。

ステップ 5 ウィンドウの下部にファイルの内容を表示するには、ファイル名をクリックします。

ステップ 6 表示するエントリをクリックします。 

ステップ 7 syslog メッセージ全体を表示するには、syslog メッセージをダブルクリックします。表 11-1 で説明

するボタンを使用して、syslog メッセージを表示することもできます。

ヒント 列の幅を広くしたり狭くしたりするには、列見出しの間にカーソルを置いたときに表示

される矢印をドラッグします。

ヒント 列見出しをクリックすると、メッセージをソートできます。最初に列見出しをクリック

すると、レコードは昇順に表示されます。小さな上向きの三角は、昇順であることを示

しています。列見出しをもう一度クリックすると、レコードは降順に表示されます。小

さな下向きの三角は、降順であることを示しています。列見出しをさらにもう一度クリッ

クすると、レコードはソートされていない状態で表示されます。
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ヒント Filter By ドロップダウン リスト ボックスのオプションを選択すると、結果をフィルタで

きます。フィルタを削除するには、Clear Filter をクリックします。フィルタを削除する

と、すべてのログが表示されます。

追加情報

P.11-2 の「関連項目」を参照してください。

関連項目

• Real-Time Monitoring の設定（P.7-1）

• 『Cisco Unified CallManager Serviceability システム ガイド』の「Real-Time Monitoring Tool」

表 11-1 Syslog Viewer のボタン

ボタン 機能

Refresh Syslog Viewer に表示されている現在のログの内容を更新します。

ヒント Auto Refresh ボタンをチェックすると、Syslog Viewer で syslog 
メッセージの自動更新が有効になります。

Clear 現在のログの表示をクリアします。 

Filter 選択する一連のオプションに基づいて、表示するメッセージを制限しま

す。

Clear Filter 表示するメッセージのタイプを制限するフィルタを削除します。

Find 現在のログに含まれる特定の文字列を検索できます。

Save 現在選択しているログを PC に保存します。
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プラグインの使用

Voice Log Translator（VLT）アプリケーションなどのアプリケーション プラグインをインストール

すると、RTMT の機能を拡張できます。RTMT ビューアの最新のプラグインは、Cisco.com からダ

ウンロードできます。プラグインをインストールした後は、RTMT ビューアからアプリケーション

にアクセスできます。

プラグインをダウンロードするには、次の手順を実行します。

手順

ステップ 1 Application > CCO Webpage の順に選択します。

ステップ 2 Login Prompt が表示されます。Cisco.com のユーザ名とパスワードを入力し、OK をクリックします。

ステップ 3 ファイルを PC にダウンロードします。

ステップ 4 インストールを開始するには、ダウンロードするファイルをダブルクリックします。 

ステップ 5 インストールの指示に従います。

プラグインにアクセスするには、次の手順を実行します。

手順

ステップ 1 次のいずれかの操作を実行します。

• Quick Launch Channel で、Tools タブ、Plugins タブの順にクリックし、目的のアプリケーショ

ンのアイコンをクリックします。

• Tools > Plugin から、起動するプラグインを選択します。

プラグイン ウィンドウにアプリケーションが表示されます。

使用方法については、アプリケーションのマニュアルを参照してください。
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関連項目

Cisco Voice Log Translator の詳細については、『Cisco Voice Log Translator User Guide』を参照してく

ださい。
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Log Partition Monitoring の設定

Log Partition Monitoring は、設定済みの次のしきい値を使用して、1 台のサーバ（またはクラスタ内

のすべてのサーバ）上のログ パーティションのディスク使用状況を 5 分ごとにモニタします。

• LogPartitionLowWaterMarkExceeded（ディスク使用率 %）：ディスク使用率が指定のパーセンテー

ジを超えると、LPM はすべてのアラーム メッセージを syslog に送信し、RTMT Alert Central に
アラートを送信します。ログ ファイルを保存し、ディスク スペースを回復するには、RTMT の
trace and log central オプションを使用できます。

• LogPartitionHighWaterMarkExceeded（ディスク使用率 %）：ディスク使用率が指定のパーセン

テージを超えると、LPM はすべてのアラーム メッセージを syslog に送信し、RTMT Alert Central
にアラートを送信します。
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Log Partition Monitoring の有効化

Log Partition Monitoring を有効にするには、次の手順を実行します。

手順

ステップ 1 Cisco Unified CallManager Serviceability で、Tools > Control Center - Network Services の順に選択し

ます。

ステップ 2 Server ドロップダウン リスト ボックスから、ディスク使用状況をモニタする対象のサーバを選択

します。

ステップ 3 CM Services の下で、Cisco Log Partition Monitoring Tool（LPM）の状況を確認します。

ステップ 4 LPM が実行されていない場合は、Cisco LPM の横のオプション ボタンをクリックし、Start ボタン

をクリックします。

Log Partition Monitoring の設定

Log Partitioning Monitoring を設定するには、Alert Central で、LogPartitionLowWaterMarkExceeded ア
ラートおよび LogPartitionHighWaterMarkExceeded アラートのアラート プロパティを設定します。

P.8-4 の「アラート プロパティの設定」を参照してください。

追加情報

P.13-2 の「関連項目」を参照してください。

関連項目

• 『Cisco Unified CallManager Serviceability システム ガイド』の「Log Partition Monitoring」

• RTMT でのアラート設定（P.8-1）

• RTMT のトレース収集とログ集中管理（P.10-1）
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CDR Repository Manager の設定

CDR Management ウィンドウでは、Call Detail Record（CDR; コール詳細レコード）ファイルと Call
Management Record（CMR; コール管理レコード）ファイルに割り当てるディスク スペースの容量を

設定し、削除するまでファイルを保存する日数を設定し、さらに CDR の宛先として最大 3 つの課

金アプリケーション サーバを設定します。CDR Repository Manager サービスは、CDR Management
ウィンドウで設定した課金アプリケーション サーバに対して CDR および CMR ファイルの送信を

繰り返し試行します。この試行は、ファイルが正常に送信されるか、CDR Management ウィンドウ

で課金アプリケーション サーバを変更または削除するか、ファイルの保存期間が経過してファイル

が削除されるまで続きます。 

デフォルトでは、Cisco CDR Repository Manager サービスが任意の課金アプリケーション サーバに

ファイルを送信するときに障害が発生した場合、システムにより CDRFileDeliveryFailed アラートが

生成されます。電子メールまたはポケットベルで通知するようにアラートを設定できます。アラー

トの設定については、P.8-4 の「アラート プロパティの設定」を参照してください。それ以降、課

金アプリケーション サーバへのファイル送信に障害が発生すると、システムにより 
CDRFileDeliveryFailureContinues syslog アラームが生成されます。 

最高水準値パラメータに基づいてファイルの削除を有効にすると、CDR Repository Manager サービ

スは CDR ファイルと CMR ファイルが使用するディスク スペースの容量をモニタします。ディス

ク使用率が設定済みの最高水準値を超えると、システムでは、すべての宛先に正常に送信され、CAR
データベースにロードされた（CAR がアクティブになっている場合）CDR ファイルと CMR ファイ

ルが削除されます。この動作は、ディスク スペースが最低水準値に戻るか、正常に送信されたすべ

てのファイルが削除されるまで続きます。正常に送信されたすべてのファイルがシステムにより削

除されても、ディスク使用率が依然として最高水準値を超えている場合、システムでさらにファイ

ルが削除されることはありません。ただし、ディスク使用率がディスク割り当ての設定値を超えて

いる場合を除きます。ディスク使用率が依然としてディスク割り当ての設定値を超えている場合、

システムでは、ファイルが保存期間内かどうか、または正常に送信されたかどうかに関係なく、ディ

スク使用率が最高水準値を下回るまで、古いファイルから順に削除されます。

（注） 最高水準値パラメータに基づくファイルの削除が有効かどうかに関係なく、ディスク使用率がディ

スク割り当ての設定値を超えている場合、ディスク使用率が最高水準値を下回るまで、CDR
Repository Manager サービスにより CDR ファイルと CMR ファイルが古いものから順に削除されま

す。
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Log Partition Monitoring サービスは、CDR Repository Manager に送信されていない CDR および CMR
のディスク使用率をモニタします。ログ パーティションのディスク使用率が設定済みの限界を超え

ており、このサービスによって他のすべてのログおよびトレース ファイルが削除された場合、Log
Partition Monitor サービスにより、CDR Repository Manager に送信されていない後続のノードの

CDR/CMR ファイルが削除されます。Log Partition Monitoring サービスの詳細については、『Cisco
Unified CallManager Serviceability システム ガイド』の「Log Partition Monitoring」の項を参照してく

ださい。

この章は、次の項で構成されています。

• CDR Repository Manager の一般パラメータの設定（P.14-2）

• アプリケーション課金サーバの設定（P.14-5）

• アプリケーション課金サーバ パラメータの設定（P.14-6）

• アプリケーション課金サーバの削除（P.14-7）

• 関連項目（P.14-8）

CDR Repository Manager の一般パラメータの設定

CDR のディスク使用率とファイル保存に関するパラメータを設定するには、次の手順を実行しま

す。

手順

ステップ 1 Tools > CDR Management の順に選択します。

CDR Management ウィンドウが表示されます。

ステップ 2 変更する CDR Manager の一般パラメータの値をクリックします。

ステップ 3 表 14-1 の説明に従って、適切なパラメータを入力します。

ステップ 4 Update をクリックします。

ヒント Set Default をクリックすると、いつでもデフォルト値を指定できます。デフォルトを設

定したら、Update をクリックしてデフォルト値を保存します。

追加情報

P.14-8 の「関連項目」を参照してください。
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CDR Repository Manager の一般パラメータの設定値

表 14-1 は、CDR Management ウィンドウの General Parameters セクションで利用できる設定を示し

ています。関連する手順については、P.14-8 の「関連項目」を参照してください。

表 14-1 CDR Repository Manager の一般パラメータの設定値

フィールド 説明

Disk Allocation (MB) CDR および CMR のフラット ファイル ストレージに割り当てるメガバ

イト数を選択します。範囲とデフォルトの値は、リポジトリ ノードの

ハード ドライブのサイズによって異なります。

デフォルトのディスク割り当てと範囲の値は、サーバのハード ドライ

ブのサイズによって異なります。

（注） ディスク使用率が CDR ファイルに割り当てられた最大ディス
ク スペースを超えている場合、システムでは、
CDRMaximumDiskSpaceExceeded アラートが生成され、正常に
処理されたファイル（課金サーバに送信され、CAR にロード
されたファイル）がすべて削除されます。ディスク使用率が依
然として割り当てディスク スペースを超えている場合、システ
ムでは、ディスク使用率が最高水準値を下回るまで、送信され
ていないファイルと保存期間内のファイルが古いものから順
に削除されます。

（注） 大規模なシステムで十分なディスク スペースを割り当ててい
ない場合は、CAR スケジューラが CDR ファイルと CMR ファ
イルを CAR データベースにロードする前に、システムにより
これらのファイルが削除されることがあります。たとえば、
CAR スケジューラを 1 日に 1 度実行するように設定した場合、
設定したディスク割り当てが、1 日に生成される CDR ファイ
ルと CMR ファイルを保存するには十分な容量でなければ、こ
れらのファイルは、CAR データベースにロードされる前にシ
ステムにより削除されます。
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High Water Mark (%) このフィールドには、CDR ファイルと CMR ファイルに割り当てる

ディスク スペースの最大パーセンテージを指定します。たとえば、Disk
Allocation フィールドで 2000 メガバイトを選択し、High Water Mark (%)
フィールドで 80% を選択した場合、最高水準値は 1600 メガバイトに

なります。

ディスク使用率が指定済みのパーセンテージを超えており、Disable
CDR/CMR Files Deletion Based on HWM チェックボックスがオフになっ

ている場合、ディスク使用率が Low Water Mark (%) ドロップダウン リ
スト ボックスで指定した値になるまで、システムでは、正常に処理さ

れたすべての CDR ファイルと CMR ファイル（課金サーバに送信され、

CAR にロードされたファイル）が古いものから順に自動的に削除され

ます。

ディスク使用率が依然として最低水準値または最高水準値を超えてい

る場合でも、ディスク使用率がディスク割り当てを超えない限り、送

信されていないファイルまたはロードされていないファイルは削除さ

れません。

Disable CDR/CMR Files Deletion Based on HWM チェックボックスをオン

にすると、システムでは、このフィールドに指定したパーセンテージ

に基づいて CDR ファイルと CMR ファイルが削除されることはありま

せん。 

（注） CDR ディスク スペースが最高水準値を超える場合、システム
により CDRHWMExceeded アラートが生成されます。

Low Water Mark (%) このフィールドには、CDR ファイルと CMR ファイルに割り当てられ

たディスク スペースの、常に使用できるパーセンテージを指定します。

たとえば、Disk Allocation フィールドで 2000 メガバイトを選択し、Low
Water Mark (%) フィールドで 40% を選択した場合、最低水準値は 800
メガバイトになります。

CDR / CMR Files 
Preservation Duration 
(Days) 

CDR ファイルと CMR ファイルを保存する日数を選択します。保存期

間を過ぎたファイルは、CDR Repository Manager により削除されます。 

Disable CDR/CMR Files 
Deletion Based on HWM 

ディスク使用率が High Water Mark (%) フィールドに指定したパーセン

テージを超えても CDR ファイルと CMR ファイルを削除しないように

するには、このチェックボックスをオンにします。デフォルトでは、こ

のチェックボックスはオフなので、ディスク使用率が最高水準値を超

えると、CDR ファイルと CMR ファイルはシステムにより削除されま

す。 

（注） 最高水準値パラメータに基づくファイルの削除が有効かどう
かに関係なく、ディスク使用率がディスク割り当ての設定値を
超えている場合、ディスク使用率が最高水準値を下回るまで、
CDR Repository Manager サービスにより CDR ファイルと CMR
ファイルが古いものから順に削除されます。

表 14-1 CDR Repository Manager の一般パラメータの設定値（続き）

フィールド 説明



第 14 章      CDR Repository Manager の設定

  アプリケーション課金サーバの設定

14-5
Cisco Unified CallManager Serviceability アドミニストレーション ガイド

OL-9418-01-J

アプリケーション課金サーバの設定

CDR ファイルの送信先のアプリケーション課金サーバを設定するには、次の手順を実行します。最

大 3 台の課金サーバを設定できます。

ステップ 1 Tools > CDR Management の順に選択します。

CDR Management ウィンドウが表示されます。

ステップ 2 次のいずれかの操作を実行します。

• 新しいアプリケーション課金サーバを追加する場合は、Add New ボタンをクリックします。

• 既存のアプリケーション課金サーバを更新する場合は、サーバのホスト名 /IP アドレスをクリッ

クします。

ステップ 3 表 14-2 の説明に従って、適切な設定値を入力します。

ステップ 4 Add または Update をクリックします。

追加情報

P.14-8 の「関連項目」を参照してください。

CDR Repository Manager 
Host Name

CDR Repository Manager サーバのホスト名を一覧表示します。

CDR Repository Manager 
Host Address

CDR Repository Manager サーバの IP アドレスを一覧表示します。

表 14-1 CDR Repository Manager の一般パラメータの設定値（続き）

フィールド 説明
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アプリケーション課金サーバ パラメータの設定

表 14-2 は、CDR Management ウィンドウの Billing Application Server Parameters セクションで利用で

きる設定を示しています。関連する手順については、P.14-8 の「関連項目」を参照してください。

表 14-2 アプリケーション課金サーバ パラメータの設定

フィールド 説明

Host Name/IP Address CDR の送信先のアプリケーション課金サーバのホスト名または IP ア
ドレスを入力します。

このフィールドの値を変更すると、送信されていないファイルを新し

い宛先に送信するかどうかを確認するプロンプトが表示されます。 

次のいずれかの操作を実行します。

• ファイルを新しいサーバに送信するには、Yes をクリックします。 

• 送信されていないファイルを送信せずにサーバのホスト名/IP アド

レスを変更するには、No をクリックします。 

CDR Management サービスは、CDR ファイルと CMR ファイルを、
正常に送信済みとしてマーク付けします。 

User Name アプリケーション課金サーバのユーザ名を入力します。

Password アプリケーション課金サーバの FTP パスワードを入力します。

Protocol 設定した課金サーバに CDR ファイルを送信するときに使用するプロ

トコル（FTP または SFTP）を選択します。

Directory Path CDR ファイルの送信先のアプリケーション課金サーバのディレクトリ

パスを入力します。指定するパスの末尾は、アプリケーション課金サー

バ上で動作するオペレーティング システムに応じて、“/” または “\” の
いずれかにする必要があります。

（注） FTP ユーザがこのディレクトリへの書き込み権限を持ってい
ることを確認してください。
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アプリケーション課金サーバの削除

アプリケーション課金サーバを削除するには、次の手順を実行します。

ステップ 1 Tools > CDR Management の順に選択します。

CDR Management ウィンドウが表示されます。

ステップ 2 削除するアプリケーション課金サーバの横のチェックボックスをオンにして、Delete Selected をク

リックします。

このサーバを削除すると未送信の CDR ファイルと CMR ファイルがこのサーバに送信されず、正常

に送信済みのファイルとして処理されることを示す、メッセージが表示されます。

ヒント サーバを削除すると、サーバに未送信のファイルの CDRFileDeliveryFailed アラートはシ

ステムで生成されません。

ステップ 3 削除を完了するには、OK をクリックします。

追加情報

P.14-8 の「関連項目」を参照してください。
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関連項目

• CDR Repository Manager の一般パラメータの設定（P.14-2）

• CDR Repository Manager の一般パラメータの設定値（P.14-3）

• アプリケーション課金サーバの設定（P.14-5）

• アプリケーション課金サーバ パラメータの設定（P.14-6）

• アプリケーション課金サーバの削除（P.14-7）

アラート

• RTMT でのアラート設定（P.8-1）

• 『Cisco Unified CallManager Serviceability システム ガイド』の「アラート」

CDR

• Cisco Unified CallManager CDR Analysis and Reporting アドミニストレーション ガイド

• Cisco Unified CallManager Call Detail Definition
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15

Serviceability Reports Archive の設定

Serviceability Reports Archive ウィンドウには、Serviceability Reporter サービスで生成したレポート

を表示できます。Serviceability Reporter サービスは、Cisco Unified CallManager の管理ページの 
Serviceability Reporter サービスのパラメータで指定した時刻にレポートを生成します。

この項では、Serviceability Reports Archive ウィンドウの使用方法を説明します。

始める前に

Cisco Serviceability Report サービスをアクティブにします。Serviceability Reporter サービスは CPU を
集中的に使用するので、コール処理を実行していないサーバ上でアクティブにすることをお勧めし

ます。

手順

ステップ 1 Tools > Serviceability Reports Archive の順に選択します。

Serviceability Reports Archive ウィンドウに、レポートを表示できる月と年が表示されます。

ステップ 2 Month-Year グループ ボックスから、レポートを表示する月を選択します。

選択した月と年が表示されます。

ステップ 3 レポートを表示するには、RTMT がレポートを生成した日に対応するリンクをクリックします。

選択した日のレポート ファイルが表示されます。

ステップ 4 特定の PDF レポートを表示するには、表示するレポートのリンクをクリックします。

ウィンドウが開き、選択したレポートの PDF ファイルが表示されます。

（注） PDF レポートを表示するには、Acrobat ® Reader をマシンにインストールする必要がありま

す。Acrobat Reader をダウンロードするには、ウィンドウの右下隅のリンクをクリックしま

す。
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追加情報

P.15-2 の「関連項目」を参照してください。

関連項目

• Real-Time Monitoring の設定（P.7-1）

• 『Cisco Unified CallManager Serviceability システム ガイド』の「Real-Time Monitoring Tool」

• 『Cisco Unified CallManager Serviceability システム ガイド』の「Serviceability Reports Archive」
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16

SNMP V1/V2c の設定

この章では、ネットワーク管理システムが Cisco Unified CallManager をモニタできるように SNMP
バージョン 1 および 2c を設定する方法を説明します。この章は、次の項で構成されています。

• SNMP コミュニティ ストリングの設定（P.16-2）

• SNMP 通知先の設定 （V1/V2c）（P.16-4）

ヒント SNMP バージョン 3 を使用する場合は、P.17-1 の「SNMP V3 の設定」を参照してください。
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SNMP コミュニティ ストリングの設定

SNMP エージェントはコミュニティ ストリングを使用してセキュリティを提供するので、Cisco
Unified CallManager システムで、管理情報ベース（MIB）にアクセスするためのコミュニティ スト

リングを設定する必要があります。Cisco Unified CallManager システムへのアクセスを制限するに

は、コミュニティ ストリングを変更してください。コミュニティ ストリングを追加、変更、削除

するには、SNMP Community String Configuration ウィンドウにアクセスします。 

手順

ステップ 1 Snmp > V1/V2c > Community String の順に選択します。

ステップ 2 Server ドロップダウン リスト ボックスから、コミュニティ ストリングを設定する対象のサーバを

選択します。

ステップ 3 次のいずれかの操作を実行します。

• 新しいコミュニティ ストリングを追加する場合は、Add New ボタンをクリックし、ステップ 4
に進みます。

• 既存のコミュニティ ストリングを変更する場合は、編集するコミュニティ ストリングの名前

をクリックし、ステップ 5 に進みます。

• コミュニティ ストリングを削除する場合は、削除するコミュニティ ストリング（複数可）の

横のチェックボックスをオンにし、Delete Selected をクリックします。システムがこのコミュ

ニティ ストリングに関連する通知エントリを削除することを示すメッセージが表示されます。

削除を続行するには、OK をクリックし、ステップ 9 に進みます。

ステップ 4 Community String Name フィールドに、コミュニティ ストリングの名前を入力します。名前には、英

数字、ハイフン（-）、アンダースコア（_）の任意の組み合せで、最大 32 文字を指定できます。

ヒント 外部者にわかりにくいコミュニティ ストリング名を選択してください。

ステップ 5 Host IP Addresses Information グループ ボックスで、SNMP パケットの送信元のホストを指定します。

次のいずれかのオプションをクリックします。

• すべてのホストから SNMP パケットを受信する場合は、Accept SNMP Packets from any host オ
プション ボタンをクリックします。

• 指定したホストからのみ SNMP パケットを受信する場合は、Accept SNMP Packets only from
these hosts オプション ボタンをクリックします。Host IP Address フィールドに、パケットの送

信元のホストを入力し、Insert をクリックします。パケットの送信元のホストごとに、このプ

ロセスを繰り返します。ホストを削除するには、Host IP Addresses リスト ボックスからホスト

を選択し、Remove をクリックします。

ステップ 6 Access Privileges ドロップダウン リスト ボックスから、次に示す適切なアクセス レベルを選択しま

す。

• ReadOnly：コミュニティ ストリングは、MIB オブジェクト値の読み取りのみが可能です。

• ReadWrite：コミュニティ ストリングは、MIB オブジェクト値の読み取りと書き込みが可能で

す。



第 16 章      SNMP V1/V2c の設定

  SNMP 通知先

16-3
Cisco Unified CallManager Serviceability アドミニストレーション ガイド

OL-9418-01-J

• ReadWriteNotify：コミュニティ ストリングは、MIB オブジェクト値の読み取りと書き込みに加

えて、MIB オブジェクト値のトラップおよび通知メッセージの送信が可能です。

• NotifyOnly：コミュニティ ストリングは、MIB オブジェクト値のトラップおよび通知メッセー

ジの送信のみが可能です。

• None：コミュニティ ストリングは、読み取り、書き込み、トラップ情報送信のいずれも不可能

です。

（注） Cisco Unified CallManager トラップの設定パラメータを変更するには、NotifyOnly 特権また

は ReadWriteNotify 特権を持つコミュニティを使用する必要があります。

ステップ 7 コミュニティ ストリングをクラスタ内のすべてのサーバに適用するには、Apply To All Nodes 
チェックボックスをオンにします。

ステップ 8 Insert をクリックして新しいコミュニティ ストリングを保存するか、Save をクリックして既存のコ

ミュニティ ストリングへの変更を保存します。

ステップ 9 SNMP マスター エージェントを再起動するまで変更が有効にならないことを示すメッセージが表

示されます。SNMP マスター エージェントを再起動せずに設定を続行するには、Cancel をクリッ

クします。SNMP マスター エージェント サービスを再起動するには、OK をクリックします。

（注） すべての SNMP 設定が終了するのを待ってから、SNMP マスター エージェント サービスを

再起動することをお勧めします。サービスを再起動する方法については、P.2-1 の「サービ

スの管理」を参照してください。

SNMP Community String Configuration ウィンドウの表示が更新されます。 作成したコミュニティ ス
トリングがウィンドウに表示されます。

追加情報

P.16-5 の「関連項目」を参照してください。

SNMP 通知先

次のうち適切な項目を参照してください。

• SNMP 通知先の設定 （V1/V2c）（P.16-4）

• SNMP 通知先の設定（V3）（P.17-4）
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SNMP 通知先の設定 （V1/V2c）
V1/V2c の通知先（トラップ / 通知の受信者）を設定するには、次の手順を実行します。 

手順

ステップ 1 Snmp > V1/V2c > Notification Destination の順に選択します。

ステップ 2 Server ドロップダウン リスト ボックスから、通知先を設定する対象のサーバを選択します。

ステップ 3 次のいずれかの操作を実行します。

• 新しい SNMP 通知先を追加する場合は、Add New ボタンをクリックし、ステップ 4 に進みます。

• 既存の SNMP 通知先を変更する場合は、編集する SNMP 通知先の名前をクリックし、ステップ

5 に進みます。

• SNMP 通知先を削除する場合は、削除する SNMP 通知先（複数可）の横のチェックボックスを

チェックし、Delete Selected をクリックします。ステップ 11 に進みます。

ステップ 4 Host IP Addresses ドロップダウン リスト ボックスから、トラップ宛先のホスト IP アドレスを選択

するか、Add New を選択します。Add New を選択した場合は、IP アドレスを入力します。 

ステップ 5 Port Number フィールドに、SNMP パケットを受信する通知先サーバが通知を受信するポート番号

を入力します。

ステップ 6 SNMP Version Information Group ペインで、該当する SNMP バージョンのオプション ボタンである

V1 または V2C のいずれか（使用する SNMP のバージョンによって異なる）をクリックします。

V1 を選択した場合は、ステップ 8 に進みます。V2C を選択した場合は、ステップ 7 に進みます。

ステップ 7 Notification Type ドロップダウン リスト ボックスから、適切な通知タイプを選択します。

ステップ 8 Community String ドロップダウン リスト ボックスから、このホストが生成する通知メッセージで使

用するコミュニティ名を選択します。 

ヒント 最下位の通知特権（ReadWriteNotify または Notify Only）を持つコミュニティ ストリング

のみが表示されます。このような特権を持つコミュニティ ストリングを設定していない

場合、ドロップダウン リスト ボックスにオプションは表示されません。必要に応じて

Create New ボタンをクリックし、コミュニティ ストリングを作成します。コミュニティ

ストリングを作成する方法については、P.16-2 の「SNMP コミュニティ ストリングの設

定」を参照してください。

ステップ 9 クラスタ内のすべてのノードに通知先を適用するには、Apply To All Nodes チェックボックスをオ

ンにします。

ステップ 10 Insert をクリックして通知先を保存するか、Save をクリックして既存の通知先への変更を保存しま

す。
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ステップ 11 SNMP マスター エージェントを再起動するまで変更が有効にならないことを示すメッセージが表

示されます。SNMP マスター エージェントを再起動せずに設定を続行するには、Cancel をクリッ

クします。SNMP マスター エージェントを再起動するには、OK をクリックします。

（注） SNMP 設定が終了するのを待ってから、SNMP マスター エージェント サービスを再起動す

ることをお勧めします。サービスを再起動する方法については、P.2-1 の「サービスの管理」

を参照してください。

追加情報

P.16-5 の「関連項目」を参照してください。

関連項目

• SNMP コミュニティ ストリングの設定（P.16-2）

• SNMP V3 の設定（P.17-1）

• MIB2 システム グループの設定（P.18-1）

• 『Cisco Unified CallManager Serviceability システム ガイド』の「SNMP」 

• SNMP 通知先の設定 （V1/V2c）（P.16-4）



第 16 章      SNMP V1/V2c の設定

  関連項目

16-6
Cisco Unified CallManager Serviceability アドミニストレーション ガイド

OL-9418-01-J



C H A P T E R

17-1
Cisco Unified CallManager Serviceability アドミニストレーション ガイド

OL-9418-01-J

17

SNMP V3 の設定

この章では、ネットワーク管理システムが Cisco Unified CallManager をモニタできるように SNMP
v3 を設定する方法を説明します。この章は、次の項で構成されています。

• SNMP ユーザの設定（P.17-2）

• SNMP 通知先の設定（V3）（P.17-4）

ヒント SNMP v1 または v2c を使用する場合は、P.16-1 の「SNMP V1/V2c の設定」を参照してください。
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SNMP ユーザの設定

SNMP のユーザを設定するには、次の手順を実行します。

手順

ステップ 1 Snmp > V3 > User の順に選択します。

ステップ 2 Server ドロップダウン リスト ボックスから、アクセスを提供する対象のサーバを選択します。

ステップ 3 次のいずれかの操作を実行します。

• 新しい SNMP ユーザを追加する場合は、Add New ボタンをクリックし、ステップ 4 に進みます。

• 既存の SNMP ユーザを変更する場合は、編集する SNMP ユーザの名前をクリックし、ステップ
5 に進みます。

• SNMP ユーザを削除する場合は、削除する SNMP ユーザ（複数可）の横のチェックボックスを
チェックし、Delete Selected をクリックします。ステップ 11 に進みます。

ステップ 4 User Name フィールドに、アクセスを提供する対象となるユーザの名前を入力します。名前には、

英数字、ハイフン（-）、アンダースコア（_）の任意の組み合せで、最大 32 文字を指定できます。

ヒント ネットワーク管理システム（NMS）に対してすでに設定されているユーザを入力します。

ステップ 5 認証を要求するには、Authentication Required チェックボックスをオンにして、Password フィールド

と Reenter Password フィールドにパスワードを入力し、適切なプロトコルを選択します。パスワー

ドは、8 文字以上にする必要があります。

ステップ 6 Authentication Required チェックボックスをオンにした場合は、プライバシー情報を指定できます。

プライバシーを要求するには、Privacy Required チェックボックスをオンにして、Password フィール

ドと Reenter Password フィールドにパスワードを入力し、適切なプロトコルのチェックボックスを

オンにします。パスワードは、8 文字以上にする必要があります。 

ヒント Privacy Required チェックボックスをオンにすると、DES（Data Encryption Standard）チェッ

クボックスも自動的にオンになります。DES プロトコルを使用すると、パケットが解読

されるのを防止できます。

ステップ 7 Host IP Addresses Information グループ ボックスで、SNMP パケットの送信元のホストを指定します。

次のいずれかのオプションを選択します。

• すべてのホストから SNMP パケットを受信する場合は、Accept SNMP Packets from any host オ
プション ボタンをクリックします。

• 特定のホストから SNMP パケットを受信する場合は、Accept SNMP Packets only from these hosts
オプション ボタンをクリックします。Host IP Address フィールドに、SNMP パケットの送信元
のホストを入力し、Insert をクリックします。SNMP パケットの送信元のホストごとに、このプ
ロセスを繰り返します。ホストを削除するには、Host IP Addresses リスト ボックスからホストを
選択し、Remove をクリックします。
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ステップ 8 Access Privileges ドロップダウン リスト ボックスで、適切なアクセス レベルを選択します。

ステップ 9 クラスタ内のすべてのノードにユーザ設定を適用するには、Apply To All Nodes チェックボックス

をオンにします。

ステップ 10 Insert をクリックして新しいユーザを保存するか、Save をクリックして既存のユーザへの変更を保

存します。

ステップ 11 SNMP マスター エージェントを再起動するまで変更が有効にならないことを示すメッセージが表

示されます。SNMP マスター エージェントを再起動せずに設定を続行するには、Cancel をクリッ

クします。SNMP マスター エージェント サービスを再起動するには、OK をクリックします。

ヒント SNMP 設定が終了するのを待ってから、SNMP マスター エージェント サービスを再起動

することをお勧めします。サービスを再起動する方法については、P.2-1 の「サービスの

管理」を参照してください。

（注） 設定したユーザを使用してこの Cisco Unified CallManager サーバにアクセスするには、この

ユーザを、NMS 上で適切な認証とプライバシーの設定値で設定したことを確認します。

追加情報

P.17-5 の 「関連項目」 を参照して ください。
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SNMP 通知先の設定（V3）
トラップ / 通知の受信者を設定するには、次の手順を実行します。

手順

ステップ 1 Snmp > V3 > Notification Destination の順に選択します。

ステップ 2 Server ドロップダウン リスト ボックスから、通知先を設定する対象のサーバを選択します。

ステップ 3 次のいずれかの操作を実行します。

• 新しい SNMP 通知先を追加する場合は、Add New ボタンをクリックし、ステップ 4 に進みます。

• 既存の SNMP 通知先を変更する場合は、編集する SNMP 通知先の名前をクリックし、ステップ
5 に進みます。

• SNMP 通知先を削除する場合は、削除する SNMP 通知先（複数可）の横のチェックボックスを
チェックし、Delete Selected をクリックします。ステップ 12 に進みます。

ステップ 4 Host IP Addresses ドロップダウン リスト ボックスからホスト IP アドレスを選択するか、Add New
を選択します。Add New を選択した場合は、IP アドレスを入力します。 

ステップ 5 Port Number フィールドに、通知先サーバ上の通知を受信するポート番号を入力します。

ステップ 6 Notification Type ドロップダウン リスト ボックスから、適切な通知タイプを選択します。

Inform を選択する場合は、ステップ 7 に進みます。Trap を選択する場合は、ステップ 8 に進みます。

ヒント Inform オプションを選択することをお勧めします。Inform 機能は、メッセージを確認さ

れるまで再送するので、Trap より信頼性が高くなります。

ステップ 7 Remote SNMP Engine Id ドロップダウン リスト ボックスから、エンジン ID を選択するか、Add New
を選択します。Add New を選択した場合は、Remote SNMP Engine Id フィールドにエンジン ID を入

力します。 

ステップ 8 Security Level ドロップダウン リスト ボックスから、適切なセキュリティ レベルを選択します。

• noAuthNoPriv：認証もプライバシーも設定されません。

• authNoPriv：認証は設定されますが、プライバシーは設定されません。

• authPriv：認証もプライバシーも設定されます。

ステップ 9 User Information グループ ボックスで次のいずれかの操作を実行し、通知先をユーザに関連付けた

り、関連付けを解除したりします。 

• 新しいユーザを作成する場合は、Create New User ボタンをクリックし、P.17-2 の「SNMP ユー
ザの設定」を参照してください。

• 既存のユーザを変更する場合は、該当するユーザのチェックボックスをオンにして、Updated
Select User をクリックします。P.17-2 の「SNMP ユーザの設定」を参照してください。

• ユーザを削除する場合は、ユーザのチェックボックスをオンにして、Delete Select User をクリッ
クします。
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（注） 表示されるユーザは、前のステップで選択したセキュリティ レベルによって異なります。

ステップ 10 クラスタ内のすべてのノードに通知先を適用するには、Apply To All Nodes チェックボックスをオ

ンにします。

ステップ 11 Insert をクリックして通知先を保存するか、Save をクリックして既存の通知先への変更を保存しま

す。

ステップ 12 SNMP マスター エージェントを再起動するまで変更が有効にならないことを示すメッセージが表

示されます。SNMP マスター エージェントを再起動せずに設定を続行するには、Cancel をクリッ

クします。SNMP マスター エージェント サービスを再起動するには、OK をクリックします。

ヒント SNMP 設定が終了するのを待ってから、SNMP マスター エージェント サービスを再起動

することをお勧めします。サービスを再起動する方法については、P.2-1 の「サービスの

管理」を参照してください。

SNMP Notification Destination Configuration ウィンドウに、通知先の IP アドレス、ポート番号、セ

キュリティ モデル バージョン、セキュリティ名、レベル、通知タイプが表示されます。

追加情報

P.17-5 の「関連項目」を参照してください。

関連項目

• SNMP V1/V2c の設定（P.16-1）

• MIB2 システム グループの設定（P.18-1）

• SNMP ユーザの設定（P.17-2）

• SNMP 通知先の設定（V3）（P.17-4）

• 『Cisco Unified CallManager Serviceability システム ガイド』の「SNMP」
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MIB2 システム グループの設定

Cisco Unified CallManager Serviceability の MIB2 System Group Configuration ウィンドウでは、MIB-II
システム グループについて、システムの連絡先とシステムの場所のオブジェクトを設定できます。

たとえば、システムの連絡先として Administrator, 555-121-6633、システムの場所として San Jose,
Bldg 23, 2nd floor のように入力できます。

MIB-II システム グループについて、システムの連絡先とシステムの場所を設定するには、次の手

順を実行します。

ヒント この手順は、SNMP v1、v2c、および v3 の設定をサポートしています。

手順

ステップ 1 Snmp > SystemGroup > MIB2 System Group Configuration の順に選択します。

ステップ 2 Server ドロップダウン リスト ボックスから、連絡先を設定する対象のサーバを選択します。

ステップ 3 System Contact フィールドに、問題が発生したときに通知する個人を入力します。

ステップ 4 System Location フィールドに、システムの連絡先として指定した個人の場所を入力します。

ステップ 5 クラスタ内のすべてのノードにこのシステム設定を適用するには、Apply To All Nodes チェック

ボックスをオンにします。

ステップ 6 Save をクリックします。

SNMP マスター エージェントを再起動するまで変更が有効にならないことを示すメッセージが表

示されます。 

ステップ 7 SNMP マスター エージェント サービスを再起動せずに設定を続行するには、Cancel をクリックし

ます。SNMP マスター エージェント サービスを再起動するには、OK をクリックします。
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（注） System Contact フィールドと System Location フィールドをクリアするには、Clear ボタンを

クリックします。システム設定を削除するには、Clear ボタンをクリックして、Save ボタ

ンをクリックします。

追加情報

P.18-2 の「関連項目」を参照してください。

関連項目

• 『Cisco Unified CallManager Serviceability システム ガイド』の「SNMP」 

• SNMP V1/V2c の設定（P.16-1）

• SNMP V3 の設定（P.17-1）
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